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CHAPTER 1

INTRODUCTION

Thank you for purchasing TireMaster. This guide includes information about daily TireMaster
operations and procedures for less frequently performed tasks, along with additional reference
information. This chapter includes the following sections:

Maintain Your TireMaster System
Basic Tasks 8

Technical Support
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MAINTAIN YOUR TIREMASTER SYSTEM

To ensure your TireMaster system runs properly, you need to maintain it. Proper maintenance
include performing updates, making backups, and reviewing system messages.

UPDATES AND PATCHES

ASA recommends that you install regularly released updates and patches. You should keep
TireMaster up to date for a number of reasons:

= Keeping up to date on updates and patches is a requirement of the TireMaster support
contract, and it helps ASA Support provide the best service to you.

= Updates and patches resolve performance issues and often include additional features and
enhancements.

= Staying up to date on updates and patches ensures that upgrading to future releases of
TireMaster requires less work.

When a new version of TireMaster or an interface for an add-on program becomes available to you,
a new installer will be placed in your TireMaster program folder during the nightly backup. When
you’re ready to update your server or workstations, you can access the installer from the apps
directory.

Note: Typically the location is c:\TireMaster\apps, d:\TireMaster\apps, c:\QDSTM\apps,
d:\QDSTM\apps, c:\tmpos\apps, or d:\tmpos\apps.

Installers are downloaded to the apps folder by default. To download installers to a different folder,
change the setting of the control TM Install - Auto download location (Other tab).

System Controls (6400)

Commission] Eustomer] Enterprize | General Iedger] Inventor_l,l] Mone  Other lVendor]

Description |Value |SiteNo | -

Tillz - Till #4 Starting Float ] 1

ETM Install - Auto download location ___"I-

Use Embeded Fonts in PDF KO 1
(P FFFFFFVYFFFFYFFFFFYFFFYFYYFFYFYFFFYYFFYYFYYYFFYYYFFFYFYYFYYYFYYYFFEYYYYEY F

Figure 1-1: Auto Download Location Control

Note: By default, automatic downloads are enabled. For more information, see "TM Install - Auto
download location" on page 1141.

If you do not want to enable automatic downloads or do not have enough disk space to manage
automatic downloads, you can download installers from the TireMaster Support site
(http://support.tiremaster.com).

REGISTER TIREMASTER

After most TireMaster updates, you’ll need to register the program to continue usingit. If you don’t
register TireMaster during the update process, you can access the registration program from within
TireMaster.
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To register TireMaster

1.

Select Help > Registration. The TireMaster - Registration Wizard opens.

Help
About
Help Contents
TireMaster Website
Messages
Program Update
Registration
Cust Begin Balance
Validate
CMD

Read the information on the Welcome tab, and click Next.

Read the end user license agreement (EULA). Then select the check box at the bottom of the
screen, and click Next.

Type the customer number and password provided by ASA, along with your contact information.
Then click Next. Required fields are labeled in red text.

Review the information on the Licensing tab, and click Register. A confirmation message
appears.

Close the confirmation message.
Click Finish.

TIREMASTER MESSAGE CENTER

The TireMaster message center is used to let you know when TireMaster updates are available and
provide you with troubleshooting and promotional information. To access the message center, you
need to be assigned all four of the following permissions:

Message Critical Notice
Message Support Notice
Message Update Notice

Message Marketing Notice

When a new notice is sent to you, the message indicator appears at the bottom of the TireMaster
screen. Messages remain in TireMaster until 30 days after they're sent.

To view TireMaster messages

1.

Do one of the following:
=  Double-click the message indicator on the status bar at the bottom of the screen.

= From the Help menu, select Messages.

The Messages from TireMaster screen opens.
Do one of the following:

® Toread anew message, selectit and click View Message.
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Note: If you want to wait until later to view a new message, select the message, and click
Mark Read. To retrieve the message, select the Viewed Messages check box.

= To view an existing message, select the Viewed Messages check box. Then select the
message you want to read, and click View Message.

3. Forahard copy of the message, click Print.
Close the Display TireMaster Message screen.

Close the Messages from TireMaster screen.

DATA VALIDATION

After you run updates, validate TireMaster. The data validation checks to see that all required
System Controls settings have been completed and other necessary configuration has been
performed. Until you validate your database, you cannot create invoices or purchase orders. In
TireMaster Plus and TireMaster Corporate, you also cannot make payments or access the general
ledger.

VALIDATE YOUR DATA

To verify that required TireMaster configuration has been done, validate your TireMaster database.
The data for both the live TireMaster and practice programs can be validated. Perform the validation
on the TireMaster server.

Note: Ifyou are using a co-located database, validate all sites that use the shared database.

To validate TireMaster

1. Select Help > Validate. The Data Validation screen opens.

Help
About
Help Contents
TireMaster Website
Messages
Program Update
Registration
Cust Begin Balance
Validate
CMD I}

2. Click Validate. The validation utility displays the status of various TireMaster settings.

Bl i B e

Print | Exit |

WYY

3. Foracopy of the validation log, click Print.
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0 \
iz inactive or does not exist.
iz inactive or does not exist.

[ is inactive or does not exist.

| P I Print I Exit

4. Iferrors (red) appear on the TM Data Validation screen, check the settings in the applicable
program areas and rerun the validation. Resolving warnings (green) is optional.

Note: Until validation errors are resolved, you won’t be able to create invoices, purchase
orders, and perform various transactions. For more information, see "Validation
Messages" on page 1147.

5. When you can run the validation with no errors, click Exit.

VALIDATION MESSAGES
When the validation identifies program areas that are not set up, it generates errors or warnings

(Figure 1-2).

Data Validation (16160)

Click Validate to check your program settings. Ifthe validation detects errors, you will not be able to perform
any transactions until the errors are resolved.

that control in Setup = System Controls = Commissions, press Enter, and select or create your default ~
CUSTOMER COMMISSION TYPE. (For more information, press F1.)
- System Control (Commission): DEFAULT EMPLOYEE COMMISSION MATRIX

WARNING: You de not have a DEFAULT EMPLOYEE COMMISSION MATRIX defined. Please go to
that control in Setup = System Controls = Commissions, press Enter, select or create a user, click
Commissions, and set up your default COMMISSION MATRIX. (For more information, press F1.)
- System Control (Commission): DEFAULT COMMISSION TYPE - INVENTORY

WARMNING: You do not have a DEFAULT COMMISSION TYPE - INVENTORY defined. Please goto
that control in Setup = System Controls = Commissions, press Enter, and select or create your default
INVENTORY COMMISSION TYPE. (For more information, press F1.)
- System Control (Enterprise): INTERSTORE OFFSET - MAJOR ACCT
- System: GL Accounts in Use (Active Only)

ERROR: The GL Acct 1110-0 for CUSTOMER TYPE: Z is inactive or does not exist.

ERROR: The GL Acct 1110-0 for CREDIT CARD: 0 is inactive or does not exist.

ERROR: The GL Acct 1110-0 for CREDIT CARD: Ais inactive or does not exist.

ERROR: The GL Acct 1110-0 for CREDIT CARD: B is inactive or does not exist.

ERROR: The GL Acct 1110-0 for CREDIT CARD: D is inactive or does not exist.

ERROR: The GL Acct 1110-0 for CREDIT CARD: Mis inactive or does not exist.

ERROR: The GL Acct 1110-0 for CREDIT CARD: Vis inactive or does not exist.

prnt | Exit

Figure 1-2: Validation Warning and Error Messages

VALIDATION ERRORS

Validation errors identify settings that must be completed before you can access various
areas of TireMaster. These errors appear when the validation program identifies required
settings that do not exist, are no longer valid, or are inactive.
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Validation errors are displayed in red, indented text. These error messages describe
settings that must be corrected and direct you to the program area where you can make
corrections.

If the validation process generates errors, you need to resolve the errors before you can
create invoices and perform other transactions. For detailed information about these
messages, see "Resolve Validation Errors" on page 1148

VALIDATION WARNINGS

Validation warnings are displayed in green, indented text. They identify settings that can be
corrected and where you can find those settings in the program.

Because validation warnings do not prevent you from accessing any program areas,
correcting them is optional. For detailed information about these messages, see "Resolve
Validation Warnings" on page 1150.

BACKUPS

Backups give you the ability to restore your data in the event of a system failure or other emergency.
To ensure the safety of your data and to protect your business, back up your database regularly. ASA
recommends that you back up your data to a storage device or removable media at least once a
week if not more frequently. Ideally, you should back up your data to a storage device or removable
media daily.

When you begin setting up your system, start running daily backups. Once you go live, also run
month end and year end backups.

Note: Ifyou are running a TireMaster Corporate system, contact TireMaster Support for
information about data backups.

REDUNDANT BACKUPS

TireMaster automatically backs up your data daily at 2:00 a.m. This automatic backup is called the
redundant backup. For redundant backups to occur, leave the main server turned on overnight.

On Monday through Saturday, the log file (enterprise.log) is copied from the data folder to the
backup folder. On Sunday, both the log file and the database file (enterprise.db) are saved to the
backup folder. These automatic backups are stored in subfolders named after the appropriate day
of the week and are overwritten each week.

Note: If you need to change the location for saving backup files, call TireMaster Support.
Redundant backups are not a suitable substitute for regular backups to removable media. With

removable media, you can store your backups off site and easily recover your data if your building or
computers are destroyed.
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The redundant backup includes an automated database validation process that scans your data for
corruption. Results of the validation will be available for you to check on the TireMaster Support site.
If ASA's support representatives identify a problem with your data, they’ll contact you.

Note: Ifyou do not wantthe automated database validation to run during the redundant backup, set

the System Control Validate Database to No. If the control is not set, the automated
database validation is enabled.

Tip: The automated database validation is a different process than running the validation. For
more information, see "Data Validation" on page 4.

MANUAL BACKUPS

TireMaster includes a manual backup program that you can run at any time. Performing a manual
backup places a copy of your TireMaster database (enterprise.db) and log (enterprise.log) in the
dbak folder (usually c:qdstm\dbak, d:qdstm\dbak , c:\dbak, d:\dbak, c:tmpos\dbak, or
d:tmpos\dbak).

Note: The contents of the dbak folder can be copied to a storage device or removable media.

To perform a manual backup, double-click the TM Backup icon on the desktop of the TireMaster
server. To verify the backup was successful, view the contents of the dbak subfolder.

DAILY BACKUPS

In addition to the redundant backups that TireMaster runs, you also need to schedule daily backups.
If your TireMaster system goes down or is destroyed, you can restore your data from the daily
backup.

You can use one of the following backup methods for your daily backups:
= Option 1: Back up your data to an off-site computer.
This type of backup is performed over the internet. If you're interested in using this type of
backup, contact your ASA sales representative.
= Option 2: Back up your data to a storage device or removable media.
Examples of storage devices and removable media include, external hard drives, thumb drives,
DVDs, and CD-Rs. With this method, you should have a device or media for each day your store

is open. For example, if your store is open Monday through Saturday, you’d have six pieces of
devices or removable media.

Once you’ve performed the daily backup, store that day’s device or media in a secure, off-site
location.
= Option 3: Combine Option 1 and Option 2.

Option 3 is the safest method, because you have two copies of your data. One copy is on an off-
site computer, and the other is on a storage device or removable media.
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To ensure successful backups
= Run backups on the servers at Corporate and at the stores (TireMaster Corporate only).

= Back up all the files and subfolders in the backups folder (c:\QDSTM\backups,
d:\QDSTM\backups, c:\backups, d:\TireMaster\backups, c:\TMPOS\backups, or
d:\TMPOS\backups).

= Assign a device or piece of media for each day your store is open.
= Change the device or media every day.

= Store the backup device or media in a secure location away from the place of business.

MONTH END BACKUPS

ASA recommends that you add general ledger accounts, GL codes, inventory categories, and
inventory items (in that order) that will be used only by the Casing Manager. The benefit of these
settings is that they help to simply research and reconciliation of general ledger activity for the
retreading process. This appendix includes the following sections:

YEAR END BACKUPS

Before you close a fiscal year, you should perform a year end backup to a piece of removable media
or arecordable memory device. You can then store this backup as an archive for tax purposes. You
should save your TireMaster year end backups for your income tax records for at least six years. For
additional recommendations concerning data archives, consult your accountant.

Year end backups are handled in the same way as daily backups. As with all of your backup media,
you should store your year end backup off site.

BASIC TASKS

Some tasks performed in TireMaster occur during other activities, and others can make working in
TireMaster easier.

LOG IN TO TIREMASTER

You can start TireMaster from the icon on the desktop or the Windows Start menu.

To log in to TireMaster

1. Do one of the following:
Double-click H on the computer’s desktop.

" Click n and scroll to the TireMaster folder. Then click the down arrow and select TireMaster
from the list of TireMaster applications.

The login screen opens.

2. Type your user name and password.
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Tip:  Passwords are case sensitive. If you can’t log in, make sure you’re using the correct case
for the letters in your password.

3. Click OK.

HOT KEYS

Like many Windows-based programs, TireMaster lets you select buttons, menus, and items by
pressing Alt and a designated letter. For menu items, the hot key appears after you press the Alt
key. For most buttons, the hot key is underlined.

TireMaster also has one unique hot key feature. Yellow fields indicate that a list or lookup screen is
available for a field. Pressing [z] displays the list or lookup screen.

Tip:  The hotkeys for the Prev and Next buttons on the Customer Maintenance and Vendor

Maintenance screens do not require use of the Alt key. To move to the previous customer or
vendor, press PgUp. To move to the next customer or vendor, press PageDown.

FUNCTION KEYS

By pressing the function keys (Table 1-1), also known as the F keys, you can quickly access several
program areas in TireMaster.

Table 1-1: TireMaster’s Function Keys

fom _ JDesctpton

F1 Displays help system content that’s related to the screen that’s currently
open.
F2 Lets you edit the description of a noninventoriable item on a work order

without have to retype the entire line.

F6 Opens the Epicor®|ntegrated Service Estimator™ (ISE) without having to
start a quote or work order. This feature is available only if you subscribe to
the ISE.

F7 Opens the fitment guide without having to start a quote or work order. This

feature is available only if you subscribe to Tire Guide Pro Plus.

F8 Opens a screen that shows the selected customer’s sales history at point of
sale.
F9 Opens a screen that shows parts and labor sales, gross profit dollars, and

gross profit percentages for completed invoices and pending work orders.

F11 Opens the Quick Jobs menu for accessing the Epicor Integrated Service
Estimator. This feature is available only if you subscribe to the ISE.

F12 Opens the Quote Module regardless of whether any other screens are open.
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DOWN ARROW LOOKUP METHOD

When you add items to a work order, purchase order, or receiving document, you can search for
inventory by pressing [1] and typing a code (such as a quick look code) or scanning a bar code.

Here’s how the down arrow lookup method works. When you’re using the Purchase Order, Receiving
Documents, or Invoice Entry screen, press [{]to add a line .

You can use either full or partial codes when searching for items with the down arrow lookup method.
In some instances, typing the full code results an in an exact match. For searches in which you use a
partial code, or when multiple items share a code, the Inventory List displays all items that match.

Note: The orderin which TireMaster looks for items depends on how the Sort field is set up on the
first tab of the Custom Inventory Lookup screen. For example, when the codes R3B are
entered in the Sort field, TireMaster looks for items that match the rim size, followed by those
that match the quick look code, and those with the best price.

Tip: Because the order for the down arrow lookup method is determined by the settings on the
first tab on the Custom Inventory Lookup screen, you can customize the search order for
each workstation. For more information, see "Configure the Custom Inventory Lookup
Screen" on page 228.

RESIZE SCREENS
The following TireMaster screens can be resized:
=  Open Work Order List
= |nvoice Entry
= |nventory List Editing
= Appointment Calendar

Toresize a screen, move the pointer % to the edge or corner of the screen. When it becomes a
double-ended arrow (¢=), drag the screen to a new size.

REARRANGE TABLE COLUMNS

Some screens have extensive tables for displaying data. Therefore, you might want to rearrange a
table’s columns so it's easier to see the information you need. To move a column, click its heading
and drag it to a different position. You can rearrange columns on the following screens:

= Open Work Order List
= |nventory List
= List Editing (Customer, Vendor, and Inventory)

Whether you're allowed to save the changes depends on which screen you’re using. For more
information, see "Move and Resize Open Work Order List Columns" on page 431 and "Move and
Resize Inventory List Columns" on page 229. Layout changes to the List Editing screens cannot be
saved.

10
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TECHNICAL SUPPORT

When technical problems arise, you might need to perform some basic troubleshooting or submit a
support request.

TROUBLESHOOTING TIPS

Before you request support, you might be able to resolve some problems on your own. If you are
getting error messages from Windows instead of TireMaster, you might simply need to reboot your
system. Rebooting can also help if you’re having network problems (that is, problems getting the
workstations and server to interact).

When you're troubleshooting, write down or take screen shots of all error messages and any strange
behavior by TireMaster. If you have to submit a support request, this information can help the
support analysts identify the source of the problem.

If you need to contact Support, having the remote desktop application installed on the server and
each workstation allows ASA's support analysts to quickly access your computer to diagnose and
resolve problems. For more information, see "Remote Desktop Application" on page 23.

INFORMATION TO INCLUDE IN SUPPORT REQUESTS

When you submit support requests, include the following information:
=  The version of TireMaster
= The Windows operating system version and service pack number
= Whether the Remote Desktop Application is installed
= Whether you’re experiencing the problem on the server or a workstation

Also describe the area of TireMaster that seems to be affected, and explain precisely what you were
doing when you encountered the problem. These extra details can help ASA Support isolate the
problem more quickly.

IDENTIFY THE TIREMASTER VERSION

To identify the TireMaster version, select Help > About. When the About screen opens, write down
the EXE version information listed on the screen.

IDENTIFY THE WINDOWS VERSION AND SERVICE PACK
For the Windows version and service pack information, type winwver in the search field (Figure 1-3)

and press Enter. If the search bar isn't visible, right-click H and select Search.

| L b kb ek kb ke kb ek bk kb kb e b

Ny
4
3
je, winved & 1

Insert
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Figure 1-3: Windows Version Search

When the About Windows screen opens, write down the operating system version and service pack
information.

REQUEST SUPPORT
When you need assistance from ASA Support, submit a support request by email or via the Autotask
client portal. The Autotask portal is available 24/7. With Autotask, you can do the following:

= Submit electronic support requests

= Track the status of your requests

= Add information to your support requests

REGISTER FOR AN AUTOTASK ACCOUNT

To log a support request, you must be a registered Autotask user. Employees who will use Autotask
can register for their own accounts as long as they each register with different email addresses.

To register for an Autotask account

1. To access the Autotask registration form, go the TireMaster Support site support.tiremaster.com
and click the support account registration link.

2. Type your name and contact information.

Note: The fields marked with a red asterisk are required.

3. Click Submit.

SUBMIT SUPPORT REQUESTS

With Autotask, you can submit support requests, also called tickets, via a web portal or by email.
When you submit a support request, include information about your TireMaster system and provide a
description of the problem you’re reporting, along with troubleshooting information, error messages,
and supporting documentation such as attachments of screenshots. For more information, see
"Information to Include in Support Requests" on the previous page.

Note: If you need to request support on a Saturday, assistance is available on a best effort basis for
critical issues. Therefore, to ensure your Saturday support requests are added to the queue
as critical tickets, log them through the Autotask portal instead of by email.

REQUEST SUPPORT VIA THE CLIENT PORTAL

When you log a support request via the Autotask client portal, you fill out a form that
prompts you for information about the issue you’re reporting.

12


mailto:portal_tm@asaauto.com
https://ww14.autotask.net/ClientPortal/Login.aspx?ci=305582
http://support.tiremaster.com/
https://ww14.autotask.net/ClientPortal/Login.aspx?ci=305582

Technical Support

Note: The following information describes basic steps for submitting a support request in
Autotask. For detailed Autotask information, click € when you’re logged in to
Autotask.

To log a support request via the client portal

1. To access the Autotask client portal, go to
https://ww 14 .autotask.net/ClientPortal/Login.aspx.

Note: You can also access the portal from the TireMaster Support site. Go to

support.tiremaster.com and click the link for submitting an online support
request.

2. Type your user name and password. Then click Login.

- IT Client Portal Login X

<« c ‘@‘ D &% hitps:/fww1d.autotask.net/Cli

4} Most Visited @Home
ms Automotive
Systems, Inc.

CLIENT PORTAL LOGIN

Llser Mame:
@asaauto.com
Passwaord:

L 2111131111111}
[] Remember my user name

[] Keep me logged in on this computer

LOGIN

Unauthorized access is prohibited
| fargot my password

3. Click New Ticket.

13
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In 60 @

HL o - 5l newTicker | ©

4. When prompted for the Request Type, select TM Request from the drop-down. Then
click Continue.

*N New Ticket - Mozilla Firefox

U &% https:/fwwl4d.autotask.net/ClientPortal/ServiceTickets/MNev

NEW TICKET - SELECT COMPANY & REQUEST TYPE

Request Type

(Select) -

(Select)
GTX Request
Tirelax Fegyest

| THME Request |

5. Type attitle for your request.
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B save &View | B Save&Close = PR Save & New

Service Request
TM REQUEST
Title~

Cannot Complete Invoice 4

Note: Allfields marked with an asterisk are required.

6. Under Ticket Details, do the following.

a.
b.

Type a description of your issue.

Select the priority level for your request from the Service Provider Priority drop-
down. If the drop-down isn’t visible, scroll down. For more information, see
"Support Priority Levels" on page 21.
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TICKET DETAILS

Company
ASA Automotive Systems, Inc

Contact”
v &
EMAIL [@asaauto.com
PHONE (603)
Description - 267 f 8000

An error appears when | try to print an invoice for one of
my customers.

Here's what happens:

1.1 click Complete.

2.1 fill in the payment and ending mileage.

3.1 click OK, and answer Yes to the confirmation. Then the
error appears and | can't complete the invoice.

Service Provider Priority *

Critical - P1 ™ -

7. Answer the background questions. For more information, see "Information to Include in
Support Requests" on page 11.

8. Do one of the following:
= If you have no attachments, click Save Ticket, and go to step 10.

® |fyou need to attach one or more documents, click Save & Attach. The New
Ticket Attachments screen opens.
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BACKGROUND QUESTIONS

What other troubleshooting steps have you taken?

| tried to print and complete invoices for other customers.

What is the error message or code that appears?

[Gybasze][ODBC Driver] Syntax error or access violation. Error

Please provide the name/version of the software application you're
having a problem with and the operating system of your computer,
if available.

TireMaster 93.0 and Windows 10

Save Ticker Save & Amach File

Note: Attachments can also be added to the request after it's saved.

r

9. For each attachment, do the following:
a. Typeaname.
b. Click Browse and select the file you want to attach.

c. Click Attach File. The file name is added to a list of files to attach to the support
request.

Note: If you decide to remove a file, click .

d. Click Save & Close.

10. When Autotask displays your request on the screen, review the information. Then click
Close.

11. Log out of the Autotask portal.

REQUEST SUPPORT BY EMAIL

To submit a support request by email, send it to portal_tm@asaauto.com.

When you request support by email, the subject line becomes the ticket title and the email
body is used as the ticket description. When you submit a request in this manner, your
original email is also attached to the ticket.

Tickets submitted by email are logged as P3 (normal) requests. Therefore, if you have a
higher priority issue, include words such as High or Critical in email subject line. This
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notation will help to ensure that ASA Support can escalate the ticket, according to our
priority guidelines. For more information, see "Support Priority Levels" on page 21.

Note: If you need to log a support call on a Saturday, assistance is available on a best
effort basis for critical issues. Therefore, to ensure your Saturday support requests
are added to the queue as critical calls, log them through the Autotask portal
instead of by email.

REVIEW AND EDIT SUPPORT REQUESTS

After a support request has been created, you can check the status, read comments, add comments,
and add attachments.

Note: The following information describes basic steps for reviewing and editing a support request in
Autotask. For detailed Autotask information, click @ when you’re logged in to Autotask.

To review or edit an existing support request
1. To access the Autotask client portal, go to https://ww14.autotask.net/ClientPortal/Login.aspx.

Note: You can also access the Autotask client portal from the TireMaster Support site. Go to
support.tiremaster.com and click the link for submitting an online support request.

2. Type your user name and password. Then click Login. Your Autotask dashboard opens.
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- IT Client Portal Login x

<« C @

L+ Most Visited @ Home

O &% hitps:/fww14.autotask.net/Cli

ﬂs Automotive
Systems, Inc.
CLIENT PORTAL LOGIN

ser Mame:

[@asaauto.com

Passward:

SRR RBRRRR
[] Remember my user name

[] Keep me logged in on this computer

LOGIN

Unauthorized access is prohibited
| fargaot my passwaord

3. Under Tickets, click the number for a ticket category. Typically, you'll be looking for a new or
open ticket. Alist of tickets in the selected category opens.
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TICKETS

=1 NEW TICKET

2 ha" 2 0

4. Click the ticket number for the request you want to review or edit.

H S

TICKET MUMBER & TICKET TITLE CREATE DATE

Q TEDEGDIZiDIEEL %nut Complete Invoice  01/23,/2020
Q, T202001237155 Vendor Subledgers and GL  01/23/2020

AF Account Don't Match

A A A A, A, A A A

Y

Tip:  You can use the filters to narrow down the number of tickets listed by ticket number, ticket
title, and date created.

5. Do the following as needed:
= Type a quick note and click Submit.
= Click Note and add a detailed note. Then click Save.
= Click Attachment and look up a file to add to the ticket. Then click Save & Close.
To return to the open ticket list, click Close.
To return to your dashboard, click Home.

Log out of the Autotask portal.

SATURDAY SUPPORT POLICY

Saturday support is available on a best effort basis for critical tickets logged via the Autotask client
portal. When you log a Saturday support request in Autotask, we will do our best to find an available
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analyst to help you. If an analyst can’t be found, your call will be first in the queue on Monday
morning. For information about critical support requests, see "Support Priority Levels" below.

To ensure your Saturday support requests are added to the queue as critical calls, log them through
the Autotask portal instead of by email. When a support request is logged with the portal, you can
classify it as critical. Requests made by email, however, are all added to the queue as normal calls.
Therefore, the only way Support will receive a critical call on a Saturday is to log the call with the
portal.

SUPPORT PRIORITY LEVELS

ASA has established priority levels for various types of support requests, along with the response
times for each level.

Note: Whether an item on this list affects your system depends on which ASA products are used by
your business.

PRIORITY LEVEL 1
Critical issues are classified as P1. The response time for P1 issues is one hour.
Table 1-2: P1 Issues

P1:Critical—1 Hour

System is down (server is down)

Glassfish server is down

eTireLink server is down

All printers are down

All users are unable to log in

SonicWALL is down

Outside technician is on site

ASA employee is on site

Unable to complete and print invoices (customers are waiting)
Unable to process credit card transactions (customers are waiting)
Remote store is down

Speed issues at all locations

First week of customer going live with new TireMaster or TireMaster Enterprise system

First week of customer going live after upgrading or moving to a new server

PRIORITY LEVEL 2

High priority issues are classified as P2. The response time for P2 issues is four hours.
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Table 1-3: P2 Issues

P2:High—4 Hours

One terminal at a location is down or locked

Note: For TireMaster locations with a single terminal, this issue escalates to P1 status.

One printer at a location is down

Note: For TireMaster locations with a single printer, this issue escalates to P1 status.
Replication is down

Kill a print job

One terminal out of many cannot print or complete invoices

Some users are unable to log on

Error messages have occurred and users cannot process transactions on one or more
terminals

Weeks 2—4 of customer going live with new system
Speed issues at one location

Late charges (aging) are not being applied

Unable to print AP checks

Unable to print statements

Orders are locked or in use

Issues with integrated applications (interfaces such as Epicor, CARFAX, and retread) that
prevent daily processing

Cannot perform day-end close, if holding up statements

PRIORITY LEVEL 3

Normal priority issues are classified as P3, which is the default priority level. ASA Support makes its
best effort to respond to these issues.

Table 1-4: P3 Issues

P3—Normal: Best Effort (Default Priority Level)

Printer issues (TireMaster Enterprise only)
One of many terminals is down or locked (TireMaster Enterprise only)

ODBC connection is down, ODBC query is not working, or both
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P3—Normal: Best Effort (Default Priority Level)

Other issues not considered critical or high

General ledger is out of balance to subledgers

Inventory issues, pricing issues, or both

Unable to complete day-end or month-end processing (unless holding up statements)
Batch is out of balance

Schedule an upgrade or update

PRIORITY LEVEL 4

Issues that do not fall into the first three priority levels are classified as P4 issues. Priority level 4
issues are responded to when possible.

Table 1-5: P4 Issues

P4—Other: When Possible

For eachissues or for each queries are needed

Note: Foreach queries that take more than 15-20 minutes of work are billable.
Documentation

Training questions

Note: Calls expected to last more than 20 minutes are billable and must be scheduled.

REMOTE DESKTOP APPLICATION

ASA Support uses the remote desktop application FixMe.IT to establish a direct connection between
your computer and the computer of the support analyst who is helping you. The connection allows
the support analyst to see your system, making it easier to address your issues and answer your
questions.

You can access the FixMe.IT installer from the TireMaster Support web site. Log on to
http://support.tiremaster.com and click Support FixMe IT Connection Application on the login
page (Figure 1-4).
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’ﬂs Automotive
Systems, Inc.

Welcome to the TireMaster Support Center

Please log in.

Enter Customer#: | |

Login

Enter Password: | |

If you do not know your customer name and password, call TireMaster Support at 800-891-7437.
To log an online support request, click here or email portal_tm@asaauto.com.

To register for an online support account, click here.

Figure 1-4: FixMe.IT Installer Link

Depending on your browser, you’ll be able to click the file name (FixMeitClient.exe) and begin the
installation right away or you’ll have to save the installer on your computer first. At the end of the
installation, the client ID screen will appear (Figure 1-5). Give the ID number to the support technician
who is assisting you, so he or she can complete the connection.

&% FixMe.T

Eﬂj FixMe.IT

By providing the Client ID, you are granting the remote person full access to your computer.
Do not provide the Client ID if you received an unsolicited call to fix your computer.

Client ID: 954 737

Please give the Client 1D above to the person providing the remote desktop assistance.

Figure 1-5: FixMe.IT Client ID
At the end of the installation, a FixMe.IT clienticon is added to the computer’s desktop (Figure 1-6).

During subsequent contact with ASA Support, double-click that icon to retrieve client ID numbers for
your support calls.
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FixMe.IT

Client

Figure 1-6: FixMe.IT Client Icon

Note: Once the FixMe.IT installation is complete, you can delete the icon for the FixMe.IT installer
(FixMeitClient.exe).

ENHANCEMENT REQUESTS

ASA s always interested in improving TireMaster. Your enhancement requests can greatly assist us
in meeting your needs. You can share your enhancement requests with either a sales representative
or a support technician.

When you request an enhancement, do the following:
= Describe the area in TireMaster (from your perspective) that the enhancement would affect.

= Explain how the enhancement would help you do your work more efficiently or more
successfully.

Although we may not be able to fulfill all requests, we attempt to implement those requests that meet
the needs of the majority of our customers.
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CHAPTER 2

MENU CONFIGURATION

You can customize the TireMaster menu to give different groups of employees easy access to the
program areas they use the most. This chapter includes the following sections:

Menu OPptioNS .. 28
Add a MeNU il 28
Manage Existing Menus . . 30
Menu AssignNments il 32
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MENU OPTIONS

The TireMaster menu includes a fixed bar along the top of the screen and customizable elements
that you can configure based on employee roles.

Example: A menu for salespeople might include buttons to open the quote screen, Open Work
Order List, and fitment guide, while the menu for an inventory manager would access the PO Sys-
tem, Inventory Maintenance, and the Qty Adjustment Wizard.

Creating a menu includes the following:
= Choosing which buttons are available on the menu.
Note: To ensure all buttons are displayed when the screen is resized, a maximum of eight
menu buttons is recommended for the resolution of 1024 x 768.
= Defining where to place the buttons.
= Assigning the menu to a site, a security group, or specific employees.

The menu configuration also includes the option to put a clock on the screen. The clock can be
placed in the upper-right, bottom-left, or bottom-right corner of the screen.

Users who belong to security groups assigned the permission Setup Users/Permission are
allowed to work with the menu configuration.

ADD A MENU

Adding a menu includes defining which buttons it will have and which locations, employees, or both
are allowed to use it. You can add menus at both the corporate site and the stores.

To add a menu
1. Select Setup > Menu Configuration. The Menu Setup screen opens.

Setup
Systern Controls
Printers

WO Status

Users & Permissions

Menu Configuration L\\,

AAAAAAAAAAAAAAAAAAAAAAAAA

2. Click Add. TireMaster prompts you for the name of the new menu.
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Delete | Assign |

3. Type the menu’s name and click OK.

W Edit Menu

Menu Name IF'oim of Sale

=]

Cancel |

4. Selectthe name of the new menu (left side of screen) and assign buttons to it.

Add aMenu

a. For each screen that should be opened with a button, select its name from the Menu

Choices list and click Add. The screen name is added to the Menu Item list.

Move Up

Move Down

i

Delete

| 2=
[=3
(=8

Menu Choices

Menu ltem ~
Day End

Dac Search

Easy Checks

Epicor

Exit i
GL Entry
GF Dashboard

Interstore TR
Inv List Edj

b. Rearrange the screen names as needed. To move a screen, select the screen name and

click Move Up or Move Down repeatedly until the name is where you want it.

Menu Name IF‘OiI"It of Sale Menu Choices
Menu tem | Menu ltem
Customers | Move Up I Accounting
Exit Payments
Quotes Banking
Invoicing Cust List Edit
Inventory Customers

Add Doc Search

= Easy Checks

N PP e aa ] Deleleul_ i

Note: To ensure all buttons are displayed when the screen is resized, a maximum of eight

menu buttons is recommended for the resolution of 1024 x 768.

5. Ifyou accidentally added a screen to the menu, select the screen name and click Delete.
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Menu Name |Point of Sale Menu Choices
Menu Item I Menu Item Ll
Customers Move Up | Accounting
Exit Payments
Quotes I0E Downl Banking
Inventory Customers
Fitment Day End
= Easy Checks
A A A A A A A A A A A A A A PP PPPPPPPPPPPPPPS P

6. Todisplay the menu at the top of the screen, make sure Top is selected. To display it along the
left side, select Left instead.

Add | Edt | Delete | Assign | | ®Top € Lef

7. Toinclude a clock with the menu, select the Clock check box. Then define the clock position by
selecting Top Right, Bottom Left, or Bottom Right.

itment

GL Entry

P Mashhnard b

i€ & Top Right Close |
i~ Bottom Left —

{~ Bottom Right

8. Assign the menu to locations, security groups, and groups as needed. For more information, see
"Assign Menus" on page 32.

9. To see the new menu, exit TireMaster. Then restart the program, and log in with the credentials
for a user who is assigned to the menu.

MANAGE EXISTING MENUS

Managing your menus includes making changes to them or removing them from TireMaster.

UPDATE A MENU

Occasionally, you might need to make changes to a menu. These changes can include updating the
name, changing the position or button assignments, and adding or removing the clock.

Note: You can make changesto menus created at your store and those added at other sites.

To update a menu

1. Select Setup > Menu Configuration. The Menu Setup screen opens.
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2. Change the name if needed. Otherwise, disregard this step.
a. Selectthe menu name you want to change, and click Edit. The Edit Menu screen appears.
b. Type the new menu name, and click OK.
3. Assign additional buttons to the menu. Otherwise, disregard this step.
a. Selectthe menu you want to work with.
b. Onthe Menu Choices list, select the name of the screen you want to assign and click Add.
c. Repeatstep 3b as needed to assign additional buttons.
4. Remove buttons from the menu. Otherwise, disregard this step.
a. Selectthe menu you want to work with.
b. Select the name of the screen whose button you want to remove, and click Delete. A
confirmation message appears.
c. Click Yes.
d. Repeat steps 4b and 4c as needed to remove additional buttons.
5. Change the position of the menu buttons. Otherwise, disregard this step.
a. Selectthe menu you want to work with.
b. Select Top or Left.
6. Add a clock. Otherwise, disregard this step.
a. Selectthe menu you want to work with.
b. Selectthe Clock check box.
c. Toidentify where to put the clock, select Top Right, Bottom Left, or Bottom Right.
7. Remove the clock. Otherwise, disregard this step.
a. Selectthe menu you want to work with.
b. Clearthe Clock check box.
Close the Menus Setup screen.
To see the changes, exit TireMaster. Then restart the program, and log in with the credentials for
a user who is assigned to the menu.
DELETE A MENU

If there is a menu you no longer use, you can remove it.

Note: You can delete a menu regardless of which site created it.

To delete a menu

1.
2.

Select Setup > Menu Configuration. The Menu Setup screen opens.

On the list of menus, select the one you want to remove and click Delete. A confirmation
message appears.

Click Yes. The menu is removed from the menu list.
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4. Close the Menu Setup screen.

MENU ASSIGNMENTS

Menu assignments define which menu appears when users log in to TireMaster.

ASSIGN MENUS

You can assign a menu to an entire location, one or more security groups, one or more users, or a
combination of locations, groups, and users.

Note: Menu assignments can be made at the site that added the menu or any of the other sites. If a
user is assigned to multiple menus, the menu that the user was assigned to first will be used.

Tip:  Setup a general default menu and assign it to your location to ensure that a set of buttons
appears for users who are not assigned a menu.

To assigh menus

1. Ifthe Menu Setup screen isn’t already open, select Setup > Menu Configuration.

Setup
Systemn Controls
Printers

WO Status

Users & Permissions

Menu Configuration |>5

Sites
LA AALAAALLLAALLLLLAALALSSLSADS

2. Select the menu you want to work with, and click Assign. The Menu Assignments screen
appears.

Menus Setup (3999)

Menus

Menu Name

Base
Point of Sale —
bbb bbb dbd bbb bddsbsdsdbdddds s

[
Add | Edit | Delete || Assign I

ot At A A |

1

ol b

3. Do the following as needed:

= To assign locations, make one or more selections from the Locations list and click Add
Location.
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Add Location ASA Automotive Systems

Menu Assignments

= To assign security groups, make one or more selections from the Security Group list and

click Add Group.

Locations

Site Mame

Add Location | 1 ASA Automotive Systems

Security Group

City
Meridian

Group |Group Mame

| Add Group |2 Back Office

1 Owner

I ——

= To assign employees, make one or more selections from the list and click Add Employee.

Employee
Id Mame Site-Emp -
I Add Employee I LA Adams, Larry 1-14
BA Andrews, Bill 1-18
JB Buckman, Jenny 113
JE |Edwards, Jery |15
FG Grant, Fred 1-6
GF Green, Freda 1-17
oJ James, Donna 1-7
KJ Johnson, Kris 1-9
Delete | FJ Jones, Fred 1-15
o PR Pata Rroiamn 1.1R v

Close |

4. Close the Menu Assignment screen.

DELETE MENU ASSIGNMENTS

When a menu should no longer be assigned to a location, security group, or one or more users, you

can undo the assignment.

Note: You can delete menu assignments, even if they were originally made at other locations.

To delete a menu assignment

1. Ifthe Menu Setup screen isn’t already open, select Setup > Menu Configuration.
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2. Select the menu you want to work with, and click Assign. The Menu Assignments screen
appears.

3. Select the name of the location, security group, employee whose assignment you want to
remove, and click Delete. A confirmation message appears.

Click Yes. The assignment is removed.

To remove additional assignments, repeat steps 2 through 4.
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CHAPTER 3

PRINTER AND DOCUMENT SETTINGS

You can generate a variety of documents with TireMaster. Before you generate these documents,
however, you need define how they will look and where they will print. If you use a cash drawer, you
also need to set it up. This chapter includes the following sections:
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PRINTERS

Before you print documents, define which printer to use for each document type. For example, you
might print reports on a laser printer and invoices on a dot matrix printer. See "Printer Guidelines" on
the facing page for a list of which printers to use for various document types.

SET UP PRINTERS

Printers need to be set up for each workstation. However, before you can assign printers in
TireMaster, you need to set them up on your network and on the individual computers connected to
your network.

Note: TireMaster Corporate’s reports can be generated with only specific printers and print drivers.
To ensure that you can consistently generate documents from TireMaster, use printing
hardware and software that has been tested by ASA Automotive Systems. If you need to
purchase printers, call ASA Support or your account manager for information about
recommended printers. ASA Support can also help you identify which print drivers you might
need.

To set up printers

1. Select Setup > Printers. The Printer Selection screen opens.

Setup
System Controls
Printers

WO Status
Users & Permissions

Menu Configuration
Nt e e e i i A e e e e i A i P

2. To select a printer for reports, click _ Inextto the Reports field. The Print screen opens.

Printer Selection (8700)

Reports EE!E I_
Invoices |N0NE
Work Orders  |NONE
WO Veh Spec  |NONE

WP YTV Y F Y YV P YV VY VY Py VY VY YTy PV wTy

Note: Some reports print using the default Windows printer regardless of the printer you select.

b b A A b

From the Name drop-down, select a printer and click OK.
Do one of the following:

= |fyou always use this printer for a document type, make sure the Selectable check box is
clear.
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Reports HP Laserlet 400 _| Selectable [

Invoices NONE _| Selectable [

Wark Orders NONE _I Selectable [~

WO Veh Spec |NONE _| Selectable [~
(T YYFFYFYEYEY

= |fyou want to choose a printer when you print, make sure the Selectable check box for the
document type is selected.

Reports |HPLaserJet4nn _| Selectable [

Invoices NONE _| Selectable [

Wark Orders NONE _I Selectable [~

WO Veh Spec |NONE _| Selectable [~
(T YYFFYFYEYEY

Note: Because some documents disregard this setting, you’'ll always be prompted to select
a printer when printing.

5. Repeat steps 2 through 4 for the remaining printers and cash drawer (if needed).
Note: The firsttime you access the Quote Module, TireMaster will prompt you to define the type
of printer to use for quotes.
6. Close the Printer Selection screen.
PRINTER GUIDELINES

TireMaster lets you set up a printer for each document type and the cash drawer. Table 3-1 lists the
printer guidelines for each document type.

Table 3-1: Printer Guidelines

Reports Prints reports, financial statements, and checks. This printer should be a

laser jet printer.

Note: Some reports use the default Windows printer regardless of the
printer you select.

Invoices Prints invoices and ROAs. This printer can be either a laser printer or a

dot matrix printer.

Work Orders Prints work orders. This printer can be either a laser jet printer or a dot

matrix printer.

WO Vehicle Prints vehicle specifications downloaded from Epicor. This printer can be
Specs either a laser jet printer or a dot matrix printer. For more information, see

Epicor Venhicle specifications.
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Quotes Prints quotes. This printer can be either a laser jet printer or a dot matrix
printer.

Purchase Order Prints purchase orders. This printer needs to be a laser jet printer.

Checklist Prints a list of recommended services for a vehicle. This printer should be
a laser jet printer.

Drawer (open) Opens an electronic cash drawer. For more information, see Cash
Drawers.

Note: TireMaster is designed to work with APG Model 182 cash drawers
only.

CONFIGURE DOCUMENTS

You can control the appearance of several documents by completing various settings. For example,
you can define how much text should fill a page, which information is printed, how information is
organized, and whether to include global messages.

SET THE TEXT LENGTH FOR FORMS

You have the option to print text on the entire page for work orders, invoices, and ROAs, or you can
leave space for preprinted disclaimers or logos in the middle of a page instead.

To set the form text length
1. Select Setup > Printers. The Printer Selection screen opens.

Setup
System Controls
Printers

WO Status
Users & Permissions

Menu Configuration
LY FFFFFTFTFFFTFTFTrTYTrrYTyTryywy:

2. Click Forms. The Form Selections opens.

Quotes

Purchase Order

Checklist

Drawer (open)

Forms

3. Select one of the following:
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=  To printtext on only part of the page, select Normal. Then select one of the Set Inch options
to define the amount of white space that will separate the text from the totals. With this setting,
preprinted areas are untouched and any remaining information is printed on subsequent

pages.
Form Selections (16370)
s
Length ~Setinch |
& Mormal (Lines stop setinch from totals for preprinted text) 35
; ) i 30
-
Filled (Lines go all the way to totals) 25
Okidata :: 3;
lrl' Invoice [~ WorkOrder [~ ROA ‘ I~ Canadian o 51'0=
i 05
Statement Formal—‘ S
’7|7 Include Reference Numper I I 1 Clo0

= To print text on the entire page, select Filled .

Length

¢ Mormal (Lines stop set inch from totals for preprinted tex)

& Filled (Lines go all the way to totals)é"""

[ Okidata

4. If you want to print documents on dot matrix printers, select the Invoice, Work Order, and ROA
check boxes as needed. Otherwise, leave them clear.

Length

& Mormal (Lines stop set inch from totals f@

A A

" Filled (Lines go all the way to totals)

Okidata
I~ Invoice [~ WorkOrder [~ ROA

Yy

Y Y Y Y YW Frrryryryryyeyy

Note: Toinclude global comments on invoices that use OKI forms, the text length needs to be
setto Normal.

5. Ifyou operate a business in Canada, select the Canadian check box.

Note: Disregard the Include Reference Number check box under Statement Format. As of
TireMaster 9.3.0, statement settings have been consolidated on a single setup screen.
For more information, see "Statement Configuration" on page 685.

6. When you’re finished, click Save Setup.

Save Setup |

7. Close the Form Selection screen.
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DESIGN WORK ORDERS AND INVOICES

You can choose which information, such as salesperson number, comments, and customer terms,
prints on work orders and invoices.

Note: Additional settings for invoices are available in System Controls. For more information, see

"Invoice - Print Header" on page 1138 and "Invoice - Print Signature Line" on page 1138.

To design work orders and invoices

1.
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Select Setup > Printers. The Printer Selection screen opens.

Setup
System Controls
Printers

WO Status
Users & Permissions

Menu Configuration
Nt e e e i A e e e e i A i B P

Click Form Options. The Form Options screen opens.

Printer Selection (8700)

Reports HP Laserlet
Invoices HP Laserlet

Wark Orders HF LaserJet

P vy

t

Quotes HP LaserJet

Purchase Order [HP LaserJet i
Checklist HP LaserJet :
Drawer (open) [NONE >

| | Form Options I

Py

Select the check boxes for the information types you want to include on work order and invoices.

Note: Disregard the settings under Statements. As of TireMaster 9.3.0, statement settings
have been consolidated on a single setup screen. For more information, see "Statement
Configuration" on page 685.

Click Save. A confirmation message appears.



Form Options (16368)

—Work Orders
[~ Print Customer Fax #

¥ Print Employee #

¥ Print Mechanic #

¥ Print Salesperson#

[~ Print Ship-To Address

v Print Service Checklist Motes
¥ Print Promised Time

[~ Print Fitment Information

[~ Print Key Tag
(Laser Printers Only)

— Invoices
[~ Print Customer Fax #

v Print Employee #

¥ Print Mechanic#

¥ Print Salesperson &
v Print Ship-To Address

[+ Print Comments

¥ Print Credit Card Information
[~ Print Name andAddress in Bold

(Laser Printers Only)

— Statements
[~ Print Customer Terms

¥ Print PO #instead of Ref#
[~ Print Customer Fax #

[~ Print Customer Email address

[+ Include Mot Due Aged Balance
|~ Age Fin. Charge by Due Date
[~ Frint Site Headar

I Save I Close

5. Click OK.

6. Close the Form Options and Printer Selection screens.

DESIGN FINANCIAL STATEMENTS

You can organize information on income statements and balance sheets by setting up groups for
each account type The groups can be general or detailed.

With general groups, all of your asset, liability, equity, income, and expense accounts are displayed
under a single heading for each account type.

Balance Sheet

Pariod Printed For: 4 Ending: 04302019

1-ASA Automolive Systems

ASA Automotive Systems

Printed: 4152019 103527 AM

| ASSETS |
Current Assets
CASH ON HAND 1392528
CASH IN BANK - CHECKING 6041426
CASH IN BANK - SAVINGS - EMERGE 1871320
ACCOUNTS RECEIVAR usTO 1435291
ACCOUMNTS RECEIVABLE - EMPLO 585.18
AR CARDS 631542
INV TIRES - PASSENGER 298493150
INV TIRES - LIGHT TRUCK 1,135,107.72
INV TIRES - MED / COMM 126000
RETREAD INVENTORY - CAPS 1,770,000
INV SERVICE PARTS 10053
NOM-NV SERVICE PARTS 261875
NOMN-MV MISC 690655
VEHICLES 2158801
FURNITURE & FIXTURES 2025000
LAND 1121
TOTAL Current Assets 4,288,790.18

Figure 3-2: Balance Sheet with General Account Type Groups

Configure Documents
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For detailed financials, set up a general group for each account type and one or more secondary
groups. These secondary groups enable you to see totals for specific general ledger accounts.

Balance Sheet ASA Automotive Systems
Periad Printed Far: 4 Ending: 047302018 Printsd: 4/15/2019 10:21:53 AM
1-ASA Autamative Systems
| ASSETS I
Current Assets
Cash
CASH ON HAND 1392528
CASH IN BANK - CHECKING B1A1428
CASH IN BANK - SAVINGS - EMERGENCY 16,7320
TOTAL Cash 91,062.74
Accounts Receivable
ACCOUNTS RECEIVABLE - CUSTOMERS 143521
ACCOUNTS RECEIVABLE - EMPLOYEES 565.18
AR CARDS [k
TOTAL Accounts Receivable 24,232 84
Inventoriable ltems
2,354,533.50
1.135,107.72
126000
177000
10088
TOTAL Inventoriable Items 412317211
A R  r  r r yrrrryrryryyyy.

Figure 3-3: Balance Sheet with Detailed Account Type Groups

Tip: By creating secondary account groups, you can calculate account totals for different areas of
your business without setting up departments.

UPDATE FINANCIAL STATEMENT ACCOUNT GROUPS

When you need to reorganize information on your financial statements, you can change
the account groups. There is no limit to how often you can update the settings for financial
statements.

To update a financial statement account groups

1. Select Setup > GL Financial Statement Design. The GL Financial Statement
Design screen opens.

Setup

Systemn Controls
Nl e i B B B B B B B B A B B

IVET VT TITTTTTTITYT T Yy Yy Yy yTe
Payment Accounts

GL Class Options
GL Financial Statement Design %
GL Ranges

BB S SS DS SS

2. Select the account group you want to change, and click Edit. The GL Report
Description Edit screen opens.
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Financial Statement Design (15700)

Group | Descr

POVVIVOVIVIY. PN

1 Current Assets

4 Fined Assets

5 Land

6 Other Assets

7 Current Liabilities

Add || Edi I Delete |

3. Change the description, level, and account ranges as needed.

I

4. To save your changes, click OK.

Print the income statement, balance sheet, or both to see whether the changes had the
intended effect.

DELETE FINANCIAL STATEMENT ACCOUNT GROUP

If you no longer want to include an account group on the financial statements, you can
delete it. To delete an account group, open the Financial Statement Design screen, select
the group you want to remove, and click Delete.

CREATE GLOBAL MESSAGES

You can create custom messages that print on all work orders, invoices, quotes, and statements
(both monthly and real-time). You can use these messages to thank customers for their business,
wish them a happy holiday, and encourage them to make payments on time. To create global
messages, you need to belong to a security group assigned

Note: When a document is reprinted, it displays the global comment currently set up in TireMaster
instead of the comment that printed on the original.

Note: Each store can have unique work order, invoice, and quote comments. Because statements
can only be generated at the corporate site, set up statement messages at that location only.

To create global messages

1. Select Setup > Edit Global Comments. The Global Comments and Messages screen opens.
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4.
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Setup
System Controls
(VY VY VVVVPYVPVV VY VIV VY vY Y
A asdanan s s s o g o e oY
Inventery Commission Types
Edit Global Comments
Vehicle Service Checklist
Customer Color Coding

Appointment Scheduling

Click the tab for the type of global message you want to create.

Global Comments and Messages (16275)

Work Order Comments |1nv0ice Comments I Quote | Statement Messagesl

Global Work Order Comment
Enter the message you want to print on each work order.

Type the message. There is one text field for work orders, invoices, and quotes. For statements,
you can use the same or different messages for each aging breakdown. The due date for a
customer’s oldest aged balance determines which message to use. If the text field for a
document type is empty, there is no global message for that document type.

Global Comments and Messages (16275)

Work Order Comments  Invoice Comments Iguote | Statement Messages |

Global Invoice Comment

Enter the message you want to print on each invoice.
This message will print above the invoice totals.

We love our customers! Thank you for choosing ASAAutomotive Systems. We hope to see you again.

Note: Toinclude global comments on invoices that use OKI forms, set the text length to normal.
For more information, see "Set the Text Length for Forms" on page 38.

To save your changes, click OK.



TIREMASTER

SOFTWARE
DRIVEN BY ASA~

CHAPTER 4

USERS AND SECURITY

TireMaster protects your business information by securing your data from tampering and limiting
who is allowed to view documents. This chapter includes the following sections:

USer ACCOUNES 46
SecCUNitY GrOUPS 53
Override TireMaster SecuUrity ... . 63
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USER ACCOUNTS

Each person who uses TireMaster or does any sales or mechanic work needs to have a user
account. User accounts allow you to capture the following information:

= Who started or completed an invoice
= Who worked on a vehicle
= Who paid expenses with cash out of the till

Employees who need to use TireMaster are required to log in with a user ID and corresponding

password.

Note: To maintain privacy, only the system-generated employee number or a combination of the
User ID and the system-generated employee number appear on documents.

Once users are logged in, they can work in the program areas they're allowed to access. For more
information, see "Security Groups" on page 53.

USER ACCOUNT PROPERTIES

For tracking and access purposes, you need to define various properties for each user. You can set
these properties on the Employee/User Edit screen (Figure 4-1).

Employee/User Edit (3000)

Name: Smith, Russell

ID: RS

Local User v

QL User. |RS

EMail: |rsmith@awesomemechanic.com
Payroll:

Active v Mechanic [

kR

Password:

Both must match
to change this

kR

Confirm:

Commissions

users password.

QK | Cancel

Figure 4-1: Employee/User Edit Screen
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fom fDeeetpter

Emp #

Name

ID

SQL User

E-mail
Payroll

Active

Mechanic

Local User

Password

Confirm

Commissions

Displays the system-generated number for the user. The first field
contains the number for the site where the user account was created.

Lets you type the user’s name.

Lets you define a code for logging in to TireMaster, such as the first and
last initials of the employee’s name. The ID can be up to five characters
long.

Lets you assign a unique ID for accessing the TireMaster database.
The SQL user can be up to 15 letters. It cannot begin with a space,
number, or symbol.

Note: ASArecommends that you set the SQL user only once. If you
change it at a later time, you will need to reset the password.
Otherwise the password will, by default, be blank.

Lets you store the user’s email address.

Displays a value that can be set through some third-party applications.
Lets you define whether the employee currently works for the
company.

Note: Clearing this check box removes employees from security

groups and deletes all of their permissions.

Lets you define whether the employee is a mechanic. Selecting this
check box enables you to assign the employee (mechanic) to
appointments created with the TireMaster Scheduler.

Lets you define whether the employee is allowed to log in at a site. In
TireMaster Plus and TireMaster Point of Sale, this check box is always
selected.

Lets you set a password for the user. For more information, see
"Create New Passwords" on page 50.

Note: Passwords are case sensitive.
Lets you confirm the user’s password.

Lets you access the Commission Matrix screen to complete sales
commissions settings for the user. For more information, see "Set Up
an Employee Commission Matrix" on page 852.
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ADD USER ACCOUNTS

You need to create user accounts for employees who use TireMaster and those whose work needs
to be tracked by TireMaster, such as mechanics. Depending on how you run your business, you
might want to set up a single user account that multiple employees can use to log in to the program.
For more information, see "Group Users" on the facing page.

Note: For some employees, you should set up two user accounts. For more information, see

"Multiple Accounts for Employees " on the facing page.

To add a user account

1.
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Select Setup > Users & Permissions. The User List opens.

Setup
System Controls
Printers

WO Status

Users & Permissions

Menu Configuration

B B B A A A A A A A A A

Click Add. The Employee/User Edit screen opens.

R5T 7T T Bmith, Russell” T T T T T TR
RW White, Robert

MMech Z-MNo MechanicAssigned
Admin Z7 - TireMaster System Admin

A o o i i s b b b b b

Add Edit lnactivate‘ Security | p

Note: TireMaster generates the employee number automatically. The system-generated
employee numbers 1 and 2 are reserved for use by the TireMaster system administrator
and ASA Support.

Type the name of the employee or group user.

Type an ID for the employee or group to use to log in to TireMaster.

Note: The ID can be up to five characters long. The user’s initials are often good choice for an
ID.

In the SQL User field, type a password for logging in to the TireMaster database.

Type the user’s e-mail address (optional).

If the user is a technician, make sure the Mechanic check box is selected. Otherwise, leave it
clear. When the check box is selected, the employee’s name will be added to the Scheduler’s
appointment calendar. For more information, see "Define Mechanics " on page 532.

Type a password for the user. For information about creating secure passwords, see "Create
New Passwords" on page 50.

Type the password again in the Confirm field.
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Employee/User Edit (3000)
Emps:  [1 [10 rocaL

MName: |Smith,Russe|l
ID: RS
SQL User. |RS

EMail: |rsmith@awesomemechanic.com
Payroll:
Active v Mechanic |

Local User v

Password; [Freresees Both must match
B revvevwvwer to change this
Fr_in users password.

Commissions oK | Cancel

10. To save the new user, click OK.

Note: New users are automatically saved as active employees and as local users.

MULTIPLE ACCOUNTS FOR EMPLOYEES

Some employees, such as the owner and system administrator, should have two user
accounts. One account should provide access to all program areas and the other should
be for performing every day, low-security functions.

Having two accounts for these employees reduces the chance that they will leave the

system open while logged in as the owner or system administrator, exposing high-security

areas to unauthorized employees.

Note: TireMaster comes with a default user account (Admin) for the system
administrator. This user is assigned to the administrator security group. When you

begin the going-online process, change the default password for the Admin
account to ensures that your administrator privileges are available only to you.

GROUP USERS

Example: If you don’t want employees to log in and out of TireMaster repeatedly, you
can set up a group user account (which is not the same as a security group). You could
create a user account called “Sales” for all of your salespeople.
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MANAGE EXISTING USER ACCOUNTS

With regular maintenance, your data remains secure and your User List is easy to manage.

CREATE NEW PASSWORDS

To maintain the security of your system, each account in TireMaster needs to have a
password. Whenever users start TireMaster, they need to type the user IDs and
passwords. If a user needs to log in at multiple sites, assign a for each site.

When you create passwords, use caution and common sense:

= Choose a password that is six to eight characters long. Short passwords are too
easy to break, and long passwords take too long to type.

= Don’t use a word or phrase that would be easy for someone to guess, such as a
birthday, a family member’s name, or a pet’s name.

= Change your password on a regular basis.

To create new passwords
1. Select Setup > Users & Permissions. The User List opens.

Setup
System Controls
Printers

WO Status

Users & Permissions

Menu Configuration

2. Selectthe name of the user whose password you want to change, and click Edit. The
Employee/User Edit screen appears.

User List (4800)
[v Active Users [« LocalUsers [~ Mechanics Mame Search: |Eluckman,Jenny
Id |Name |Site# |Empl0yee# |
LA Anderson, Lee 1 17
AB Brown, Abe 19

1
1
1

Edit I 1nactivate| §ecurit}r| Close |

3. Type the new password in both the Password and Confirm fields.

Add
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T T T T T T T T T T T T T T T T T T T T T T T T T YT T T T TTYR

——
Passwaord: revs——— Both must match
- xg*x*xsxg*tj tG Change thlS
BT users password.

Commissions QK | Cancel

Note: Passwords are case sensitive.

4. To save the new password, click OK.

MAKE USER ACCOUNTS INACTIVE

When an employee no longer works for you, inactivate his or her user account. Inactivating
a user account results in the following:

= |t removes the user from security groups.
= |t removes any permissions and reports associated with that user.

Note: Inactivating user accounts helps you manage the number of names displayed
on the User List. To display the names of inactive users, clear the Active
Users Only check box.

To inactivate user accounts
1. Select Setup > Users & Permissions. The User List opens. The User List appears.

Setup
Systern Controls
Printers

WO Status
Users & Permissiens

Menu Configuration
A AALAAALLLAALLLLALAALALSSSLSS

2. Select the name of the user who you want to make inactive.

3. Click Inactivate.
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User List (4200)

[v Active Users [« LocalUsers [ Mechanics Mame Search: |Elr0wn,Abe
Id |Name |Site# |Empl0yee# |
LA Anderson, Lee 1 17

Add | Edit | lnadivatel §ecurit].r| Close |

4. To confirm that you want to inactivate the user, click Yes.

MAKE USER ACCOUNTS ACTIVE

If you inactivate a user account by accident or if a former employee comes back to work for
you, you can activate his or her user account.

Note: Once you activate a user account, you need to reassign the user to one or more
security groups.

To activate a user account
1. Select Setup > Users & Permissions. The User List opens.

Setup
Systern Controls
Printers

WO Status

Users & Permissiens

Menu Configuration

2. Clearthe Active Users Only check box to display the names of both inactive and
active users.

[~ Active Users [+ LocalUsers [ Mechanics

Id Mame

3. Select the name of the user account you want to make active and click Edit. The
Employee/User Edit screen appears.
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User List (4200)

[~ Active Users | LocalUsers [ Mechanics Mame Search: IElrown,Abe
Id |Name |Site# |Empl0yee# |
LA Anderson, Lee 1 17

Add | Edit 1nac’[ivate| Security Close |

4. Selectthe Active Only check box. A confirmation message appears.

—

4
Commissionsl :

To verify that the user is now active, click OK.

To save your changes, click OK.

I TPV T IV IITTIITYY
4

| S

3 Both must match
:— to change this

: users password.

Cancel |

7. Close the User List.

L

SECURITY GROUPS

Security groups define which program areas employees are allowed to access and which reports
they’re allowed to print. Security groups are set up based on the different roles of employees. Each
security group is assigned the following:

= Permissions, which define the program areas users in that group are allowed to access. For
a list of permissions, see "Permissions List" on page 1111.

=  Reports, which define the documents users in that group are allowed to print. For more
information, see Reports.
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DEFAULT SECURITY GROUPS
New TireMaster systems ship with the following security groups.

= Administrator is for the person responsible for maintaining and supporting TireMaster. The
user account for the system administrator is automatically assigned to this security group.
Typically, all permissions are assigned to the administrator.

= Owner is for the person who owns the store. Typically, all permissions and reports are
assigned to the owner security group.

= Accountants is for your accountants or bookkeepers. Typically, the users in this security
group are assigned permissions for all accounting functions, along with reports for generating
accounts payable, accounts receivable, and financial information.

= Sales is for users who work at point of sale. Typically, invoicing and some customer
permissions are assigned to the sales security group.

Once the permissions and reports for a security group are set, you can assign users to that group.

ADD OR RENAME SECURITY GROUPS

If the settings for an existing security group don’t meet your needs, you can rename it or create a new
one.

To add or rename a security group

1. Select Setup > Users & Permissions. The User List opens.

Setup
System Controls
Printers
WO Status
Users & Permissions
Menu Configuration

B A A A A A A A A AL A

2. Click Security. The Security Assignments screen opens.

Lo . o i B i
§mlfﬁ, Russell

RS

RW White, Robert

MMech Z-MNo Mechanic Assigned
Admin Z7 - TireMaster System Admin

T WYYV YYYYYHS

Add ‘ Edit | Inactivate Security

3. Click Group Maintenance. The Security Group Maintenance screen opens.
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RS gmitﬁ, Russe
RW White, Robert

MMech Z- Mo Mechanic Assigned
Admin Z7 - TireMaster System Admin

Add | Edit | lnactivatel Security

4. Do one of the following:
= Foranewgroup, click Add.

®=  Torename an existing group, select the group’s name and click Edit.

Edit I Delete Close

The Security Group Add/Edit screen opens.

5. Type aname for the group and click OK. The name of the new group is added to the list of
security groups.

Security Group Add/Edit (16342)

Group Name |Inventor_».r Contral

Cancel |

6. Close the Security Group Maintenance screen and the User List.

ASSIGNING PERMISSIONS TO A SECURITY GROUP

You can control which program areas users can access by assigning permissions to the security
groups.

To assign permissions to a security group
1. Select Setup > Users & Permissions. The User List opens.

Setup
System Controls
Printers
WO Status

Users & Permissions

Menu Configuration

2. Click Security. The Security Assignments screen opens.
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RS mith, Russe
RW White, Robert

MMech Z- Mo Mechanic Assigned
Admin Z7 - TireMaster System Admin

Add | Edit | lnactivatel §ecurit].r|

3. Onthe Groups list, select the security group you want to assign permissions to.

Security Assignments (16340)

—Selection
f* Groups = Employees

Groups

Accountants
Administrator
Inventory Control
Owner

Er

4. Under Assignments, select Permissions. The assigned permissions for the group, if any,
appear on the Assigned list.

" Employees

"ﬁ\ssignment

Assigned

5. To assign permissions to the group, do one of the following on the Unassigned list:
= For anindividual permission, double-click the permission’s name.

= Foranindividual permission, select the permission’s name and click <.

= For multiple permissions, press Ctrl while you select each permission that you want to
assign. Then click <|.
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Administrator
Inventory Control
Owner

P WA A A A A A AT A W A A Y

Customer Add
Inventory Access
Invaicing Access

il

—Selection Assignment

f* Groups " Employees ’7(‘ Employees f* Permissions " Repors

Groups | Assigned Unassigned | ~
Accountants Inventory GLCode View

Inventory Pricing
Inventory Qty Adjustment
Inventory view only pricelt
Inventory View/Edit Cost

Invoicing Change Date

6. Close the Security Assignments screen and the User List.

ASSIGN REPORTS TO A SECURITY GROUP

Security Groups

You can control which documents users are allowed to print by assigning reports to security groups.

Note: Assigning reports to security groups affects only those documents that can be generated
from the Report List.

To assign reports to a security group

1. Select Setup > Users & Permissions. The User List opens.

Setup
System Controls
Printers
WO Status

Users & Permissions

Menu Configuration

2. Click Security. The Security Assignments screen opens.

RS mi
R

MNMech
Admin

Add |

 Russel

‘White, Robert
Z-MNo Mechanic Assigned
Z7 - TireMaster System Admin

Edit | Inactivate

Security

3. Onthe Groups list, select the security group you want to assign reports to.
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Security Assignments (16340)

—Selection

f* Groups = Employees
|Gr0ups | ’
Administrator

Inventory Control
Owner
Sales

4. Under Assignments, select Reports. The assigned reports for the group, if any, appear on the
Assigned list.

Assignment
’7(' Employees ~ Permissions R

Assigned Unassigned

5. To assign reports to the group, do one of the following in the Unassigned list:
= Foranindividual report, double-click the report’s name.

= Foran individual report, select the report’'s name, and click <.

= For multiple reports, press Ctrl while you select each report that you want to assign. Then

click <.

Selection Assignment
|VG' Groups " Employees ’7(‘ Employees " Permissions (+ Reporis

Groups Assigned Unassigned | ~
Administrator AR Detail - By Customer AR Collections - Beta
Inventory Control AR Ledger Report Balance Sheet- MTD

Owner AR or AP Aging by Date Cashln

Sales AR or AP Payments Cash Out

Balance Sheet Cash Requirements Reg
b e b b b b kb B A A A A sk sasd Al AL IETND o . s .

6. Close the Security Assignments screen and the User List.

ASSIGN USERS TO A SECURITY GROUP

Before you can give users access to program areas and reports, you need to assign them to one or
more security groups.

To assign users to a security group

1. Select Setup > Users & Permissions. The User List opens.
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Setup
Systern Controls
Printers

WO Status

Users & Permissions

Menu Configuration

2. Click Security. The Security Assignments screen opens.

RS mith, Russel
RW White, Robert

MNMech Z - MNo Mechanic Assigned
Admin ZZ - TireMaster System Admin

Add | Edit | Inactivate | | Security

3. Onthe Groups list, select the security group you want to assign users to.

Security Assignments (16340)

—Selection
@ Groups = Employees

Groups

Accountants
Administrator

Inventory Control

4. Under Assignments, make sure Employees is selected. The names of the assigned users for
the group, if any, appear on the Assigned list.

Assignment
|7G' Employees“’(" Permissions " Reports

Assigned Unassigned

5. To assign users to the security group, do one of the following in the Unassigned pane:
=  For anindividual user, double-click the user’s name.

= Foranindividual user, select the user’s name, and click <-|.

= For multiple users, press Ctrl while you select each user that you want to assign. Then click

=l
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Security Assignments (16340)

—Selection Assignment

% Groups " Employees ’75‘ Employees i~ Permissions " Repors
Groups | Assigned Unassigned |
Accountants Brown, Abe
Administrator Ellis, Bonnie Buckman, Jenny

Inventory Control Garrison, Pete Edwards, Jerry
Owner

Sales James, Donna

6. Close the Security Assignments screen and the User List.

REVIEW SECURITY ASSIGNMENTS

Occasionally, you might need to review the assignments for a security group or an employee, or you
might want to check the assignments for a report or a permission. TireMaster makes it easy to view
and generate a printout of this information.

Note: Permissions and reports are assigned only to active employees.

To review an employee’s permissions & reports
1. Select Setup > Users & Permissions. The User List opens.

Setup
System Controls
Printers

WO Status

Users & Permissions

Menu Configuration

2. Click Security. The Security Assignments screen appears.

mith, Russe
RwW White, Robert
MMech Z- Mo Mechanic Assigned
Admin Z7 - TireMaster System Admin

Add | Edit | |nactivate

Security I

3. Click View Security Assignments. The View Security Assignments screen appears.

Group Maintenance View Security Assignments I

4. Selectone of the following from the View Assignments by drop-down:
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View Security Assignments (16345)

Security Groups

To see which permissions, users, and reports are assigned to a security group, select

To see which groups, permissions, and reports, are assigned to a user, select Employee.
To see the users and groups a permission is assigned to, select Permission.

To see the users and groups a report is assigned to, select Report.

View Assignments by:

Groups Employees

Edwards, Jerry

Security Group j

Employee
Permission
Report

5. Depending on your selection in step 4, select a group, employee, permission, or report.

6. To print the information displayed on the screen, click one of the following:

Print assignments for the selected group |

Z - Mo Mechanic Assigne
ZZ - TireMaster System A
ZZ-Commission Templal

Print assignments for the selected employee |

Print assignments for the selected group

Print assignments for the selected employee

Print assignments for the selected permission

Customer Combine Cus'
Customer Delete
Customer Edit Account
Customer Edit Cash Onl

Print assignments for the selected permissionl

Print assignments for the selected report
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R T TR S

Print assignments for the selected report

‘Chad OfAccountListing | |
Check History Report
Check Register Report
Commission Report

bl o

The Report Window opens and displays the Security Assignments Report.

7. Printthe report and then close the Report Window.

8. Close the open screens.

REMOVE SECURITY GROUP ASSIGNMENTS

If you decide that a permission, report, or user should no longer be assigned to a particular security

group, you can remove it from the group.

To remove security group assignments

1. Select Setup > Users & Permissions. The User List opens.

Setup

System Controls

Printers

WO Status

Users & Permissions

Menu Configuration
LA AALAAALLLAALLLLLAALALSSLSADS

2. Click Security. The Security Assignments screen appears.

RS

Vv TYyw, b b b
gﬂ"lltﬁ, Russell

4

4

RW White, Robert :
MMech Z - MNo Mechanic Assigned :
Admin ZZ - TireMaster System Admin 1
4

4

Add ‘ Edit | nactivate || Security |

3. Select the name of the group whose assignments you want to change.
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Security Assignments (16340)

—Selection

@ Groups " Employees
|Groups i ’
Administrator

Inventary Contral
owner
Sales

4. Do one or more of the following as needed:

= Toremove a user from the group, select Employees in the Assignments area. Then select
the user’'s name, and click .

= Toremove a permission from the group, select Permissions in the Assignments area.
Then select the permission name, and click .

=  Toremove areport from the group, select Reports in the Assignments area. Then select
the report name, and click .

Security Assignments (16340)

—Selection Assignment
f* Groups " Employees ’7(‘ Employees = Permissions + Repors
Groups Assigned | Unassigned ~
Administrator AR Detail - By Customer AR Collections - Beta
Inventory Control AR Ledger Report CashIn
Owner AR or AP Aging by Date Cash Out
Sales AR or AP Payments il Cash Requirements Reg
Balance Sheet Check History Report
Balance Sheet- MTD Check Register Report
Chart Of Account Listing ;}LLs Commission Report
0000000000000000080h00 T i etiatssssaba et as

Note: Toremove multiple users, permissions, or reports, press the Ctrl key while making each
selection.

5. Close the Security Assignments screen.
6. Close the User List.

OVERRIDE TIREMASTER SECURITY

If you are logged in as a regular user and come across a restricted area, TireMaster displays a
warning (Figure 4-2).
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@ Security Violation

Permizgion Denied: Setup Interfaces

Somy, you do not have security permission to access this particular
feature. Please zee your system administrator bo gain access.

Overnide

Figure 4-2: Restricted Feature Warning

The warning states that you aren’t assigned the permission needed to use the feature in question.

When the warning appears, you need to have a manager or another user with the required

permission override the restriction. This topic describes the buttons and options available on the

Security Assignments screen.

Note: Any user who has the permission in question can also override the restriction. This override
lasts until the affected screen is closed.

To override a permission restriction

When the TireMaster Security Message screen appears, click Override. Then type the user name
and password for the user who has the appropriate permission on the override verification screen,

and click OK.
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CHAPTER 5

CUSTOMERS

With TireMaster, you can track sales and payment activity for walk-in customers and those who have
in-store charge accounts. This chapter includes the following sections:

Add and Manage Customers ... ... . . 66
Customer Maintenance Screen . . 78
Customer SearChes ... L 89
Customer Payment Terms . il 90
CUSEOMI TY P OS e 95
Customer Type Edit Screen . L 99
Customer Color Codes ... . 101
External History Viewer . 105
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ADD AND MANAGE CUSTOMERS

Adding new customers and managing existing customer records are two of the most commonly
performed tasks in TireMaster. For information about adding and managing vendor accounts, see
"Add and Manage Vendors" on page 168.

ADD A CASH CUSTOMER

In TireMaster, cash customer is a classification for those clients who are required to pay upon
completion of a sale. Clients classified as cash customers can pay with cash, check, or payment
cards. Cash customers are typically those clients who walk into your store to inquire about products
and services.

Customers can be added at either the corporate site or the stores. The site where a customer is
added is included in the system-generated customer number.

To add a cash customer

1. Starta work order or a quote. TireMaster prompts you for the customer's name. For more
information, see "Create a Regular Work Order" on page 410, or "Basic Tire Quotes" on
page 469.

2. To close the Name Lookup/Entry screen, click Cancel .

Name Lookup/Entry (2300}

Enter Name: “

License # Phone # (Last 4):
Customer # Unit#
VIM #:

OK " Cancel I

[v¥ Active Only
[v Search All Site |

3. Onthe Customer Maintenance screen, click Add. TireMaster prompts you for the new
customer’s name.

AAAAi

b s e b

Eind |I Add I

4. Type the new customer’s last name or the customer’s business name and click OK. One of the
following occurs:

= The Customer Maintenance screen opens, with the customer's last name filled in.

= |f a customer with the same last name already exists, TireMaster asks if you want to continue.
To add the customer, click Yes . To see if the customer already exists in the database, click
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No. The customer record will open for editing, or you'll be prompted to select the name from
the customer list.

example. CARLSON, STUART.)

JOMES, TOM

Enter lame:

LY YV VYTV

After the new customer’s last name, type a comma, a space, and the customer’s first name. (For

Note: Forbusinesses, disregard the comma before the abbreviation Inc. Otherwise, Inc. will be

treated as a last name (Inc., My Company).

Type the new customer’s street or mailing address.

Type the customer’s zip code. If the zip code has already been used, the Zip Codes screen
appears.

8. Click OK. The city and state are added to the customer’s contact information.

General |‘ufehicle| ShipTol Ledgerﬂ—Hstoryl Agingl Informationl

Cust#:

| Contact Type Mumber / E-Mail
Mame: |[JONES, TOM Business Phonej |

Address: [B00W. ROSE HILL 5T. Business F'honej
Address2: i
City: s
sate: [ zig [ciy state  |zip i

BOISE

|v¥ Taxable

|¥ Cash Only
¥ Statement
|¥ Finance Charge
¥ Open lterm AR

9. Add the phone numbers and e-mail address you want to have on record for the customer. For
more information, see "Add Phone Numbers and Email Addresses" on page 155.

67



User Guide

mation l J
Cust#: | [1 [251
Contact Type Mumber ! E-Mail Mame

|Cell Phone (Per: v | |208-655-7770 |
|Business Phone ~ | |208-555-3030
|E-ru1ail j |tj0nes@fakemail.con

FEFTFVTVVVVyVyvyyyyyeyw

[

10. To accept the remaining default settings for the customer, click OK. For more information, see
"General Tab" on page 78.

i

Recon Codes

Cancel

Note: Most walk-in customers will have the same tax level, customer type, price level, and
payment settings. To save time, the customer default settings in System Controls should
match the profile of your typical customer.

I VWYYV

ADD AN AR CUSTOMER

When management agrees to extend in-store charges privileges to a business or individual, create a
customer record for the client that includes the credit limit and payment terms. Customers can be
added at either the corporate site or the stores. The site where a customer is added is included in the
system-generated customer number.

Note: If you need to create a record for a national account or government support customer, see

"Add a National Account Customer" on page 793 or "Add a Government Support Customer"
on page 801.

To add an AR customer

1. Select Customers > Maintenance. TireMaster prompts you for the customer's name.

Customers
Maintenance
Easy Checks
Types
Contact Types

List Editing

Reports...

2. Toclose the Name Lookup/Entry screen, click Cancel .
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Name Lookup/Entry (2300}

Enter Mame: |
License #: Phone # (LasM):I
Customer # Unit # I
VIM #: I
|+ Active Only
[ Search All Site ok || cance |

On the Customer Maintenance screen, click Add. TireMaster prompts you for the new
customer’s name.

Eind || Add I Eat | pewte | [Terms | |combine|

Type the new customer’s name, using the following guidelines, and click OK:

= Forindividuals, type the last name, a comma, a space, and the first name. (For example,
CARLSON, STUART.)

Enter Name: JOMES, TOM

e it e i g e i A e i i A

®  Forbusinesses, disregard the comma before the abbreviation /nc. Otherwise, Inc. will be
treated as a last name (Inc., My Company).

MName Lookup/Entry (2300)

Enter Name: | PARING DAISIES FLORAL INC:

License # Phone # (Last 4)

Cugtomer#:l Unit#:

WIM #:

Add the customer's address and contact information:
a. Type the new customer’s street or mailing address.

b. Type the customer’s zip code. If the zip code has already been used in TireMaster, the Zip
Codes screen appears.

c. Click OK. The city and state are added to the customer’s contact information.
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Customer Maintenance (12200)

General |\u’ehicle| ShipTol Ledgem—nstor}rl Agingl Informationl

Cust#:
Contact Type MNumber ! E-Mail
Mame: [DARING DAISIES FLORAL INC. Business Phone ~| |
Address: |900 E. ORCHID AVE. Business Phonej
Address2: i
city: i

state: | zig

BOISE

| Taxable

¥ Cash Only

¥ Statement

|¥ Finance Charge
F Open ltem AR Ok

T
I T aasaanaa ab oo

d. Add the phone numbers and e-mail address you want to have on record for the customer.
For more information, see . "Add Phone Numbers and Email Addresses" on page 155.

Prev | I et |
Cust# | [ [o52

Contact Type Mumber / E-Mail Mame
IBusiness Fhon&j 208-555-4545 Main Mumber
IBusiness Phonsj 208-555-6778 Office Number
IE—MaiI j daringdaisies@faker
ICeII Phone (Eusj 208-555-7899 Sue Potts (Driver)

6. To classify the customer as an AR account, do the following:
= Clear the Cash Only check box.
= Select or clear the Statement and Finance Charge check boxes as needed.

= Type the credit limit. For unlimited credit, type 0. 00.

¥ Taxable
[~ Cash Only
¥ Statement
v Finance Charge

Tax Level - Parts: |1 Labor: |1 CreditLimitI 8000.00
Price Level: I ArlAp: IAR Last Pay: I
Type: |1 Commission:l Salesperson:l

TaxID I CustomerSince:I 3M4i2019 vl

7. Update the remaining costumer settings (such as tax level, price level, customer type) as
needed. For more information about customer account settings, see "General Tab" on page 78.

8. Click OK to save your changes.
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Sl i b A A

Recon Codes

Cancel

9. Setthe customer's payment terms. For more information, see "Set a Customer's Payment
Terms" on page 93.

Y Y YT YT Y YY

UPDATE CUSTOMER RECORDS

Occasionally you need to update customer information, such as address, phone number, or tax
level. You can modify the information for a single customer or you can update a range of customer
records.

UPDATE ONE CUSTOMER RECORD

Most of the time, you’ll need to make changes to one customer record at a time. You can
make these changes on the Customer Maintenance screen. Customer information can be
updated at either the corporate site or the stores.

To update a customer record

1. Look up the customer whose settings you need to update. The Customer Maintenance
screen appears. For more information, see "Customer Searches" on page 89.

2. Make sure the General tab is selected, and do one of the following:

= |f you have permission to update the entire customer record, click Edit.

AAAAi

Find | Add || Edit I Qelete| 'I_'erms| Combine|

= [fyou’re allowed to update the contact information and notes only, click Edit
Contact.

W WY
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mationl

Cust# | "1_ |252
Contact Type Mumber { E-Mail Mame
|EL|Siness F'h-:nneJ |2[]8—555—4545 |Main Number
|Business Phone —| [208-555-6778 |Office Number

|E-mail

J |daringdaisies@faker |

|Cell Phone (Bus - | [208-555-7899

|Sue Potts (Driver)

Phone & E-Mail | Tex‘t|

|EL|siness F'h-:neJ | |

3. Make the needed changes. For information about the settings on this screen, see

Edit Contact

"Customer Maintenance Screen" on page 78.

4. To save your changes, click OK.

bl bl S b

Recon Codes

Cancel

UPDATE MULTIPLE CUSTOMER RECORDS

You can update the information for a range of customer records with Customer List Editing.
Customer information can be updated at either the corporate site or the stores. If you need
to update a range of vendor records instead, see Update Multiple Vendor Records.

To update multiple customer records

1. Select Customers > List Editing. The Customer Range Lookup screen opens.

Customers
Maintenance
Easy Checks
Types
Contact Types

List Editing L.\)

Reports...

2. To search for a range of records to edit, use one or more of the following:

= Starting and ending name

= Customer ID (starting and ending)

= Area code (starting and ending), city, state, or zip code
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= Blank zip codes

= Site (for the corporate site of TireMaster Corporate systems only)

= Salesperson, customer type, price level, commission type, or tax level

= Active, inactive, or both

= Cash, credit, or both

= Customers who are assessed finance charges, those who aren’t, or both
= Customers who receive statements, those who don’t, or both

Tip: Toreturnto the screen’s original settings, click Reset.

3. Click OK. The Customer List Editing screen opens.

Customer Range Lookup (16265)

Name: |.J J to |JZ J
Area Code: | to _
City: [BOISE
State: ’—

Zip: [~ Blank Zip Codes

Sit i Activellnactive Cash/Credit
stesr | | . * Casn
Salesperson: " Inactive (" Credit
" Both {« Both
Cust Type: |1
. Finance Charge Statement
HEceLareE | | € Finchrg " stmnt
iz cinn: " Mo Fin Chrg " Mo Stmnt
Commission: & Both & Both
Parts Tax:
Labor Tax:

Reset Close

Note: For ahard copy of the information listed on the screen, click Print to generate
the List Editing Report.

4. Selecta column and update the records as needed. You can type your changes or
make a selection from a list. To select a setting from a list, click or press [].

d q

cuch SITENO  [NAME PLEVEL |5TAT
145 1]JAC0OB, TOM 20T |D
144 1|JAMES, DONNA 207 |8
130 1]JONES, JEFF D
126 1]JONES, KRIS D
251 1]JoNES, TOM D

Tip:  You canrearrange the columns on this screen. For more information, see
"Rearrange Table Columns" on page 10.
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5. When you're finished updating the records, click Close.

ADD A SHIPPING ADDRESS

TireMaster lets you store additional shipping or billing addresses for each customer. When you
create new work orders, you can select one of the addresses.

To add a separate shipping address

1. Search for the customer whose shipping address you’re going to add. For more information, see
"Customer Searches" on page 89.

2. Onthe Customer Maintenance screen, click the ShipTo tab.

General “u"ehiclel ShipTol Ledgerﬂ—nstor}fl Agingl Informationl

Eind ShipTo: | Search

Add Edit | Delete |

Type a unique name for the address and the address information.

To save the new address, click OK.
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Ship-Te Maintenance (3401)
Ship#: I ‘II 103 Cush: I 1| 249

Name: INDRTH BOISEHUB

Address: |455o E. CACTUS LANE

Address2: |
City: IEIDISE
State: IID Zip:  [s3708

Phane: |203-555-3033

Contact: ITINA SPARKS

0K Cancel |

MANAGE ADDITIONAL CUSTOMER INFORMATION

If you need to store additional information in a customer’s record, you can add it to the Information
tab. Types of information that can be added to the tab include additional contact names and billing
instructions.

Note: Contenton the Information tab can be updated only by users assigned the permission
Customer Edit Information Tab.

Tip:  The content on the Information tab can also be viewed at point of sale.

To add content to the Information tab

1. Search for the customer for whose information you want to add. For more information, see
"Customer Searches" on page 89.

2. Click the Information tab.

General |‘ufehic|e| ShipTol Ledgerﬂ—nstoryl Agingl Informationl

3. Click Edit.

4. Type the new information, and click Save.
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Generall \u"ehiclel ShipTol Ledgerﬂ—nstoryl Aging Information |

Send invoices to Betty Jackson at Boise Bench hub.|

hA A A A A4 4 4 as s i a s

COMBINE CUSTOMERS

In some cases, such as marriage or duplicates, you might need to combine two customer records.
When you combine customers, TireMaster makes one record inactive and adds that customer
information to an existing customer record which is maintained.

Y Y

To combine customers
1. Search for the customer whose record you want to keep. For more information, see "Customer
Searches" on page 89.

2. Onthe Customer Maintenance screen, make sure the General tab is selected and click
Combine. TireMaster prompts you for a name.

General |\u"ehic|e| ShipTol Ledgem—nstor].rl Agingl Informationl

Contact Typ:
Name: [ALVERSON, FRANK Home Ph-:na]
ress: [2818 RIDGE RO, E4ai 4

acd | Edt | Detete | 'I_'ermsllCombineI

3. Type all or part of the name of the customer whose record you want to combine with the record
you selected in step 2 and click OK. The Customer List opens.

Custorner Maintenance (12200)

General |\u’ehicle| ShipTol Ledgerﬂ—iistoryl Agingl Informationl

b B e

Cust#:
Contact Type Number/E-Mail
Name: [ALVERSON, FRANK [Home Prone -] |208-555-6454

Address: (2818 RIDGE ROy

PUPPN Y P =4 Y YN

Address2:
City: [BOISE Enterﬂame:lALVERSDM
State: [ID zip: [2370 oK Cancel |
..........PEQDE&E.‘MQ'HI.TEﬂl.......‘

4. Selectthe customer’s name, and click OK.
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Site# Cust# MName Address1
1 256 ALVERSON JAMITORIAL SUPPLY B112W. MAIN
1 254 ALVERSON, CHRISTOPHER 2900 N. UNIVERSITY DRIVE
4

143 ALVERSON, FRANK 2818 RIDGE ROAD
> W 2318 RIDGE ROAD
1 255 ALVERSON, PEGGY . S
E List Edit || oK I Cancel |‘

5. Amessage similar to the following appears:

“About to delete and combine ALVERSON, MARY with ALVERSON, FRANK. Continue?”

6. Click Yes. TireMaster inactivates the record and adds the customer information to the record you
selected in step 2.

7. Update the customer record that you kept as needed.

Example: If you combined the customer records for Frank Alverson (husband) and Mary
Alverson (wife), you could change the name from Alverson, FranktoAlverson,
Frank and Mary.

MAKE A CUSTOMER INACTIVE

If a customer is no longer doing business at your store, you can inactivate corresponding the
customer record. Inactive customer records can be excluded from customer searches.

To make a customer inactive

1. Search for the customer whose record you want to make inactive. For more information, see
"Customer Searches" on page 89.

2. Onthe Customer Maintenance screen, make sure the General tab is selected and click Edit.

Eind | Add || Edit I ge|ete| 'I_'erms| Combine|

3. Clearthe Active Customer check box.

[~ Active Customer ‘//Default Recon:

[~ Require P.O. Recon Codes
Inventory

Cancel

4. Click OK to save your changes, and close the Customer Maintenance screen.
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DELETE A CUSTOMER
Customer records that have never been used can be deleted from the TireMaster database.

Note: If you wantto delete a customer record but cannot due to transactional history, inactivate the
customer record instead. For more information, see "Make a Customer Inactive" on the
previous page.

To delete a customer record

1. Search for the customer whose record you want to delete. For more information, see "Customer
Searches" on page 89.

2. Onthe Customer Maintenance screen, make sure the General tab is selected and click Delete.
A confirmation messages appears.

3. Click Yes. The customer is removed from the database.

CUSTOMER MAINTENANCE SCREEN

You can store and track information about customers and their vehicles on the Customer
Maintenance screen. This screen appears when you add a customer and at point of sale.

GENERAL TAB

The General tab (Figure 5-1) includes contact and account information for the selected customer.
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Customer Maintenance (12200)

Mame:
Address:
Address2:
City:

General |\u’ehicle| ShipTol Ledgerﬂ—nstor]rl Agingl Informationl

Prev | Mext |

Cust | [1 [z
Contact Type Mumber ! E-Mail Mame
Cagney Courier Business Phans:} 208-636-9000 ext. 10 |Billing Dept.
125 8. Delivery Way E-Mail L! bkerns@cagney.com |Bradly Kerns
Business Phansl! 208-636-9000 ext. 10 |Main Number
MERIDIAN Business Phonsj

State: IID_ Zip: |83642 Color |J |ElL|Siness Phonsj I I

Phone & E-Mail | Text | Edit Contac’[l

Motes:

¥ Taiahle Tax Level - Parts: |1 Labar: |1 Credit Limit:l 5000.00
T Cash Only
W Staterment Price Level: I AriAp: IAR Last Pay: |02125!2019
¥ Finance Charge
¥ Open ltem AR Type: |1 Commission:l Salesperson:l
Tax D | CustomerSince:I 21252019 vl

Contact Bradly Kerns or Randy Smith

Add |

Edit | Qeletel 'I_'ermsl Combinel

Default Recon: |—
Recon Codes |
Fleet Contracts |

Inventory |

Close |

¥ Active Custormer
I~ Require PO,

Figure 5-1: Customer Maintenance Screen General Tab

on oo

Prev
Next

Cust #

Name

Lets you move to the record for the previous or next customer on the
Customer List. The shortcut key for Prev is PageUp, and the shortcut
key for Next is PageDown. To move to the next or previous customer,
you need to be out of edit mode.

Note: Customer records for inactive customers are retrieved only by
clicking Prev or Next when they’re included in the initial
customer search. To include inactive customers in a search,
clear the Active Only check box on the Name Lookup/Entry
screen. For more information, see "Customer Searches" on
page 89.

Lets you enter the customer number, if any, from your previous system.
The customer number generated by TireMaster is also listed here. The
second number identifies the site where the customer was added. The
third digit is a unique, system-generated number assigned to the
customer.

Lets you enter the name of the customer as you want it to appear in your
searches. When typing a customer’s name, do the following:
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N

= For people, type the last name followed by a comma and the first
name (Smith, John). The last name is displayed first on the
Customer List and reports. However, the first name appears
before the last name on documents such as invoices and
statements.

= For businesses, disregard the comma before the abbreviation
Inc. Otherwise, Inc. will appear first on invoices and statements
(Inc., My Company).

Address Lets you enter the customer’s physical address.

Address 2 Lets you enter the customer’s P.O. box address, if any.
Note: Ifthe customer only gives you a P.O. box number, putitin the
Address 1 field and leave this field blank.
City Lets you define the customer’s city.
Tip:  Enter the customer’s zip code first to insert the city and state
automatically.

State Lets you define the customer’s state.

Zip Lets you enter the customer’s zip code.
Tip:  Type the zip code first. If it is already in the database, the city
and state will be inserted automatically.

Color Lets you assign a color code to the customer. If a color code is assigned
to a customer, that customer’s name is highlighted with the assigned
color on the Customer Maintenance screen, the Customer List, the
Open Work Order List, and the Invoice Entry screen.

Contact Type Does the following:

Fields = |dentifies the contact method assigned to the selected customer’s
phone numbers, email addresses, or both.

= Lets you define the contact method for phone numbers, email
addresses, or both (in add and edit modes).
Number/E-Mail Does the following:

Fields = |dentifies the phone numbers, email addresses, or both assigned
to customers.

= | ets you define the phone numbers, email addresses, or both
assigned to customers (in add and edit mode).
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Name Fields

Phone & E-Mail

Text

Edit Contact

Taxable

Cash Only

Statement

Finance Charges

Open Item AR

Tax Level - Parts

Tax Level -
Labor

Price Level

Customer Maintenance Screen

Does the following:

= |dentifies the person to whom an email address or phone number
is assigned. This entry can also be a description, such as Main
Phone.

= Lets you define the name or description that you want to assign to
phone numbers, email addresses, or both (in add and edit mode).

Lets you access the customer’s contact list, which includes both phone
numbers and email addresses.

Lets you access the screen for sending text messages to the customer.
Lets you update the customer’s address, phone numbers, email

addresses, and notes.

Note: Users who are allowed to update contact information only can
click this button when they need to make changes to customer
records.

Defines whether the customer pays sales tax.

Note: Taxexemptorreseller customers should be set up with tax
levels that calculate no tax. This approach ensures that all
customers appear on tax reports, regardless of whether they
pay sales tax.

Defines whether the customer must pay at the time of sale. If this check
box is cleared, the customer has an in-store charge account.

Defines whether TireMaster will print statements for any balances that
the customer carries.

Defines whether the customer will be assessed a finance charge for any
balance that is past due.

Lets you apply payments toward specific invoices. All charge customers
are set up with open item AR accounts.

Note: This check box is always selected and cannot be cleared.

Lets you assign a tax level for calculating the amount of sales tax
assessed on parts sold to the customer.

Lets you assign a tax level for calculating the amount of sales tax
assessed on labor sold to the customer.

Lets you assign a price level code that will allow the customer to receive
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N

AR/AP

Type

Commission

Tax ID

Credit Limit

Last Pay

Salesperson

Customer Since

Notes

Active Customer

Require PO

Default Recon

82

special prices for any or all items.

Defines whether the record is for a customer (accounts receivable) or a
vendor (accounts payable). For customers, this setting is always AR.

Lets you assign a customer type to the customer.

Lets you assign a customer commission type to use for calculating
commissions. If no code is entered in this field, TireMaster uses the
default customer commission type set in System Controls.

Lets you define a customer’s tax identification number, if that clientis
exempt from paying sales tax.

Lets you set the credit limit for charge customers. To give a customer
unlimited credit, type 0. 00.

Note: This field is active when the Cash Only check box is clear. If you
change an in-store charge customer to a cash-only customer,
this field will become disabled but will continue to display the
credit limit amount.

Displays the last date when a payment from the customer posted to the
general ledger. Displays the date of the last payment from the customer.

Lets you assign a salesperson to the customer’s account. That
employee is then used as the default salesperson for any work orders
created for the customer.

Lets you define the date when the customer started doing business with
you.

Lets you enter information about the customer or account. This
information does not print on statements.
Note: Thisinformation can be viewed at point of sale by clicking the

Customer Notes tab on the Invoice Entry screen.

Defines whether the customer is active. Clearing the check box removes
the customer from reports and lookup lists but preserves the customer’s
history.

Lets you define whether a PO number is required to complete an invoice
for the customer.

Displays the default reconciliation code for the customer (if any).
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Recon Codes

Fleet Contracts

Inventory

Find

Add
Edit

Delete

Terms

Combine

Cancel

OK

Close

VEHICLE TAB

Lets you enter one or more reconciliation codes for customers who have
national account or government support agreements with your vendors.

Not used.

Lets you look up inventory items to see the customer’s best price for
those items. The best price is the everyday low price or the sale price,
whichever is lower.

Lets you look up a customer or a list of matches using full or partial
entries.

Lets you add a new customer.
Lets you change the customer’s contact and account information.

Lets you delete a customer record that has never been associated with
an invoice, work order, or quote.

Displays the screen for assigning payment terms to the customer.

Lets you select another customer account to inactivate and combine
with the current customer’s account. This option combines the history,
vehicles, and ledgers of the selected customer with those of the current
customer.

Lets you exit the screen in add or edit mode without saving any
changes.

Lets you save changes in add or edit mode and exit the screen.

Lets you exit the screen.

The Vehicle tab (Figure 5-2) lists a customer’s vehicles. From this tab, you can also initiate vehicle
transfers and access service history.
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Custormer Maintenance (12200)

General

ShipTo Ledgeeristor].rl Agingl Information

| & Retail

~ Commercial

iCagney Courier

TRANSIT-250
TRANSIT-250
TRANSIT-250
TRAMNSIT-250
TRANSIT-250
TRANSIT-250

Mileage

CAGENYS 1

CAGMNEYG 99254 1 1HZZ22YYMM202311 | 195
CAGNEY3 50499 1 1XHKZZ99PPKK305511 192
CAGNEY4 75592 1 1ZZLLBBBBRR525256 | 193
CAGENY1 3027 1 ATTFF99HHDD987123 190
CAGNEY2 1 ATTFF55VVEET 298200

R4 s oo B

G457

Eind Vehicle: I Checklist
| ._: I Other Checklist
CUSTOMER
Add | Edit | geletel Iransferl Qombinel History | SIGNUP Egpensel

Figure 5-2: Customer Maintenance Screen Vehicle Tab
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Retail

Commercial

Year
Make
Model
Unit #
License
Mileage
Site

VIN

Find Vehicle
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Displays a list of the customer’s retail vehicles (such as cars, pickup
trucks, and minivans).

Displays a list of the customer’s commercial vehicles (such as dump
trucks, buses, and fork lifts).

Displays the model year for the vehicle.

Displays the make for the vehicle.

Displays the model for the vehicle.

Displays the unit number the customer has assigned to the vehicle.
Displays the license plate number for the vehicle.

Displays the last ending mileage entered for the vehicle.

Displays the site number for the location where the vehicle was added.
Displays the vehicle’s identification number.

Lets you look for a vehicle on the list by make, model, or license plate
number.
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Search Lets you activate the search for a vehicle.

Active Only Displays only the active vehicles on the customer’s vehicle list.

Checklist Lets you access the recommended service checklist for the selected
vehicle.

CARFAX History Lets you access service and repair history that CARFAX has collected
for the selected vehicle.

Other Checklist For future use.

Add Lets you add a new vehicle for the customer.

Edit Lets you change information for the selected vehicle.

Delete Lets you delete a vehicle from the list that is not already associated with

an invoice, work order, or quote.

Transfer Lets you move the history for a vehicle from the selected customer to
another customer. After a transfer, the sales history for the transferred
vehicle still appears in the original customer’s historical ledger.

Combine Lets you combine the history for two vehicles when there are multiple
listings for the same vehicle.

History Displays a list of all the items sold to the customer and the
corresponding invoices for the selected vehicle.

Expense Lets you generate a vehicle expense report for the selected vehicle.

SHIPTO TAB

The ShipTo tab list separate shipping or billing addresses for the selected customer. When you
create new work orders, you can select one of the addresses.

Tip:  To quickly find the address you need from a list of multiple addresses, type all or part of the
address name in the Find ShipTo field. Then click Search.

CUSTOMER LEDGER/HISTORY TAB

The Ledger/History tab (Figure 5-3) displays a customer’s subledger account activity and provides
access the open item ledger. For more information, see Open ltem Ledger.

Tip:  You can limit the number of documents retrieved when looking up a customer’s history by
setting a system control. For more information, see "AR/AP Lookup Date " on page 1134.
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Customer Maintenance (12200)

General | Wehicle | ShipTo Aging! Information |

ICagneyCourier |1 |242
Search I | SortBy: " Reft (= Date (" Invoice #
Date Site |Mod [Invoice Ref Total Amt Charge Amt PO Check #
0212719 |1
022719 |1 185 29.94 29.94
022¢¥M19 | 1 184 1071.84 1071.84
02/25M19 |1 183 515.30 515.30
022519 |1 182 117.94 117.94
0212519 |1 181 789.96 789.96
0212519 1 RO 11T 500.00 0.00 12356
salasassssas AAAAASSSA AAAAASALSAA AAAAASSSA AAAAASASA AAAAASLSA AAAAASSSA AMAS
I( >
View: ¢ AR Ledger Credit Memo | Open Iteml Print | Tax | Besearchl

s History
. E-Mails |

Figure 5-3: Customer Maintenance Screen Ledger/History Tab
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Search Lets you narrow down the documents displayed by invoice number,
reference number, PO number, check number, or amount.

Sort By: Lets you display documents by the transaction date, transaction
reference number, or invoice number.

Note: When Invoice #is selected, additional sorting by site number also

occurs.
(first blank Displays the customer’s name.
field)
(second and Displays the system-assigned customer number. The first digit identifies
third blank the site where the customer was added.
fields)
Date Displays transaction dates.
Site Displays the sites where transactions occurred.
Mod Defines the type of transactions.
Invoice Displays the document numbers for the transactions.
Ref Displays any reference information entered when the transactions
occurred.
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Total Amt
Charge Amt

Paid Amt

PO
Check#

AR Ledger

History

Ext. Hist

Emails
Credit Memo

Open Item

Print

Displays the total amount for transactions (in historical view only).

Functions in one of the following ways:

= |n historical view, shows only the amount charged. For example, a
$100 charge made toward a $120 purchase would show as 100.
ROAs and discounts do not show an amount.

= |n AR view, shows the original amount. For charges and late fees,
this amount is positive. For ROAs and discounts, this amount is
negative.

Shows the amount applied to an item (in AR ledger view only). For
charges and late fees, the amount is displayed as a positive number. For
ROAs and discounts, the amount is displayed as a negative number.

Displays the document number for a PO charge.

Displays the check numbers for AR easy checks and the checks that the
customer used to pay you (in historical view only). Displays the check
numbers for the checks that the customer used to pay you (in historical
view only).

Displays all account activity (charges, payments received on account,
discounts, or other) for the current period, as well as all unpaid or
unapplied amounts from previous periods.

Note: ROAs are displayed as negative amounts, because they
decrease the customer’s balance.

Displays all invoices, ROAs, finance charges, and discounts generated
since the customer’s account was started.

Note: Because the historical ledger is not used to calculate the
customer’s balance, ROAs are displayed as positive amounts.

Lets you access the External History Viewer (if it's installed). For more
information, see "External History Viewer" on page 105.

Lets you email one or more selected documents to the customer.
Lets you create a credit memo for the customer.

Displays the open item ledger, where you can view or apply payments to
outstanding invoices.

Lets you reprint the selected historical invoice or other document.
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Tax Lets you change the amount of sales tax charged for a completed invoice.

Research Lets you view journal entries related to a selected item in the customer’s

subledger in TireMaster Plus and TireMaster Corporate systems.

CUSTOMER AGING TAB

The Aging tab (Figure 5-4) displays a customer’s balances and information about unapplied credits
or unpaid finance charges.

Customer Maintenance (12200)

General | Vehiclel ShipTol Ledger/History

| Information |

iCagney Courier |1 |242

Balance:

UnApplied Credits:
UnApplied Itm Cnt:
Un-Paid Fin. Chrgs:

Current: YTD:

264292

| -500.00 |
1-30;

31-60:

61-90:

I 214292

-500.00
1.00
0.00

| 0.00 |

s Last Statement

0.00

i Current Date

Figure 5-4: Customer Maintenance Screen Aging Tab
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Balance Displays the total amount owed to you.
Unapplied Displays the total of any amounts received on account (ROAs) that have
Credits not been applied to a specific invoice. Unapplied amounts affect the

customer’s balance but remain in the open item ledger until you apply
them.

Unapplied Itm Displays the number of payment and credit items in the customer’s ledger

Cnt that have not been applied.
Unpaid Fin Displays any finance charges that have not been paid.
Chrgs
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Current Displays the balance resulting from in-store charge and finance charge
activity that occurred since the last statement cutoff.

Note: Any ROAs that have never been applied to the customer’s
account are included in the current balance.

YTD Displays the total amount of sales to the customer for the current year. On
January 1, the amount in this field is reset to $0.00.

Note: Year-to-date totals are not calculated for the credit card customer
accounts (such as ZZ-Visa/MasterCard), because those
customer accounts are used for tracking payments received from
credit card companies.

1-30 Displays the balance due as of the last statement.

31-60 Displays the balance due as of the second-to-last statement.

61-90 Displays the balance due as of the third-to-last statement.

Over Displays any balances due for more than 90 days.

Future Displays any balance that will appear as current on the next statement.

Last Statement Lets you view account information for the selected customer as of the last
statement cutoff date.

Current Date Lets you view account information for the selected customer as of today’s
date.

INFORMATION TAB

The Information tab for storing further details about a customer’s account. For example, you could
post additional contacts or billing instructions on it.

Note: Users who are responsible for managing the content on the Information tab need to be
assigned a permission. For more information, see "Customer Edit Information Tab" on
page 1112.

CUSTOMER SEARCHES

Searching for customers is one of most commonly performed tasks in TireMaster. Customer
searches typically occur when starting various transactions and when you need to review information
such as a customer's account balance or history.

To search for a customer

1. Start a task that requires you to search for a customer or select Customers > Maintenance.
TireMaster prompts you for the customer's name.
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2. Type one of the following, or leave the Enter Name field blank to retrieve all customers.

= Name

Tip:  You can use the percent sign (%) to replace an unknown portion of the customer's
name.

= License plate number

= System-generated customer number (disregard the site)

=  Phone number (last four digits of home, business, fax, or cell numbers)
= Unit number

= Vehicle identification number

Note: Partial entries are allowed for names, license plate numbers, unit numbers, and VINs.

3. Toinclude inactive customers in the search, clear the Active Only check box.

Clear the Search All Site check box to limit the search to customers added at your site.

Name Lookup,/Entry (2300}

Enter Mame: |J0NES' JEFF

License # Phone # (Last 4):
Customer # Unit#
VIM #:

[~ Active Only,
¥ Search All Site OK | Cancel |

5. Click OK. One of the following occurs:

= |fthe search finds an exact match, the Customer Maintenance screen opens to the
customer's record.

= |f more than one customer matches the lookup, the Customer List appears. In this scenario,
select the appropriate customer’s name, and click OK.

Tip:  Ifyou selected the wrong customer, click the Prev or Next button on the Customer
Maintenance screen move to the correct customer record.

CUSTOMER PAYMENT TERMS

If you offer in-store charge accounts, you need to assign payment terms to your customers. Payment
terms include due dates, discounts for early payments, and the number of instaliments.

SET DEFAULT CUSTOMER TERMS

Default payment terms are those terms which you extend to the majority of your customers who have
in-store charge accounts. To define your default payment terms, you need to set a variety of system
controls.
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To set default customer payment terms

Customer Payment Terms

Select Setup > System Controls. The System Controls screen opens.

n

Click the Customer tab.

g

Make sure Corporate Controls is selected.

b

Set the requirements for the default due date:

a. Select Default AR Due (D=#Days or T=Date) and press Enter.

Systemn Controls (6400)

Commizsion  Sustomer | Enterprisel General Iedgerl Inventor_l,ll Other I Vendorl

D ezcription |Value ISiteNo | ~
Debit Cards - Allow Cazh Back MO 1

Default 8 Dizcount BDaps/Date 10 1

Default &8 Dizcount [D=#Days or T=Date] D 1

Default AR Dizcount Percentage [%] 200 1

Default AR Due #Days/Date 5 1
; 1

Default AR |rwvaice Terms (HPapments) 1 1

ol Repgsit MIN Dol amount o 0Ly saa PPPPPPPPP Dsnsnsnsns A ahassnana

.

b. Ifthe paymentis due by a specific number of days after the purchase, select Days. If the
payment is due by a specific day of the month instead, select Th. Then click OK.

c. Select Default AR Due #Days/Date and press Enter.

Systemn Controls (6400)

Commizsion  Customer | Enterprisel General Iedgerl Inventor_l,ll Other I Vendorl

D escription |Value ISiteNo | ~
Debit Cards - Allow Cash Back KO 1

Default 48 Dizcount #Daps/Date 10 1

Default 48 Dizcount [D=#Days or T=Date] b} 1

Default &R Dizcount Percentage [%) 2.00 1
] e - 1

Default AR Due [D=HD ays or T=Date) T 1

Default AR |nvaoice Terms [(BPapments) 1 1

ool Dapgsit MIN Dollag amount L0y saa FPPPPPPPP D snsnsnsns A A A ahasssasa

»

d. Type the number that represents the number of days after the purchase or the day of the

month. Then click OK.

5. Set the default number of payments for an invoice:

a. Select Default AR Terms (#Payments) and press Enter.
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Systemn Controls (6400)

Commizsion  Custorner | Enterprize I General ledger I Irventon I Other I Wendor I

Dezcription |\-"a|ue |SiteNo | ~

Debit Cards - Allow Cash Back KO 1

Default &R Dizcount #Daywz/Date 10 1

Default AR Discount [D=#0ays or T=Date] ) 1

Default AR Discount Percentage [%) 200 1

Default AR Due #Days/Date 15 1

Default AR Due [D=HDaps or T=Date] T 1

] i ol — 1

1 Le

b. Type the number of installments and click OK.
6. Setthe default early pay discount percentage:
a. Select Default AR Discount Percentage (%) and press Enter.

System Controls (6400)

Commigsion  Custorner | Enterprisel General Iedgerl Inventor_l,ll Other I \-"endorl

Deszcription |Value |SiteNo | ~
Debit Cards - Allow Cash Back KO 1
Default AR Discount #Daps/Date 10 1

Default 4R Due [D=HDays or T=Date) T
Default &R Invoice Tems [BPayments] 1
ool Diposit MIN Dollar Arount PP P PPN PPN PPN UPY v adde

b. Type the percentage amount and click OK.
7. Setthe requirements for receiving the early pay discount:
a. Select Default AR Discount (D=#Days or T=Date) and press Enter.

Systemn Controls (6400)

Commizsion  Customer | Enterprisel General Iedgerl Inventor_l,ll Other I \-"endoll

Description |Value |SiteN0 | -
Ciebit Cards - &llow Cash Back MO 1
Default AR Discount 8D aps/Date 10 1
Default AR Discount [D=#Days o 1
Default 4R Dizcount Percentage (%) 225 1
Default &R Due #Daps/Date 15 1
Default &R Due [D=HDays or T=Date) T 1
Default AR Invoice Tems [BPayments] 1 1
ool Deposit - MIN Dolla dmount | PP PO PPN POPPTY Uy o ARl

b. If you need to receive the payment by a specific number of days after the purchase, select
Days. If you need to receive the payment by a specific day of the month instead, select Th.
Then click OK.

c. Select Default AR Discount #Days/Date and press Enter.
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Systemn Controls (6400)

Commizsion  Sustomer | Enterprisel General Iedgerl Inventor_l,ll Other I Vendorl

D ezcription |Value ISiteNo | ~
Debit Cards - Allow Cazh Back MO 1

Default 4R Discount #Daps/Date — —

Default &8 Dizcount [D=#Days or T=Date] D 1

Default AR Dizcount Percentage [%] 225 1

Default AR Due #Days/Date 15 1

Default AR Due [D=HD ays or T=Date) T 1

Default AR |rwvaice Terms (HPapments) 1 1

ol Repgsit MIN Dol amount o 0Ly saa PPPPPPPPP Dsnsnsnsns A ahassnana -

d. Type the number that represents the number of days after the purchase or the day of the
month. Then click OK.

8. Close the System Controls screen.

SET A CUSTOMER'S PAYMENT TERMS

When you add a customer, the default payment terms are assigned automatically. If you want to offer
different terms to a customer instead, you can set custom payment terms for that client.

To set custom payment terms

1.

Look up the customer for whom you want to set custom terms. For more information, see
"Customer Searches" on page 89.

On the Customer Maintenance screen, make sure the General tab is selected.

General |‘u’ehicle| ShipTol Ledgerﬂ—Hstoryl Agingl Informationl

Contact

Click Terms. The Terms screen opens.

aga | Eot | ge|ete||1erms| Combine |

To enable early pay discounts, select the Give Early Pay Discounts check box.

To set a unique early pay discount, due date, or both, clear the Use Above Defaults check box.
TireMaster disables the default terms.
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‘ Default Discount %: 2.25

=
‘ Default Discount Days: 10 r

‘ Default Due Date:

v Give Early Pay Discount

sh.a&o‘o.a.o.o.oo BBl b ko S

If you selected the Give Early Pay Discount check box in step 4, do the following:

a. Type the discount percentage in the Discount % field.

Example: To subtract 2% from invoices for which you receive early payment, type 2 in
the Discount field.

b. Ifthe payment must be received a specific number of days after the purchase to give the
discount, type the number of days in the Discount Days field and select Days Later. If the
payment must be received by a specific day of the month instead, type the day of the month
and select Day of Month.

If the payment is due a specific number of days after the purchase, type the number of days in the

Due Date field and select Days Later. If the payment is due by a specific day of the month

instead, type the day of the month and select Day of Month.

b i i e e e e B e B B B e B e e e B

‘ Discount %: 2
- (+ Days Later
‘ Discount Days: 10~ Da; of Month
] (" Days Later
‘ Due Date: 15 & Day of Month

1A AAAAAALAALALALLSALSASAASSASASSASAD

Note: If payments are due on the last day of the month, type 31. TireMaster adjusts due dates
for months with fewer than 31 days.

Under Invoice Terms, select the maximum number of payments the customer can make on an
invoice.

Invoice Terms:
3 Payments
i 4 Payments

lﬂ““#““ e e R R el

Under Future Due, define whether to include future due invoices and balance adjustments on
the customer’s statements.

= To use the future due setting defined on the Statement Setup screen, select Default. For
more information, see "Define Statement Print Options" on page 688.

®  To always include future due items on the customer’s statements, select On.
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=  To always exclude future due items from the customer’s statement, select Off.

~ Definable At Point of Sale

/|vvvvvvvvvvvvvvvvvvvvvvvvvvvvvvvv\

‘ Futire Due: ¢ Defaut & onde™ ¢ OF

QK | Cancel

10. To save your changes, click OK.

CUSTOMER TYPES

Customer types classify customers and ensure that special handling occurs at point of sale. You can
also use customer types to organize information on several reports.

When you start a work order, TireMaster looks at the customer’s type code to determine the
following:

= Whether you'll be prompted to select a vehicle

= Whether you'll be prompted to select a tax level

= Whether to include add-on items on the work order

= Which general ledger accounts the completed sale will post to

TireMaster comes with several customer types that you can customize and you can add your own. If
you’re looking for information about vendor types, see "Vendor Types" on page 180.

ADD A CUSTOMER TYPE

Although TireMaster comes with several customer types, you can create additional types to further
classify your clients. Before you set up your customer types, talk to your accountant about which
general ledger accounts any new types should post to.

To add a customer type
1. Select Customers > Types. The Customer/Vendor Type List opens.

Customers
Maintenance
Easy Checks
Types
Contact Types

LAAAASASLSASSSSS

2. Click Add. The Customer/Vendor Type Edit screen opens.
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Wholesale Sales

3 <
4 Farm Sales 1
E Employee Sales 3
N Mational Account Sales 4
3
b

Add Edit | Delete |

3. Define a unique code for the customer type in the Type field.

Note: Forease of use, use only letters or numbers.

4. Inthe AP or AR field, type AR.

Type a description for the customer type.

Customer / Vendor Type Edit (1300)

Type b} AP TAR |AR

Description |G0vernmemSupp0rtSales

Accounts

\AAAAMQ"AAAAAA[AAAAAJAA‘AAAAAA‘I

6. Assign the generalledger accounts for posting sales for the new customer type. To assign an
account, click the account field, press [7], and select an account from the list that appears.

P VTV T TV VT P T T T VIV Py oy vy vy vy vy
Accounts

AR Acct 1100 100
AP Acct: 2000 100
AR Dis Acct 4600 0
AP Dis Acct 5600 0
Exp. Acct 9999 99499

LAAAALALSLASSSSSSSSSSSSSSSSSS0SSSSH

7. Select any options that you want to enable for the customer type. For more information, see
"Customer Type Edit Screen" on page 99.

8. Toassign a department to the type, click the Department field, press [z], and select an account
from the list that appears (optional).

T T T T T P r T T o e T T YT T T T T T T T T T T YT

Options
| | [~ Addons
v Wehicle [T TaxSelect [

[+ FET Exempt [ DirectDeposit
[~ Price Levels for Mational/Gs

Department 1

9. To save the customer type, click OK.

SET THE DEFAULT CUSTOMER TYPE

The default customer type is the setting that identifies your typical customer. For example, if most of
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your customers buy tires and services for their personal vehicles, you would define the retail
customer type as the default. The default customer type is automatically assigned each time you add
a new customer. The default customer type is defined with a system control.

To set the default customer type

1. Select Setup > System Controls. The System Controls screen opens.
2. Click the Customer tab.
3. Select Customer Default Type and press Enter. The Customer/Vendor Type List opens.
Commizsion  Customer | Enterprize | General ledger Inventor_l,ll Mone I Other I \.-"endorl
Drescription |Value ISiteNol ~
Customer - Transfer Type
Cuztamer D efault Type — =
Select the type you want to use as the default, and click OK.
Close the System Controls screen.
ASSIGN A CUSTOMER TYPE

When you create a customer record, the default customer type is automatically assigned to the new
customer. You can leave this setting alone or change it. You can also change the type assigned to
existing customers.

To assign a customer type

1.

Add a customer or look up the customer whose type you want to change. For more information,
see "Add a Cash Customer" on page 66, "Add an AR Customer" on page 68, or "Customer
Searches" on page 89

When the Customer Maintenance screen opens, make sure the General tab is selected.

General |\u’ehicle| ShipTol Ledgerﬂ—Hstoryl Agingl Informationl

Click Edit.

Find |  Adg || Edit | Delete | Terms | Combine

Click the Type field and press [z]. Then select a type from the list that appears.
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P R RO R Y Y Y Yy vy Y VVV‘HHL,“M_VY WYY

¥ Finance Charge
F Type: M

Tax 1D

1A

P TV ORIV NN IOV Y rwewy

Maotes:

5. To save the change, click OK.

UPDATE A CUSTOMER TYPE

If you need to update customer types, you can easily adjust the options for handling point of sale and
received on account activity. In TireMaster Plus and TireMaster Corporate, you can also choose to
post sales activity to different GL accounts.

To update a customer type

1. Select Customers > Types. The Customer/Vendor Type List opens.

Customers
Maintenance
Easy Checks
Typs%
Contact Types

LAAAASLSLLLSASSSSS

2. Select the type you want to updated and click Edit. The Customer/Vendor Type Edit screen
opens.

Ty YY & VYT YTYYY
ME “Wholesale Sales 4

E Employee Sales
M Mational Account Sales

Add |I Edit I Delete |

3. Do the following as needed:

b b

= Change the GL accounts.
= Select different options.

= Change the department.

To update the GL accounts or department, click the field that needs to be changed. Then press
[r]and make a selection from the list that appears.

4. To save your changes, click OK.

DELETE A CUSTOMER TYPE

If a customer type is not assigned to any customers, it can be deleted.
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To delete a customer type

1. Select Customers > Types. The Customer/Vendor Type List opens.

2. Select the type you want to remove and click Delete. A confirmation message appears.
3. Click Yes.

CUSTOMER TYPE EDIT SCREEN

The settings for customer types are defined on the Customer/Vendor Type Edit screen (Figure 5-5).
Vendor types are also set up and maintained with this screen. For more information, see "Vendor
Types" on page 180.

Customer / Vendor Type Edit (1300)

Type M AP AR !AR

Mational Account Sales

Description
rAccount
AR Acct: 1100 100
AP Acct: 2000 100
AR Dis Acct: 4600 0
AP Dis Acct 5600 0
Exp. Acct 9999 9999
—Option
[T Charge [ Ship-Ta v Addons
¥ Vehicle [ TaxSelect [~ Wholesale
[~ FETExempt [ Direct Deposit
[~ Price Levels for MationallGS
Department I 1

concl_|
Figure 5-5: Customer Type Edit Screen
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Type Lets you define a number or letter for identifying the customer or vendor
type. (In add mode only.)

Note: Vendor types are used only in TireMaster Plus and TireMaster
Corporate.

AP or AR Defines whether the type is for accounts payable (vendors) or accounts
receivable (customers).

Note: Vendor types are used only in TireMaster Plus and TireMaster
Corporate.

Description Lets you enter a description for the type.
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fom _ Jpmserpton

Accounts:

AR Acct

AP Acct

AR Dis Acct

AP Dis Acct

Exp Acct
Charge
Ship-To
Addons

Vehicle

Tax Select

Wholesale

FET Exempt

Direct Deposit

100

Lists the major and minor general ledger accounts to post to for
transactions involving the type.

Note: In TireMaster, use the preset accounts listed in "Add a
Customer Type" on page 95.

Lets you define the general ledger account for posting accounts
receivable amounts.

Lets you define the general ledger account for posting accounts payable
amounts.

Lets you define the general ledger account for posting accounts
receivable discounts.

Lets you define the general ledger account for posting accounts payable
discounts.

Lets you define the general ledger account for posting any expenses.
Not used.
Not used.

Defines whether add-on items are included on work orders and quotes
for customers assigned the type.

Defines whether the vehicle list is displayed when starting work orders
for customers assigned the type.

Defines whether users are prompted to choose a tax level when starting
work orders for customers assigned the type.

Not used.

Defines whether customers assigned the type are exempt from paying
federal excise tax. When a customer type is FET exempt, TireMaster
automatically removes the federal excise tax from work orders for
customers assigned that type.

Defines whether ROAs from customers assigned the type should be
processed as direct deposits. When this setting is enabled, the Direct
Deposit check box is automatically selected on the ROA completion
screen.



Customer Color Codes

fom  Jomsertpton

Price Levels for Defines whether price levels can be used for national account and

National/GS government support customers.

Department Lets you define the department (if any) for transactions involving the
type.

CUSTOMER COLOR CODES

You can use color codes to easily identify customers who meet certain characteristics, such as those
for whom you’ve written off bad debt. Color codes are displayed in customer records, on the
Customer List, on the Open Work Order List, and on the Invoice Entry screen.

CREATE A COLOR CODE

Before you can assign color codes to customers, you need to create them. Customer color codes
can be created at the Corporate site only.

To create a color code
1. Select Setup > Customer Color Coding. The Customer Color Codes screen opens.

Setup |

Systemn Controls I

Edit Global Cornments
Vehicle Service Checklist
Customer Color Coding

Appeintment Scheduling

2. Click Add. The Add/Edit Color Codes screen opens.

Add Edit | Delete |

3. Type adescription for the color code.
4. Assign a color to the code.

a. Click Select. The Color screen opens
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Add/Edit Coler Codes (16395)

Description |BAD DEBT

oK

FY VYWY YYYWWH

b. Selectthe color you want to use and click OK.

Basic colors:

ul inf 10
ol IR B
EEEEEN
ENEEEEEN

Define Custom Colors »>

I oK I Cancel |

c. To save the new color code, click OK (again). The new color code is added to the list of color
codes.

Add/Edit Color Codes (16393)

4

Description IElAD DEBT 1
Color - §e|ec1|

FYVYVYY VYV VN

5. Close the Customer Color Codes screen.

UPDATE A COLOR CODE

In some instances, you might want to change the description or color for an existing code.

To edit a color code
1. Select Setup > Customer Color Coding. The Customer Color Codes screen opens.

Setup |

System Controls l
b d s st b0t Lttt ot s

Edit Global Cormments
Vehicle Service Checklist
Custemer Celor Coding I}
Appointment Scheduling

2. Select the code that you want to update, and click Edit. The Add/Edit Color Codes screen opens.
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Customer Color Codes (16349)

Description <
BAD DEBT ) 4
ﬂ OVERDUE BALANCE —=

VIP CUSTOMER

Add || Edit l Delete |

3. Type a new description if needed.

FY VYV VVYTYV VN

To change the color, click Select. Then choose a new color and click OK.

Add/Edit Color Codes (16395)

Description |D‘JERDUE BALANCE

oK

L et

5. Click OK (again).

Add/Edit Color Codes (16395)

Description IDVERDUE BALANGE

coor [ sec |

LR R

6. Close the Customer Color Codes screen.

DELETE A COLOR CODE

If you no longer use a color code, you can delete it.

To delete a color code
1. Select Setup > Customer Color Coding.
2. Select the color you want to remove and click Delete. A confirmation message appears.
Note: Ifa color code has been assigned to customers, it will be removed from those customer
records when it is deleted.

3. Click Yes. The color code is deleted.

ASSIGN COLOR CODES TO CUSTOMERS

When you assign a color code to a customer, the customer’s name is highlighted with the assigned
color on the Customer Maintenance screen, the Customer List, the "Open Work Order List" on
page 428, and the Invoice Entry screen.
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To assign a customer color code

1. Add a customer or look up the customer whose type you want to change. For more information,
see "Add a Cash Customer" on page 66, "Add an AR Customer" on page 68, or "Customer
Searches" on page 89.

2. Onthe Customer Maintenance screen, make sure the General tab is selected and click Color.
The Customer Color Codes screen opens.

General |\u"ehic|e| ShipTol Ledgerﬂ—nstoryl Agingl Infor]

Mame: |DRAKE, CRAIG
Address: [785 DENTON

Address2:
City: |MERIDIAN

State: 'lD— Zip: |33642 I Calor IJ

3. Select the code you want to assign to the customer, and click OK. The selected color is added to
the name field and is displayed in a swatch next to the Color button.

Customer Color Codes (16349)

Description Color ~

I QK I Cancel |

4. Close the Customer Maintenance screen.

REMOVE COLOR CODES FROM CUSTOMER RECORDS

If a color code should no longer be associated with a customer, remove the code from the customer’s
record.

To remove a customer color code

1. Look up customer whose color code you want to remove. For more information, see "Customer
Searches" on page 89.

2. Onthe Customer Maintenance screen, make sure the General tab is selected and click Color.
The Customer Color Codes screen opens.
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Customer Maintenance (12200)

<

4
General “u’ehiclel ShipTol LedgerIHistonrl Agingl Inforﬂ

[isme: GARNERCOUNTYSHERFF

Address: [27 BERRY DR.
Address2: |
City: [NAMPA

state: [0 zip: [84686 [Ccoor |

B B b b b A

3. Click Cancel. A confirmation message appears.

|

W

I oK I Cancel |

4. Click Yes. The coloris removed from the Name field and the swatch.

e e ik

5. Close the Customer Maintenance screen.

EXTERNAL HISTORY VIEWER

With the External History Viewer, you can look up and print copies of invoices from sales that
occurred in TireMasterDOS or TireMaster Lite. You can access the viewer from a customer’s ledger
history and vehicle history.

Note: The External History Viewer displays invoices only if you've had ASA Client Services load
TireMaster DOS or TireMaster Lite data into your current TireMaster system.

VIEW DOS AND LITE CUSTOMER HISTORY

You can access the External History Viewer from the Ledger/History tab on the Customer
Maintenance screen. This function lets you view invoices for all sales to the selected customer that
occurred in TireMaster DOS or TireMaster Lite.

To view DOS and Lite customer history

1. Look up the customer whose history you want to view. For more information, see "Customer
Searches" on page 89.

When the Customer Maintenance screen opens, click the Ledger/History tab.
Click Ext. Hist. The General External History Viewer opens.

Select an invoice in the top pane. TireMaster lists the items sold on that invoice in the bottom
pane.

5. To printinvoice history, do one of the following:
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= Fora copy of the selected invoice only, click Print.

= For a copy of all previous-system invoices, select the Print external history for this cus
check box, and click Print.

The Report Window opens.
6. Click Print and then close the Report Window.

VIEW DOS AND LITE VEHICLE HISTORY

You can use the External History Viewer to look up invoices associated with a particular vehicle. This
function lets you see which parts and services were sold for the selected vehicle in transactions
performed in TireMaster DOS or TireMaster Lite.

To view DOS and Lite vehicle history

1. Look up the customer whose vehicle history you want to view. For more information, see
"Customer Searches" on page 89.

When the Customer Maintenance screen opens, click the Vehicle tab.

Select the vehicle whose history you want to view and click History. The Vehicle History screen
opens.

Click Ext. Hist. The General External History Viewer screen opens.

5. Selectaninvoice in the top pane. TireMaster lists the items sold on that invoice in the bottom
pane.

6. To printa list of all invoices associated with the selected vehicle, click Print. The Report Window
opens.

7. Click Print and then close the Report Window.
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CHAPTER 6

VEHICLES

TireMaster includes a variety of tools for managing your customers’ vehicles. Along with adding new
vehicles and updating existing vehicles, you can also retrieve vehicle service history. This chapter
includes the following sections:

Add a Customer’s Vehicle .. ... . 108
Manage Existing Vehicles ... ... .. 110
Retrieve a Vehicle’s History ... . il 115
CARF AX Applications .. 116

Commercial Vehicles
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ADD A CUSTOMER’S VEHICLE

You can add a customer’s vehicle as a standalone task or at point of sale when starting a quote or a
work order.
To add a customer’s vehicle

1. Look up the customer or start a work order or a quote. For more information, see "Customer
Searches" on page 89, "Create a Regular Work Order" on page 410 or "Basic Tire Quotes" on
page 469.

2. Do one of the following:
= |fthe Customer Maintenance screen is open, click the Vehicle tab. Then click Add.
= |fthe Vehicle Listis open, click Add.

Vehicle List (5300)

Wehicle |

| f+ Retail i Commercial

PN PR aey

IARMINGTDN, TOMMY

13 |DODGE |CHARGER |2CKJ93-

Editl Qeletel Iransferl Qombinel

The Retail Vehicle screen opens.

3. Click Choose. The Standard Vehicle Selection screen opens.

Retail Vehicle (700)

Veh#: |1_| Cust: |1_ |160

Year: I

Make: I I Choose I
MMMO
Note: Depending on a system control setting, the year for the vehicle will be added as a two digit

(such as 16) or four digit (such as 2016) number. For more information, see "Vehicle
Year Format" on page 1127.
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Tip:  If you know the vehicle’s VIN or license plate number and state, you can skip this step.
VIN and plate numbers can be used to retrieve year, make, and model information from
CARFAX. For more information, see "CARFAX Applications" on page 116.

4. Selectthe vehicle’s year, make, model and option/engine. Then click OK.

Standard Vehicle Selection {14800)

Year | A |Make | A | Model | Option/Engine

2020 PORSCHE BRZ &1l Optians

2013 Rk CROSSTREE

REMALILT FORESTER 2.5 LIMITED

2017 ROLLS-ROYCE IMPREZA, 2.5 FREMIUM

2016 SEA-DO0 LEGACY 25 TOURING

2015 SEAT QUTE. 3.ER LIMITED

2014 5KI-DO0 WA 36R TOURING

2013 SMART WX STI

2012 SUBARL N

20Mm SUZLIKI

2010 TESLA

2009 TEXTRON

2NN ¥ lTnvnTa v “ v
Ok LCancel |

Note: Ifthe vehicle isn’t on the list, click Cancel and type the vehicle information on the Retail

Vehicle screen.

5. Type the vehicle’s license number, VIN, and unit number (when applicable).

Retail Vehicle (700)

Veh#: |1_| Cust#: |1_ |160

Year: I‘IB
Make: ISUEI\ARU Choose |

Madel: |ouTBACK

Suby [251

License#: |1D4ETJJ & State IIDT‘
VIN: |1DDDD82633XUU4352‘.ﬁRFAX Search |
Unit: | &

Mileage: |0 v Active

l CUSTOMER l
SIGNUP oK Cancel

6. To save the new vehicle, click OK.
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MANAGE EXISTING VEHICLES

Occasionally, you might need to correct an error, such as a typo in the license plate number, or
remove a duplicate vehicle entry. If one customer sells a vehicle to another customer, you can also
update your records to reflect the change in ownership.

UPDATE VEHICLE INFORMATION

If the information about a customer’s vehicle contains errors, you can correct the inaccuracies by
editing the customer’s record.

To update vehicle information

1. Do one of the following:

= Look up the customer whose vehicle information you want to edit. When the Customer
Maintenance screen opens, click the Vehicle tab. For more information, see "Customer
Searches" on page 89.

General |Vehicﬁi;ﬂo| Ledgerﬂ—iistor}rl Agingl Informationl

= Retrieve a customer's work order. Then click Vehicle on the Invoice Entry screen. For more
information, see "Retrieve a Customer's Work Order" on page 419.

Invoice: 132 | 22019 ~| sales ||DJ

Sold To: ||ARMINGTDN,TDMMY Contact | Tax Level |
Ship To: || |2us-5554499 |

Wehicle |‘13CHARGER DODGE 2CKJ934 (0) IS‘u’C Chi_(l Eitmentl

2. Selectthe vehicle and click Edit. The Retail Vehicle screen opens.
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Vehicle List (3300)

Wehicle |

| f+ Retail ~ Commercial

IARMINGTDN, TOMMY

FW WYYy TYwTrvywwn

13 |DODGE |CHARGER — |

|2cKJ93
18 | SUBARU OUTBACK 1D467.

Qeletel Transfer | gnmhinel

3. Do one of the following:
= Type the needed changes.
= Click Choose to select a different vehicle.

= Type the VIN or license plate number and state, and click CARFAX Search (on TireMaster
systems integrated with CARFAX).

4. To save your changes, click OK.

COMBINE A CUSTOMER’S VEHICLES

If the same vehicle is listed in a customer’s record two or more times, you can remove the entries by
combining the vehicles. When vehicles are combined, history from the deleted vehicle is added to the
history for the vehicle that you keep.

To combine vehicles

1. Look up the customer whose vehicles you want to combine. The Customer Maintenance screen
appears. For more information, see "Customer Searches" on page 89.

2. Click the Vehicle tab.

General |Vehicﬂi;ﬂo| Ledgerﬂ-ﬁstor].rl ﬁ.gingl Informationl

3. Select the vehicle you want to keep and click Combine. The Customer Vehicle Selection screen
opens.
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Customer Maintenance (12200)

L]

4

General Vehicle |ShipT0| Ledgerﬂ—listor}rl Agingl Informationl :
4

L

| & Retail ¢ Commercial 1

4

|GILEERT, JOYCE '

4

Year [Make [Moder |unit#  [License [mileage |site [vin <
10  HYUNDAI ACCENT 1ABWOS6 0 1 4

|HYUNDA! |ACCENT GLS —

|1ABWO056 |0 1 |KMHCN4AC
1

Find Vehicle: | Search | ¥ Active Only
CARFAXHistor].fl

gdd| Editl gelete| Iransferl Combine History

CUSTOMER
SIGNUP

L

4. Select the vehicle that you want to remove from the customer’s record, and click OK. A
confirmation message appears.

Custormer Vehicle Selection (148310)

" Commercial | Main Vehicle: 10 HYUNDAIACCENT GLS - - 1AGW056

98 | JEEP CHEROKEE 1AHE467 0 1 1J4FJ6BSTW TG

Lo o oo sy .
k. i
I Ok I Cancel | ‘

IGILEIERT, JOYCE

5. Click Yes. The extra vehicle is inactivated.

TRANSFERRING A VEHICLE TO ANOTHER CUSTOMER

In some cases, such as a vehicle sale, you might need to transfer a vehicle from one customer to
another.

To transfer a vehicle to another customer

1. Look up the customer who sold the vehicle. For more information, see "Customer Searches" on
page 89.

2. When the Customer Maintenance screen opens. click the Vehicle tab.
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General |Vehicﬂi;ﬂo| Ledgerﬂ-ﬁstor].rl ﬁ.gingl Informationl

3. Select the vehicle you need to transfer and click Transfer. TireMaster prompts you for the
customer's name.

General Vehicle |ShipT0| Ledgerﬂ—nstor}fl Agingl Informationl

‘ f+ Retail " Commercial

IGILEERT, JOYCE

Year |Make Model Unit#  |License |[mileage [site |vin <
10 HYUNDAI ACCENT GLS 1ABWO56 0 1 KMHCN4A
" |1AHS467 1J4F JB8ST,

Eind Vehicle: | Search | ¥ Active Only

CARFA)(HistUr].{l [
CUSTOMER
aod | Edt | Delete | Iransferl Combine | isoy | LI

4. Look up the name of the customer who purchased the vehicle. TireMaster prompts you to
confirm the transfer.

5. Click Yes. The vehicle is removed from the customer record for the seller and is added to the
customer record for the buyer.

DELETING VEHICLES

You can delete a vehicle from a customer’s record, regardless of whether any history is associated
with that vehicle. First, look up the customer whose vehicle you want to delete. Then click the
Vehicle tab on the Customer Maintenance screen, select the vehicle you want to remove, and click
Delete.

Note: If a vehicle has history and you no longer want to display it on the Vehicle List, you can
inactivate it instead. For more information, see "Make Vehicles Inactive " below.

MAKE VEHICLES INACTIVE

In some cases, you might need to remove a customer’s vehicle from the list of active vehicles but
maintain the vehicle’s history. On such occasions, you can inactivate a vehicle, which lets you save
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the historical information while hiding the inactive vehicle on the Vehicle List.

To inactivate a customer’s vehicle
1. Do one of the following:

= ook up the customer whose vehicle you want to inactivate. Then click the Vehicle tab on the
Customer Maintenance screen. For more information, see "Customer Searches" on
page 89.

Customer Maintenance (12200)

General |Vehicﬁi;ﬂo| Ledgerﬂ—iistor}rl Agingl Informationl

= At point of sale, click the Vehicle button on the Invoice Entry screen.

W Invoice Entry (3300)

Invoice: 133 | 822019 | sales ||Admin

Sold To: ||GILELERT,JDYCE Contact | Tax Level |
Ship To: | | |203—55&9393 |

|svc Cm_<| Eitmentl

Wehicle | I‘IUACCENT GLS HYUNDAI 1ABWO0SE (0)

2. Select the vehicle you want to make inactive and click Edit. The Retail Vehicle history screen
appears.

i

Wehicle |

| i+ Retail = Commercial

|GILEIERT, JOYGE

FY I T YwYTvyw.

10 [HYUNDAI |ACCENT 6LS — | [1a6wWo0s

15 | MERCEDES-BEPM GLK250 BLUETEC FICKLE

Qeletel Transfer | gnmhinel

3. Clearthe Active check box.
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i

E QK I Qancell

4. To save your changes, click OK.

Retrieve a Vehicle’s History

When you need to display the inactive vehicle on the Vehicle tab or the Vehicle List, clear the Active

Only check box.

RETRIEVE A VEHICLE’S HISTORY

You can view a vehicle’s service history at point of sale or by looking up the customer record for the

vehicle’s owner.

To retrieve a vehicle’s history

1. Do one of the following:

= At point of sale, click the Vehicle button on the Invoice Entry screen.

Invoice: 131 | & 212019

j Sales | |5—

Sold To: | IARMINGTDN, TOMMY

Contact |

Tax Level |

Ship To: ||

|203—55&4499

Vehicle II‘IB OUTBACK SUBARU 1D467.J (0)

|svc cm;| Eitmentl

® Look up the customer record for the vehicle’s owner. When the Customer Maintenance
screen opens, click the Vehicle tab. For more information, see "Customer Searches" on

page 89.

General |Vehicﬂi;ﬂo| Ledgerﬂ-ﬁstor].rl ﬁ.gingl Informationl

2. Select the vehicle whose history you want to view and click History. The Vehicle History screen
appears. It lists the parts and services that were previously sold for the vehicle, along with the
ending mileage at the time the items were sold.

115



User Guide

Vehicle List (5300)

Vehicle |

‘ * Retail ~ Commercial

IARMINGTDN, TOMMY

Year |Make [moder [unit#  [License [mileage [site [vin |ven =
13 DODGE CHARGER 2CKJ934 0 1 2C3CDXBG4DHE37340 103

18 |SUBARU |ouTBACK | |1D46700 [15031 |1 [1DDDD82633X004352 [172

Find Vehicle: I Search | v Active Only Checklist

E;ARFA)(Histgml Other Checklist
CUSTOMER

3. Toprinta duplicate invoice for a previous visit, select a line for that visit and click Reprint.

Description
LUBE, OIL & FILTER = 5QTS —"
REST AIS POTEMNZA
COMPUTER BALAMCE - PASS.

Reprint I Cancel |

225/60R18

0.00 011340
11.99 29

188.11
0.00

4. To close the Vehicle History screen, click Cancel.

CARFAX APPLICATIONS

TireMaster is integrated with various CARFAX® Service Network applications. If you're a CARFAX
subscriber, you can use TireMaster's CARFAX Interface to easily retrieve a vehicle’s year, make, and
model information and its service history. The CARFAX Interface also gives you the ability to submit
repair information from your shop to CARFAX, along with the means to register customers for the
myCARFAX service reminder mobile app.

RETRIEVE VEHICLE INFORMATION WITH CARFAX

With TireMaster’s integration to the CARFAX® QuickVIN™ application, you can look up a vehicle’s
year, make, and model based on its VIN or license plate number. You can retrieve vehicle
information in this manner when adding new vehicles or updating existing vehicle records in
TireMaster.
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To look up vehicle information

1. Begin the process of adding a new vehicle or updating an existing vehicle record. FFor more
information, see or .

2. Onthe Retail Vehicle screen, type one of the following:
= The license plate number and state
= The VIN

3. Click CARFAX Search. One of the following happens:

= Ifyoufilled in the license plate number and state, the VIN, year, make, model, and submodel
information appears.

= [fyoufilled in the VIN, the year, make, model, and submodel information appears.

4. To save the vehicle information, click OK.

SUBMIT SERVICE INFORMATION TO CARFAX

The CARFAX Interface is used to submit repair data to CARFAX. That data is used on reports for
consumers and the CARFAX Service History Check for service shop technicians. Vehicle data from
TireMaster is electronically submitted to CARFAX daily at 2:00 AM.

RETRIEVE CARFAX SERVICE HISTORY

With TireMaster’s integration to the CARFAX® Service History Check™, you can retrieve service and
repair history that CARFAX has collected for a customer’s vehicle. With this information, you can
learn about services performed on the vehicle at other shops that also submit repair data to
CARFAX.

To look up a vehicle’s CARFAX history

1. Do one of the following:

= Look up the customer whose CARFAX vehicle history you want to retrieve. When the
Customer Maintenance screen opens, click the Vehicle tab. For more information, see
"Customer Searches" on page 89.

= Open the work order for the customer whose CARFAX vehicle history you want to retrieve.
Then click Vehicle on the Invoice Entry screen.

Select the vehicle.
Click CARFAX History. The service history opens in another screen.
For a hard copy of the CARFAX history, click Print.

When you’re done reviewing the CARFAX service history, close all of the open screens.

o b

REGISTER CUSTOMERS FOR MYCARFAX

You can offer to register both new and existing customers for myCARFAX®. This tool is a mobile app
that helps you increase customer loyalty and return visits to your shop. Customers who sign up for
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myCARFAX will receive service reminders and a list of shops they’ve previously visited, including
yours. A perk of signing up customers for myCARFAX is that your store is listed as their favorite shop
on those service reminders. You must receive verbal authorization from customers to register them
for a myCARFAX account.

To register customers for myCARFAX

1. Add a new customer or look up an existing customer. For more information, see "Add a Cash
Customer" on page 66, "Add an AR Customer" on page 68, or "Customer Searches" on
page 89.

On the Customer Maintenance screen, click the Vehicle tab.
Do one of the following:

®  For new vehicles, click Add and retrieve the vehicle information with CARFAX. For more
information, see and "Retrieve Vehicle Information with CARFAX" on page 116.

= For existing vehicles, select the vehicle you want to register.
Click myCARFAX Customer Signup. The myCARFAX Signup screen appears.

Type the customer’s email address. If the customer’s contact information includes an email
address, it's already entered for you.

6. Toindicate that the customer has given you verbal authorization to sign up for myCARFAX, make
sure the check box is selected.

Click the myCARFAX Customer Signup icon. A field with a confirmation message appears.

Close the myCARFAX Signup screen. If you just added a vehicle, close the Retail Vehicle screen
too.

SET UP THE CARFAX INTERFACE

Before you can use the CARFAX Interface, you need to complete a variety of settings that will
connect your TireMaster system to CARFAX. If you plan to offer myCARFAX registration to
customers, review the end user license agreement for myCARFAX at
https://service.carfax.com/csn/csnTerms.
To set up the CARFAX Interface
1. SelectInterfaces > Interface Setups. The Interface Setup screen appears.
2. Click CARFAX Interface. The CARFAX Settings screen appears.
3. Enter the following information:

®= The address for the store web site in the URL field.

=  The name of the business contact for your store. By default, this field displays the name of the
store contact that was entered on the site setup screen. You can change the name, if needed.

= The name of the technical contact for your store.
= The email address to which correspondence from CARFAX should be sent.

4. Update the location name and contact information if needed.

118


https://service.carfax.com/csn/csnTerms

Commercial Vehicles

Click Authorize.

Note: The information you entered can be authorized only once. If you need to change the
information, contact the CARFAX Service Network Support Team at 888-655-5362 and
select option2.

If you want to offer myCARFAX registration to customers, accept the myCARFAX end user

license agreement. Otherwise, skip this step.

a. Click myCARFAX Authorization. The myCARFAX Signup EULA screen appears.
Note: Forthe full end user license agreement, visit

https://service.carfax.com/csn/csnTerms.

b. Click Accept.

c. Close the myCARFAX sign up screen.

Click OK.

Close the Interface Setup screen.

COMMERCIAL VEHICLES

Commercial vehicles are those vehicles which are designed to perform a specific task. Examples of
commercial vehicles include buses, forklifts, and dump trucks.

While information about retail vehicles is listed by model, vehicle subclass, and engine size,
commercial vehicle information is based on function. Commercial vehicle settings include the
following:

Type: Identifies the kind of vehicle (cement mixer or a refrigerated van)

Application: Identifies how or where the vehicle is used (Light commercial, over the road, or
pick up and delivery)

Miles/Hours: Identifies the last recorded mileage or last recorded hours of use

ADD A COMMERCIAL VEHICLE

The manner in which commercial vehicles are added to a customer’s record is similar to that for
adding retail vehicles.

To add a commercial vehicle

1.

Look up the customer start a work order or a quote. For more information, see "Customer
Searches" on page 89, "Create a Regular Work Order" on page 410, or "Basic Tire Quotes" on
page 469.

Do one of the following:

= |fthe Customer Maintenance screen is open, click the Vehicle tab. Then select
Commercial.

= |fthe Vehicle List is already open, select Commercial.
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Custormer Maintenance (12200)

General Vehicle |ShipT0| Ledgerﬂ—iistor].rl Agingl Informationl

|  Retail

IDEKTER'S DELIVERY SERVICE

Find Vehicle: |

Add gdit| ge|ete| Transfer | Combine

4. Type the vehicle’s information.

Commercial Vehicle {

Veh#: |1_| Cust#: |1_ |226
Year: |12

Make: IINTERN:&TIDNAL 4400 Choose |
Type: |EIDX TRUCK

Application: |

License#:  [C990011 State |ID

VI | CARFAX Search
Unit [15

Miles/Hours: |0 v Active

CUSTOMER

OK Cancel

5. To save the new vehicle, click OK.
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CHAPTER 7

TEXT AND EMAIL

With TireMaster's text and email applications, you can send messages and various documents to
customers and vendors. This chapter includes the following sections:

TV T Xt L 122
Prepare to Email Documents .. . .. 142
Email DoCUMENtS . 145
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TMTEXT

With the TMText application, you can send text messages to customers and vendors. If you use
TireMaster‘'s Scheduler, you can also use TMText to send appointment reminders to customers.

PREPARE TO USE TMTEXT

Before you can use TMText, you need to complete settings that make texting available at point of
sale and define whether to send automated appointment reminders to customers. You can also
create predefined messages (such as thank you notes and reminders) that can be reused.

DEFINE THE SOURCE NUMBER

With the source number for TMText, you define the phone number from which text
messages are sent. This setting allows you to display a ten digit phone number (such as
111-222-3333) on devices receiving text messages instead of SMS (short message
service) short codes (such as 111-00).
To define the source number
1. Access the TireMaster - Texting screen.

a. Ifthe Open Work Order Listisn’t already open, click Invoicing.

b. Click Text. The TireMaster - Texting screen opens.

2. Click Text Setup. The Text Message Setup screen opens.

Text Setup

»
»
»
»
»
»
»
»
»

3. Click Source Num.
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.

Source Num

VYT TYYY

=

4. Type the ten digit phone number for sending text messages in the Source Number
field, and click OK.

Source NMumber

Source Humber:
| 2085550000

I QK. I Cancel |

Note: To ensure text messages send, exclude hyphens from the entry for the source
number. (Example: 2085550000.)

5. Close the Text Message Setup screen.

Note: Since you're already working in the Text Message Setup screen, you can
create predefined messages (such as thank you notes, service reminders, and
an appointment notification) now or you can wait until later. For more
information, see "Add Predefined Messages" on page 125.

ENABLE TEXTING FOR WORK ORDER STATUS CHANGES

You can send text messages to customers when there are status changes for their work
orders (such as when the status goes from In Progress to Done). You can indicate whether
texting is available for each work order status. For more information, see "Send Text
Messages for Work Order Status Changes" on page 136.

To enable texting for work order status changes

1. Select Setup > WO Status. The Work Order Status Options screen opens.

2. Select a status for which you want to enable texting, and click Edit. The WO Status
screen opens.

3. Selectthe Send Text check box.
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WO Status (16602)

Option Mame |In Process = 4«
Option Symbol |P [~ Default Status

Option Color -

|

Cancel |

4. To save your changes, click OK.

5. Repeat steps 2 through 4 to enable texting for another status, or close the Work Order
Status Options screen.

ENABLE TEXTING FOR COMPLETED INVOICES

You have the option to send text messages to customers when you complete their sale
invoices. By setting a system control, you can define whether the texting screen opens as
part of the invoice completion process.

To enable text messaging for completed invoices

1. Select Setup > System Controls.

Setup
System Controls I}
Printers

WO Status

Users & Permissiens

Menu Configuration

Click the Other tab.

Select Texting - Send Thank You Text at Completion and press Enter.

System Controls (8400)

Commissionl Eustomerl Enlerprisel General Iedgerl Ireventary  Other |\-"endu:|r|

Drescription

|Value

|SiteNo| A

Statement - Print Addreszz (VES or MO

Texting - Send Automated Appointrient Feminders

Teuting - Send Thank You Text at Completion _—

YES

YES

4. Forthe option to send text messages, select Yes and click OK. Otherwise, select No

and click OK.

5. Close the System Controls screen.
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ENABLE AUTOMATED APPOINTMENT REMINDERS

When automated appointment reminders are enabled, TireMaster sends notifications to
customers every afternoon. Automated appointment reminders are enabled by setting a
system control. For more information, see "Send Automated Appointment Reminders" on
page 139.

To enable automated appointment reminders

1. Select Setup > System Controls.

Setup
System Controls b

Printers
WO Status

Users & Permissions

Menu Configuration

2. Click the Other tab.

3. Select Texting - Send Automated Appointment Reminders and press Enter.

System Controls (6400)

Commissionl Eustomerl Enterprisel General Iedgerl Ireventary  Other |\-"endu:|r|

Drescription |Value |SiteND | ~
Statement - Print Addreszs [YES or HO) TES 1

ETE:-:tir'ug - Send dutomated dppointment Reminders —

Testing - Send Thank v'ou Test at Campletion YES 1

il

4. Select Yes, and click OK.

5. Close the System Controls screen.

PREDEFINED MESSAGES

Predefined messages simplify texting, because they require you to do little or no typing when
sending a text. Examples of predefined messages include thank you notes, oil change reminders,
and the appointment notification.

Note: You can have only one appointment notification, because that message type is sent via an
automated process.

ADD PREDEFINED MESSAGES

You can set up predefined messages that can be used in various scenarios. Predefined
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messages are classified as Text or Reminder. Textis for messages that are sent

immediately, and Reminders is for messages that are sent on a specific date. You can set
up a maximum of five reminder messages.

Note: In TireMaster Corporate, messages need to be set up at each site. Also, messages
from one site are not available at the other sites.

To add a predefined message
1. Access the TireMaster - Texting screen.
a. Ifthe Open Work Order List isn’t already open, click Invoicing.

b. Click Text. The TireMaster - Texting screen opens.

2. Click Text Setup. The Text Message Setup screen opens.

»
»
; Text Setup
>
>
>
>
»
3. Click Add.
Iv Show Active Only 50%
Add Edit | i

4. Type the name of the message. (If there is an existing name, type over it.)
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i Text Message Add/Update

-
Tent Mame: IF'ickup‘

Test Body:

VS TV

5. Type the message in the Text Body field. To personalize the message, click the

applicable button under System Words to insert placeholders for name and vehicle
information.

i Text Message Add/Update

Test Name: IPiCkL"IJ @ Message  ( Reminder ‘ Daps: ID—

[Mame] [LMame] vour [vear] [Vidake] [Wodel] iz ready for pickup. Please come in
ak your convenience, Syztem Words

First Marne |
Last Mame |
Yehicle Year |
Vehicle Make |
Wehicle Model |

Test Body:

Example: Hi[Name]. Your [VMake] [VModel] vehicle is ready to be picked up.
Note: Web site URLs can be used in the body of text messages. However, ASA
recommends that you avoid using quotation marks.

6. Identify the text message type.

® Forunscheduled text messages, select Messages.

(* Meszage " Reminder

| Daps: IU

Suztem Words

odel] iz ready for pickup. Please come in

= Forscheduled text messages, select Reminder. Then type the number of days in
which the message will be sent.
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7. Click OK. The name of the new message is added to the list on the left side of the

8. Repeat steps 4 through 7 to create additional messages if needed. Otherwise, close

" Message % Reminder | Daps: Iggi

ear] (Wi ake] [V odel] in for an ol

Syztem Words

[

Example: If you want to send oil change reminders to customers in three

months, you'd type 90 in the Days field.

For the appointment notification (you can have only one), select Message and the
Appointment check box. If you don’t use the Scheduler, disregard adding this text

message type.

i Text Message Add/Update

Tewst Mame: Iﬁppointment Motification

{* Meszage { Reminder

[l [Mame] [LM ame] Don't forget! vou have an appointment for your [Wrear] [y ake]

torarrow. See you then.

‘/IV Active

screen.

Wehicle bake |
Yehicle Model |

Ok Cancel |

the open screens.

UPDATE PREDEFINED MESSAGES

Predefined messages are typically updated when you want to vary the text or correct

mistakes.

To update predefined messages

1.
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a. Ifthe Open Work Order List isn’t already open, click Invoicing.

b. Click Text. The TireMaster - Texting screen opens.

Text

>

Click Text Setup. The Text Message Setup screen opens.

Text Setup |

Select the name of the message you want to update, and click Edit.

i Tt W essage Setup(16495)

Mame |T],fpe|
Appointment Motification 1
Pickup 1

Tire Rotation 1

Add Edit I

Do the following as needed:

=  Change the name (by typing over the existing name).

= Add, change, and delete body text and customer name and vehicle placeholders as
needed. To remove text and placeholders, select them and press Delete on the
keyboard.

= Change the number of days (for sending reminders).
Click OK.
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1

Yehicle Make
Wehicle Model

Ok Cahicel ‘

FY WYY YTYTYYYYY

6. Repeat steps 3 to 5 to update additional messages if needed. Otherwise, close the
open screens.

MAKE PREDEFINED MESSAGES INACTIVE

If you no longer use a predefined message, you can make it inactive. When a message is
inactive, itis no longer listed on the screen for texting customers and vendors.

To make a message inactive
1. Access the TireMaster - Texting screen.
a. Ifthe Open Work Order List isn’'t already open, click Invoicing.

b. Click Text. The TireMaster - Texting screen opens.

Text

2. Click Text Setup. The Text Message Setup screen opens.

Text Setup

3. Select the name of the message you want to make inactive, and click Edit.
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i Tt W essage Setup(16495)

Mame |T],fpe |
Appointment Motification 1
Pickup 1
Thank You

Tire Rotation =
Qil Change

Add Edit I

4. Clearthe Active check box.

¥ &ppaointment [~ Active

5. Click OK.

Wehicle M ake |
ehicle kodel |

Ok Cancel |
S—

6. Toremove the inactive message from list on the Text Message Setup screen, select
the Show Active Only check box.

[+ Show Active Only

7. Close the Text Message Setup screen

MAKE PREDEFINED MESSAGES ACTIVE
You can resume using a predefined message by making it active once again.

To make a predefined message active
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132

Access the TireMaster - Texting screen.
a. Ifthe Open Work Order List isn’t already open, click Invoicing.

b. Click Text. The TireMaster - Texting screen opens.

Text

>

Click Text Setup. The Text Message Setup screen opens.

Text Setup |

Clear the Show Active Only check box.

Select the name of the message you want to make active, and click Edit.

i Tt Message Setup(16495)

Mame |T],fpe|

Appointment Motification 1
Pickup 1
Thank You

Tire Rotation—
Qil Change

Add Edit I

5. Selectthe Active check box.
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v [v Active i

6. Click OK.

.

Wehicle M ake
ehicle kodel

Ok Cancel ‘

FY YWY YTYTYYYYY

7. Close the open screens.

SEND TEXT MESSAGES

TireMaster’s texting functionality is available for individual customer and vendor records, at point of
sale, and in the Appointment Scheduler.

TEXT CUSTOMERS

You can send text messages directly from a client’s customer record or the Open Work
Order List.

To send a text message to a customer

1. Do one of the following:

= Look up the customer to whom you want to send a text message. When the
Customer Maintenance screen (General tab) opens, click Text.
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Prev
Cust: | I‘I_ |15T

Contact Type Number / E-Mail Mame
_~| [208-555-9292 |CAROL CELL

|Ce|l Phone

WWWW

Phone & E-Mail | Text Edit Contact

= |fthe Open Work Order List isn’t already open, click Invoicing. Then select the
customer’s name and click Text.

The TireMaster - Texting screen opens.
2. Do one of the following if needed:

= |f you want to change the entry in the Number field, type the phone number you
want to use instead.

Note: Cell phone numbers that allow texting are automatically entered in the Number
field. If the customer has multiple cell phone numbers, the entry is the cell
phone number that’s closest to the top of the Contact List.

= |fthe Number field is empty, type the customer’s cell phone number.

= |fyou change your mind about sending a text, click Close and disregard the
remaining steps.

3. Select one or more predefined messages, reminders, or both. To type your own
message, select Custom Message instead.

Note: If the customer has multiple vehicles and you're sending a predefined
message, also select a vehicle.
Select the time when the message(s) will be sent.

5. Click Send Text. If you selected the custom message type, compose the message and
click OK.
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TireMaster - Texting (16493)

First Mame Vehicle

|caroL Vehicle | Text Setup |

Last Mame 17-DODGE - DURANGO

ICELL 13-RAM - 2500

01-HOMDA - CIVIC LX

Mumber
|2035559292
Message —Send TetWhen—|  Reminders
Text Mame ’

& Now [~ Alignment

_ [ Oil Change History |

Appointment Motification 15 minutes [~ Tire Rotation
Pickup 30 minutes

Thank You 1 hour Send Text I

Tire Rotation

3 hours

Close |

[+ Custom Message

6. Close the open screens.

TEXT VENDORS

When you need to text a vendor, you can send the message directly from that supplier’s
vendor record.

To send a text message to a vendor

1. Look up the vendor to whom you want to send a text.

2. Onthe Vendor Maintenance screen (General tab), click Text. The TireMaster -
Texting screen opens.

e

Contact Type MNumber ! E-Mail Mame
IElusiness Phonej |208-444~2345 |
[Faxnumper -] [208-444-3456 |
[cePhone -] [208-555-0000 [RayAcct. Mar
IElusiness Phonej | |
IElusiness Phonej | |

Phone & E-Mail |

Text

3. Do one of the following if needed:
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SEND TEXT MESSAGES FOR WORK ORDER STATUS CHANGES

If texting is enabled for a work order status, you can text customers when that status is
selected at point of sale. For example, if texting is enabled for the status Done, TireMaster
prompts you to send a text message when the status of a work order changes from In
Progressto Done. In this scenario, you'd text customers to let them know that their

= |f you want to change the entry in the Number field, type the phone number you

want to use instead.

Note: Cell phone numbers that allow texting are automatically entered in the
Number field. If the vendor has multiple cell phone numbers, the entry is
the cell phone number that’s closest to the top of the Contact List.

= |fthe Number field is empty, type the vendor’s cell phone number.

= |fyou change your mind about sending a text, click Close and disregard the

remaining steps.

Select one or more predefined messages, reminders, or both. To type your own

message, select Custom Message instead.

Select the time when the message(s) will be sent.

Click Send Text. If you selected the custom message type, compose the message and

click OK.
TireMaster - Texting (16493)
First Mame Vehicle
[Ray Vehicle Text Setup
Last Mame
Acct. Mar.
Mumber
2085550000
Message Send Text When Reminders
& Mow [~ Alignment
_ [ 0il Change History
Appointment Notification " 15 minutes ™ Tire Rotation
Pickup i 30 minutes
Thank You ~ 1 hour Send Text
Tire Rotation
" 3 hours Close

vehicles are ready for pickup.

To
1.
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a. Click Invoicing.

b. Selectthe work order whose status you want to change and click Select. The
Invoice Entry screen opens.

Select a status on the lower-left corner of the screen. The TireMaster - Texting screen
opens.

Note: Ifthe TireMaster - Texting screen does not appear, texting is not enabled for
the status you selected.
Do one of the following if needed:

= |f you want to change the entry in the Number field, type the phone number you
want to use instead.

Note: Cell phone numbers that allow texting are automatically entered in the
Number field. If the customer has multiple cell phone numbers, the entry is

the cell phone number that'’s closest to the top of the Contact List.
= |fthe Number field is empty, type the customer’s cell phone number.

= |f you change your mind about sending a text, click Close and disregard the
remaining steps.

Select one or more predefined messages, reminders, or both. To type your own
message, select Custom Message instead.

Note: Ifthe customer has multiple vehicles and you're sending a predefined
message, also select a vehicle.
Define when to send the message.

Click Send Text. If you selected the custom message type, compose the message
and click OK.
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TireMaster - Texting (16493)

First Mame Vehicle

|MARY Vehicle Text Setup

Last Mame 18-DODGE - GRAND CARAVAN

CELL
Mumber

2055557701

Message Send Text When Reminders
Text Name | & Now [~ Alignment

No Text [ 0il Change History

Appointment Notification " 15 minutes [~ Tire Rotation

£ 30 minutes

Thank You

™ 4 hour Send Text

Tire Rotation

" 3 hours
Close
[~ Custom Message

7. Close the open screens.

SEND TEXT MESSAGES FOR COMPLETED INVOICES

You have the option to send customers messages during the invoice completion process.
When text messaging is enabled for completed invoices, you'll be prompted to send a text
message after entering the customer’s payment. You can then send a thank you message,

service reminder, or both.
To send text messages for completed invoices
1. Begin the invoice completion process as usual.

2. On the Invoice Completion screen, enter the payment information and click OK. The
TireMaster - Texting screen opens.

3. Do one of the following if needed:

= |f you want to change the entry in the Number field, type the phone number you
want to use instead.

Note: Cellphone numbers that allow texting are automatically entered in the

Number field. If the customer has multiple cell phone numbers, the entry is
the cell phone number that’s closest to the top of the Contact List.

= |fthe Number field is empty, type the customer’s cell phone number.

= |f you change your mind about sending a text, click Close and disregard the
remaining steps.

4. Select one or more predefined messages, reminders, or both. To type your own
message, select Custom Message instead.
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Note: If the customer has multiple vehicles and you're sending a predefined
message, also select a vehicle.
Select the time when the message(s) will be sent.

Click Send Text. If you selected the custom message type, compose the message
and click OK.

TireMaster - Texting (16493)

First Name Vehicle
|CARCIL Vehicle Text Setup |
Last Mame 17-DODGE - DURANGO
IEIURNS 13-RAM - 2500
01-HOMDA - CIVIC LX
MNumber
|2035559292
e Send Text When— ~Reminders
Text Mame | e [~ Alignment
Mo Text Wi History |
Thank You & 30 minutes
1 hour Send Text I
3 hours Close |
[~ Custom Message —

7. Complete and print the invoice as usual.

SEND AUTOMATED APPOINTMENT REMINDERS

TireMaster can be set up to automatically send appointment reminders to customers at
4:05 p.m. daily. Messages are sent one day before appointments are scheduled.

Example: Reminders for Wednesday appointments are sent on Tuesday afternoons.

Note: To ensure that reminders for Monday appointments are sent, the server needs to
be running on Sunday afternoon.
On the Appointment List, the entries in the Text column indicate the following:
= Text messages are ready to be sent for appointments.
=  Text messages have been sent for appointments.

= Texting for appointments has been turned off.
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Note: Todisable texting for an appointment select the Do not send Text check
box on the Appointment Maintenance screen when you’re scheduling the
appointment.

= Texting for appointments is not available. (The customer doesn’t have a cell phone.)

Before automated appointment reminders can be sent to customers, texting of this
information needs to be enabled. For more information, see "Enable Texting for Work
Order Status Changes" on page 123.

TEXT MESSAGE STATUS

When TMText is installed, the Open Work Order List has an additional column labeled Text. It
displays codes that identify the most recent type of activity that occurred in the texting history for
customers who have open work orders.

Note: If you cannot see the Text column, scroll to the far right of the screen. If you want to move the
Text column, click the column heading and drag it to a different position. Then click Save
Layout.

The following status codes are used for text messages:

= Sentindicates that you sent a text message to the customer
® Rcvdindicates that you received a reply from the customer.
® Readindicates that you've read a reply from the customer.

The text message status updates every two minutes. For more information, see "Text Message
History" below.

Tip:  To manually update the status, select Name and type all or part of a customer’s name in the
Find field. Then clear the entry in the Find field to display to the full list of open work orders.

TEXT MESSAGE HISTORY
Text message history is available on the Text Message Tracking screen.

Note: Message history is available for two weeks. Then it is automatically deleted.

To view text message history
1. Open the TireMaster - Texting screen using one of the following methods:
= Select the customer’s name on the Open Work Order List, and click Text.

= |Look up the customer or vendor. When the Customer Maintenance or Vendor Maintenance
screen opens (General tab), click Text.

= Change the status of a work order. The texting screen opens automatically when texting is
enabled for the status you just selected.
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= Begin the invoice completion process. The texting screen opens automatically when texting is
enabled for completed invoices.

2. Click History. The Text Message Tracking screen opens. Alist of sent and received messages
appears on the left side of the screen.

b b b

Histary I

Send Text |
Close |

Note: Anew entryis created on the list each time a text message is sent from TireMaster.

3. Toseethreads for a message, select the message. The threads are displayed on the right side
of the screen.

i Tt Message Tracking(16496)

Number ILastText ITime J Name: |Smith, Melanie
Hi Melanie. Thank you for your business. We hope 1 12/20 02:44 pm
! ! ° P Thread: |— Rovd —
Hi Melanie. Your DODGE DURANGO vehicle is reaq 12/20 12:29 pm -+ - (19112 05:00 pm
Thank_‘_.«'ou for vacuuming my floor mats!—= 09/12 05:00 pm Thank you for vacuuming my floor mats!

Sent—

W - 0912 04:05 pm
Hi Melanie. Thank you for your business. We hope
to see you again.

Bl A A A A A A A A A e A A A A A A A A PR B b A A A A A A A A A A A P R PR -

4. Do the following as needed:

= Tolist all text messages (instead of those for the selected customer), select the All
Messages check box.

= For a hard copy of the messages listed, click Print Texts.
Note: When the messages for multiple customers and vendors are listed, they’re grouped
by recipient on the Text Log Report.
= Toindicate you've read a message, select it and click Mark Read. The status of the message
will change to Read on the Open Work Order List.

Note: Because the text message status updates every two minutes, you might not see the
status change right away.
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bl e i e e e

W All Messages Print Texts Mark Read

i b b b S

5. Close the open screens.

PREPARE TO EMAIL DOCUMENTS

Before you can email documents from TireMaster, you need to do the following:

= Connect TireMaster with your email provider, which includes defining the host and port for your
outgoing mail server and your account credentials.

Note: For thisinformation, contact your internet service provider or the company that provides
your email service. For free email services, information about outgoing mail server
settings is available on the internet. However, your ability to email documents from
TireMaster via a free email service may be limited. Other factors, such as network
configurations, firewalls, and virus protection programs, can affect whether documents
can be emailed from TireMaster. If you use Gmail™, you might need to change your
Google® account settings to allow TireMaster to access your Gmail account.

= Define the email address for each employee who will be emailing documents from TireMaster.

= Create a predefined subject line and email address for the documents that you’ll send from
TireMaster.

Before you can send emails from TireMaster, you also need to include valid email addresses in the
customer and vendor records for your clients. For more information, see .

To set up email

1. Select Setup > Printers. The Printer Selection screen opens.

Setup
Systemn Controls
Printers
WO Status

Users & Permissions

Menu Configuration
Bt e ol e e e i A e e A A A e A

2. Click E-Mail Options.

e LACE GRS ME-C - g g

EEEE——
aserdet 400 . Selectable [~
| S
g_aserJet 400 .. | selectable [
-

Selectable [~

>
4 ]
4 E-Mail Options Close

3. Click Add.
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M B e

<
4
4
<
<
4
4
4
<
4

Add Delete |

4. Define the outgoing server settings:
= Type the address of the SMTP mail server in the Host field.
= Type the port for the SMTP mail server.

= |fyou're using an email server that is not inside your domain, select the Secure Host check

box.

9

> Host: |smtp.gmai|.com
>

E Port: [587

; v Secure Host

l

5. Enter the login information that you use to access your email account.
= Type the user name for your email account.

= Type the password that you use to log in to your email account.

User. [roundystire@gmail.com 4
Password: [ &

From E-Mail: |

From Name: |

Employee |

Save/Add | [T Statements

\erbiage | Close |

i e i

Example: If your email account is roundystire@gmail.com, and the password to log in is
cooltires1, you would type roundystire@gmail. com inthe User field and
cooltiresl inthe Password field.

Note: The Statements check box visible in the image above is used in the configuration for
statement email. For more information, see "Configure Statement Email" on
page 690.
6. To save the outgoing server and email account settings, click Save/Add.
7. Add each employee who will be sending emails from TireMaster
a. Type the employee’s email address in the From E-Mail field.

b. Type the employee’s name in the From Name field.
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c. Toassign the email addresses to a specific user, click Employee and select a name from the
User List (optional).

Note: When an email address is assigned to a specific user, TireMaster will know which
account to send the message from when that employee is logged in to the program.

d. Click Save. The employee’s name and email address are added to the list on the left side of
the screen.

.

From E-Mail: |fgrant@r0undystire.com

From Name: |Fred Grant

qIFe

[~ Statements

Verbiage | Close |

YWY YYYYYYYYYY

8. Define the subject line and body text for each of the documents emailed from TireMaster.

a. Click Verbiage. The Email Verbiage Setup screen appears.

ifred Grant

Gl

Save | [~ Statements

| Verbiage I Close |

b. Selectadocument name.

IV Y

W E-Mail Verbiage Setup (16490)

Documents
Document Description

Invoice
Waork Order

‘Quote/Estimate ——

(YW W W N W YW TS

Received on Account

c. Ifyou wantto use a different subject line when the document is emailed, type your changes in
the Subject field.

d. Ifyou wantto modify the email body text that’s listed, type your changes in the Body field.

e. Click Save.
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Subject
|Qu0te:’Estimate Request

Body
Attached is a copy ofthe
quotelestimate you requested. We're
looking forward to seeing you soon!

f. To define the subject line and body text for additional documents, repeat steps 8b through
8e.

9. Close the open screens.

e e

EMAIL DOCUMENTS

Various documents can be emailed to customers or vendors as soon as they’re created, or you can
retrieve duplicates to send. The ability to email a group of historical sale invoices is also available.
Work orders, invoices, quotes/estimates, ROAs, purchase orders, receiving documents, and vendor
invoice documents can be distributed by email. Documents that are emailed to customers are
converted into the portable document format (PDF).

Note: When you prepare customer account statements, you have the option to deliver them by
email. For more information, see "Statements" on page 680.

EMAIL DOCUMENTS UPON COMPLETION

A variety of documents can be sent to customers or vendors by email when you complete the related
transactions.

To email documents when transactions are completed

1. Begin to print the document as usual. This process varies, depending on the document. The
report screen appears.

Note: For work orders, invoices, deposits, and ROAs make sure the entry in the # Copies field
(upper-right corner) is set to 0.

2. Click E-mail. Depending on the document, the button is either along the top or the bottom of the
screen. The Select Email screen appears.
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W Report (16550)

1 ql 10f1 - ul - | = |75% -| Findl Next| Expon| E-Mail | Setup

< P!eviousl MNext > | FPrint I Zoom I I E-Mail I j

Note: The E-Mail button is active only when an email address has been set up for the customer
or vendor to whom you want to send the document.

3. Atthetop of the screen, select the email address that the document will be sent from.

[

From 4
Email | Mame L
info@roundystire.com Roundys Tire 4
fgrant@roundystire.com .__;-""'___ | Fred Grant

djames@roundystire.com Donna James
krisj

@roundystire.com Kris Johnson

4. Selectone or more email addresses to send the document to. For multiple addresses, press Ctrl
while making your selections.

5. Ifyou need to send the document to additional email addresses, type them at the bottom of the
screen, separating them with commas.

daringdaisies@fakemail.com

Email: |daringsuepoﬁs@fakemail.com,daringrosebloom@fakemail.c0m|

6. Fordocuments thatinclude the option to edit subject and body text, make changes as needed.

Subject |Your Invoice from ASAAutomotive

Body

Hi Sue,

Here is a copy of your invoice. Thank you for your
business.

Fred Grant
Sales Manager|

Note: Subjectand body text editing is available for work orders, invoices, deposits, and ROAs.

7. Click OK, and wait until the system busy indicator disappears.
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FY Y YT YT YY

I oK I Cancel |

8. Printa hard copy of the document, if needed.

9. Close the report screen.

EMAIL MULTIPLE HISTORICAL INVOICES

When a customer needs copies of previously completed sale invoices, you can retrieve and send a
group of these documents from the customer’s subledger. Documents that can be emailed as a
group from a customer’s subledger include normal sale invoices (document type code is blank),
national-account invoices (document type code NA), and government-support invoices (document
type code GS).

Note: Ifavendorrecord includes sale invoices, those documents can be emailed as a group as
well. In this scenario, you need to access the vendor’s AR subledger to retrieve and email the
documents.

To email multiple historical documents
1. Look up the customer. For more information, see "Customer Searches" on page 89.

2. Onthe Customer Maintenance screen, click the Ledger/History tab.

Customer Maintenance (12200}

3. Select History (lower left of screen). TireMaster lists the customer or vendor’s historical
documents.

4. Click E-Mails. Various buttons on the screen become inactive.

"W"’W"""

View: ¢ AR Ledger

f+ History
E-Mails

5. Pressthe Ctrl key and select each invoice you want to include in the email.

b A
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Customer Maintenance (12200)

General | \u’ehiclel ShipTo LedgerHistory |Aging| Informationl

L)
>
A
4
[caGnEY COURIER f1 [242 &
L)
4
A

6. Click E-Mails again. The Select E-Mail screen appears.

7. Atthe top of the screen, select the email address that the documents will be sent from.

L]
From 4
Email |Name 4
infe@roundystire.com Roundys Tire 4

fgrant@roundystire com = |Fred Grant
djames@roundystire.com Donna James

Kris_1g

8. Select one or more email addresses to send the documents to. For multiple addresses, press
Ctrl while making your selections.

9. Ifyou need to send the documents to additional email addresses, type them at the bottom of the
screen, separating them with commas.

|Emai| |Name |
bkerns@cagney.com Bradly Kerns

klarsong@cagney.com Karla Larson

Email: |t|acey@cagney.com,bwillis@cagney.com|

10. Update the subject and body text as needed.

Subject |Invoice Request

Body

Hello,
Aftached are copies ofthe invoices you requested.

Fred Grant
Roundys Tire|

11. Click OK, and wait until the system busy indicator disappears.
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FY Y YT YT YY

I oK I Cancel

12. Close the open screens.

GENERATE A LIST OF SENT EMAILS

The sent box for your email account doesn’t include entries for invoices emailed from TireMaster.
Therefore, you need to generate a report to verify which customers and vendors received emailed
documents. For more information, see "Sent Email/Text List" on page 1021.
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CHAPTER 8

CONTACT INFORMATION

In TireMaster, you can assign multiple phone numbers and email addresses to customer and vendor
records and classify contact information with a setting called contact types. This chapter includes the
following sections:

Contact TYPOS .. 152
Phone Numbers and Email Addresses ... ... . 155
Organize Contact Information ... . .. 161
Primary Contact Method .. . 165
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CONTACT TYPES

Phone numbers and email addresses are classified with settings called contact types. In other words,
a contact type is a means of describing a contact method. Examples of contact types include cell
phone and email. Contact types are used for both customers and vendors.

ADD CONTACT TYPES

TireMaster includes five default contact types: business phone, cell phone, email, fax number, and
home phone. You can use these contact types as is, modify them, or remove them. If you need
contact types that aren’t available, you can add your own.

Note: When you set up contact types, you can define whether they’re shown in the same spot on
the maintenance screens for all customers and vendors, or you can vary the order in which
they’re displayed for individual customers and vendors. For more information, see "Organize
Contact Information" on page 161.

To add a contact type
1. Select Customers > Contact Types. The Contact Type screen opens.

Customers
Maintenance
Easy Checks
Types
Contact Types b
List Ediiinﬁ

A A A S A AL S S S

Note: Although the setup screens for contact types are accessed from the Customers menu,
contact types are used for both customers and vendors.

2. Click Add. The Add/Edit Contact Type screen opens.

Ll b b b b A 8 s e s ot

Lossssssssss

Add Edit |

3. Foranew contact type, enter a name. For an existing type, change the name if needed.
To define the type of contact method you're adding, select Fax, E-mail, Cell, or Phone (for land
lines).

5. Define the position in which the contact type is shown on the Customer Maintenance screen.

= Tolist contact types in the same order for all customers, type the position 1,2, 3,4,0r 5 in
the Cust Order field. For more information, see "Organize Contact Information Globally " on
page 162.
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= To vary the order of contact types from customer to customer, type 0 in the Cust Order field.
For more information, see "Organize an Individual’s Contact Information" on page 163.

6. Define the position in which the contact type is shown on the "Vendor Maintenance Screen" on
page 174.

= Tolist contact types in the same order for all vendors, type the position 1, 2, 3, 4, or 5 in the
Vend Order field. For more information, see "Organize Contact Information Globally " on
page 162.

Note: If you have more than five contact types, leave the rest set to 0.
= To vary the order of contact types from vendor to vendor, type 0 in the Cust Order field. For
more information, see "Organize an Individual’'s Contact Information" on page 163.

7. To save the new contact type, click OK.

Add/Edit Contact Type (16482)

Contact Type: |Ce|| Phone (Business)

" Eax " E-Mail " Cell (s Phone

Cust Order:|0 Vend Crder. |0 Cancel

8. Close the Contact Type screen.

MANAGE EXISTING CONTACT TYPES

You can manage existing contact types by updating them and removing those that are no longer
needed.

UPDATE A CONTACT TYPE

TireMaster includes five default contact types: business phone, cell phone, email, fax
number, and home phone. You can use these contact types as is, modify them, or remove
them. If you need contact types that aren’t available, you can add your own.

Note: When you set up contact types, you can define whether they’re shown in the same
spot on the maintenance screens for all customers and vendors, or you can vary
the order in which they’re displayed for individual customers and vendors. For
more information, see "Organize Contact Information" on page 161.

To update a contact type

1. Select Customers > Contact Types. The Contact Type screen opens.
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Customers

Maintenance
Easy Checks
Types
Contact Types I}

SN Einn AN

Note: Although the setup screens for contact types are accessed from the

Customers menu, contact types are used for both customers and vendors.

Select the contact type you want to update and click Edit. The Add/Edit Contact Type
screen opens.

Contact Type (16480)

Contact Type

FUNN Y

Business Phone

Cell Phone (Business) :

E-Mail 4
EAADADALLDSS DS S

|'v“vvvvvvvvvv .

4
;

Do the following as needed:

= Change the name of the contact type.

= Select a different contact method type.

Change the position in which the contact type is shown on the Customer Maintenance

screen if needed.

= To list contact types in the same order for all customers, type the position 1, 2, 3,
4, or 5 in the Cust Order field. For more information, see "Organize Contact
Information Globally " on page 162.

= To vary the order of contact types from customer to customer, type 0 in the Cust
Order field. For more information, see "Organize an Individual's Contact
Information" on page 163.

Change the position in which the contact type is shown on the Vendor Maintenance

screen if needed.

= To list contact types in the same order for all vendors, type the position 1, 2, 3, 4,
or 5 in the Vend Order field. For more information, see "Organize Contact
Information Globally " on page 162.

Note: If you have more than five contact types, leave the rest set to 0.
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= To vary the order of contact types from vendor to vendor, type 0 in the Cust Order
field. For more information, see "Organize an Individual’'s Contact Information" on
page 163.

6. To save your changes, click OK.

Add/Edit Contact Type (16482)

Contact Type: |Ce|| Phone (Personal)

i~ Fax i E-Mail v Cell i~ Phone

Cust Qrder:|0 Vend Order: |0 Cancel

7. Close the Contact Type screen.

DELETE A CONTACT TYPE
If there is a contact type you don’t use, you can remove it from TireMaster.

Note: Removing a contact type makes it unavailable for both customers and vendors.

To remove a contact type
1. Select Customers > Contact Types. The Contact Type screen opens.
Note: Although the screens for working with contact types are accessed from the
Customers menu, contact types are used for both customers and vendors.
2. Select the type you no longer want to use and click Remove. A confirmation message
appears.
Click Yes.

Close the Contact Type screen.

PHONE NUMBERS AND EMAIL ADDRESSES

Phone numbers and email addresses can be classified by assigning contact types.

ADD PHONE NUMBERS AND EMAIL ADDRESSES
You can add multiple phone numbers and email addresses to customer and vendor records.

Note: When you add a phone number or email address, you can associate a name with it. For
example, the customer record for Rex and Mary Jones could have one phone number
associated with the name Rex and another associated with the name Mary. In this scenario,
you could also include phone numbers for the couple’s teenage children. At point of sale,
both the phone number (or email address) and the associated name are displayed on the
Invoice Entry screen.
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To
1.

2.
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add phone numbers and email addresses

If you haven't already done so, add a new customer or vendor or look up an existing customer or
vendor. For more information, see "Add a Cash Customer" on page 66, "Add an AR Customer"
on page 68, "Customer Searches" on page 89, "Add a Vendor" on page 168, or "Vendor
Searches" on page 179.

To add up to five contact methods, complete the following steps. If you want to enable texting for
cell phone numbers, add those phone numbers using the method described in step 3.

a. Ifthe phone number and email fields are not active, click Edit Contact on the Customer
Maintenance screen or click Edit on the Vendor Maintenance screen.

b. If you need to change the contact type, select it from the drop-down.

rmationl
Cust# | [1 [232

Contact Type Mumber / E-Mail Mame
|Business F'honsj |

Business Phone
CeII Phone (Busine

Cell Phone (Person|

|

|

| |

E-Mail |
|

Fax Mumber |
Home Phone |

Phone & E-Mail | Tex‘t|

RAAALAAASLS AALALSLLSSASSSSSSSSSSSSSSSSS

Note: If your TireMaster system is set up to display contact information in the same order
for all customers and vendors, the phone numbers and email addresses will be
arranged in that order once you click OK, regardless of how you enter them here. For
more information, see "Organize Contact Information" on page 161.

VTV VTV TIT VI TWIIwywywwery

Tip: Ifthe drop-down doesn’tinclude the contact type you want to assign, you can add
your own. For more information, see "Add Contact Types" on page 152

c. Type the phone number or email address.

Note: When you initially add contact information, the phone number or email address at the
top of the list is designated as the primary contact method, and the second one is
designated as the alternate contact method. For customers, the primary contact
method is assigned to work orders by default. If you want to use a different phone
number or email address as the primary contact method, you can change it. For more
information, see "Update the Primary Contact Methods" on page 165.

Tip:  Hyphens are automatically inserted in phone numbers. If a phone number
includes an extension, type it as well. For example, 208-333-6000 ext.
102.
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d. Type a description or the name of the person or business to whom the phone number or

e

mail address belongs.

; | F'revl Nextl
rmation

Cust | [i [e38
Contact Type Mumber [ E-Mail Mame
Cell Phane (F'er:j 208-555-7990 Melanie's Cell
Bhosemlals onana PP PR AAAS

3. Foreach additional phone number and email address you need, complete the following steps.

a. Click Phone & E-mail. The Contact List appears.

rmation |

Cust | [1 [z38
Contact Type Mumber [ E-Mail Mame
Cell Phone (Per. | [208-555-7990 [metanie's cel
Cell Phone [F'er:j 208-555-7991 Dean's Cell
Business Ph-:nnej 208-555-0000 Melanie Work
Cell Phone [Eusj 208-555-1111 Dean's Work
Home Phone  ~| |208-655-8001

ﬁl Edit Contactl

b. Click Add. The Add/Edit Phone Number screen appears.

| Add l Edt | Delete |

c. Do the following as needed:

Select a different method of defining the contact type from the drop-down.
Type the phone number or email address in the Number/E-Mail field.

Type a description or the name of the person or business to whom the phone number or
email address belongs.

For cell phone numbers that are allowed to receive text messages, select the Send Text
check box. This check box is available only when a contact type for cell phones is selected.

For the email address you want to set as the customer’s default, select the Default
E-mail check box. This check box is available only when a contact type for emails is
selected.
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Note: Ifyou use third party marketing applications, the default email address is the one to
which promotional messages for customers will be sent.

d. To save the new number or email address, click OK.

N Add/Edit Contac.. — O b4

Type |E-Mail -

Mumber/E-Mail Imsmith@fakemail.com

Mame IMeIanie personal email

[~ Send Text
gance |

e. Change the position for the phone number or email address if needed. To change the
position, select the number or email address and click Move Up or Move Down as needed.

Contact List (16424)

Phone Mumbers
Contact Type |Number |Default |Name | Move Up I
Cell Phone (Personal) 208-555-7990 Primary |Melanie's Cell
Cell Phone (Personal) 208-555-7991 Alternate Dean's Cell Move Down I
Business Phone 208-555-0000 Other Melanie's Work
Cell Phone (Business) 208-555-1111 Other Dean's Work
Home Phone 208-555-8001 Ot
ther Melanie Personal email

4. Make any other needed changes to the customer or vendor record. Otherwise, close the
Customer Maintenance or Vendor Maintenance screen.

MANAGE EXISTING CONTACT INFORMATION

When the contact information for customers or vendors changes or is no longer relevant, you can
ensure that those details are up-to-date in TireMaster.

UPDATE PHONE NUMBERS AND EMAIL ADDRESSES

When a customer’s or vendor’s phone number or email address changes, you can update
the contact information in TireMaster.

Note: Depending on how your customer types are set up, contact information is ordered
the same for all customers and vendors or its organized on an individual basis. For
more information, see "Organize Contact Information" on page 161.
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Updating a phone number or email address

1. If you haven't already done so, look up the customer or vendor whose phone number
needs to be updated. For more information, see "Customer Searches" on page 89 or
"Vendor Searches" on page 179.

2. Toupdate one of the five numbers or email addresses listed on the General tab of the
Customer Maintenance or Vendor Maintenance screen, complete the following steps.
To update the customer or vendor’s additional numbers and email addresses, go to
step 3 instead. To enable texting for cell phone numbers, use the update method
described in step 3 as well.

a. Forcustomers, click Edit Contact. For vendors, click Edit instead.
Note: Depending on your security settings, you can also click the Edit button on
the Customer Maintenance screen.
b. Do the following, as needed.
= Select a different contact type from the drop-down.

Note: If your TireMaster system is set up to display contact information in the
same order for all customers and vendors, the phone numbers and email
addresses will be arranged in that order once you click OK, regardless of
how you enter them here. For more information, see "Organize Contact
Information" on page 161.

= Type adifferent phone number or email address.

= Type adifferent name or description for the phone number or email address.

| | [t |

Cust: | [1 [3712
Contact Type MNumber ! E-Mail Mame
|Cell Phone (Per. ~| [208-555-7991 [Dean's Cell
|Cell Phone (Bus ~| |208-655-1111 [Dean's Waork

|Home Phone | [208-555-8001 |

| ell Phone (Per - | [208-555-7790 _  |Melanies Cell
|E-Mai| j |msmith@new+email.c |I'u1elanie Personal

e e b b b b

3. Toupdate a phone number or email addresses that is not listed on the General tab,
complete the following steps.

a. Click Phone & E-mail. The Contact List opens.
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Cust: | [t [p3712

Contact Type MNumber ! E-Mail Mame
|cell Phone (Per. | [208-555-7991 |Dean's cell
ICeII Phone (Bus | |2ua-555—1111 IDean's Work
|Home Phone | [208-555-8001 |
|cell Phone (Per: »| [208-555-7790 [Melanie's Cell
IE—MaiI j |msmith@newemail.c |I‘u'|e|anie Personal

Phone & E-Mail I Te}dl Ed[tCnntactl

Select the phone number or email address you want to update, and click Edit. The
Add/Edit Phone Number screen opens.

Contact List (16484)

Phone Numbers :
Contact Type |Number |Defau|t |Name L
Cell Phone (Personal)  208-555-7991 Primary Dean's Cell :
Cell Phone (Business) 208-555-1111 Alternate Dean's Waork 4
Home Phone 208-555-8001 Other 1

Add Edit | ge|ete|

Select a different contact type from the drop-down, type a different number or email
address, or type a different name as needed.

If you need to enable or disable texting for cell phone numbers, select or clear the
Send Text check box. This check box is available only when the cell phone contact
type is selected.

If you need to change the default status for an email address, select or clear the
Default E-Mail address. This check box is available only when the email contact
type is selected.

Click OK to save your changes.
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[N Add/Edit Contac... — O X

Type |Ce|l Phone [F‘ersonal}j

Number/E-Mail |208-555-4444

Mame |Me|anie's Cell

OK Cancel |

4. Close the Contact List.

DELETE PHONE NUMBERS AND EMAIL ADDRESSES

When a customer or vendor no longer uses a phone number or an email address, you can
delete it.

To delete a phone number or email address

1. Ifyou haven't already done so, look up the customer or vendor whose phone number
or email address needs to be deleted. For more information, see "Customer
Searches" on page 89 or "Vendor Searches" on page 179.

2. Onthe Customer Maintenance or Vendor Maintenance screen, make sure the
General tab is selected. Then click Phone & E-mail. The Contact List opens.

3. Select the phone number or email address you need to remove and click Delete. A
confirmation message appears.

Click Yes. The phone number or email address is removed from the list.

If the deleted phone number or email address was the main or secondary contact
method, define a new primary or alternate contact number. For more information, see
"Organize Contact Information" below.

6. Close the Contact List.

ORGANIZE CONTACT INFORMATION

Contact information can be organized on the Customer Maintenance and Vendor Maintenance
screens in one of the following ways:

= The order can differ for each customer and vendor. For example, for some vendors you might
list the business number first and for others the cell phone would be first.

= Aglobal order for displaying phone numbers and email addresses can be used for all
customers, and another global order can be used for all vendors. For example, for customers,
you could always list the cell phone first, followed by home phone, email address, business
phone, and fax number.
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Note: When global ordering is used, each contact type is displayed on the Customer
Maintenance or Vendor Maintenance screen once. For example, if two or more cell
phone numbers are associated with a single customer record (such as one for a married
couple who has teenage children) one of the cell numbers is on the Customer
Maintenance screen and the rest are on the customer’s Contact List.

The way in which you define the order depends on which method you use:

=  To use the same order for everyone, define a position (1 through 5) in the settings for up to five
contact types. For instructions, see "Organize Contact Information Globally " below.

= To setthe order on an individual basis, make sure the position is O for all contact types. Then
arrange the contact information on the customer’s or vendor’s Contact List. For instructions,
see "Organize an Individual's Contact Information" on the facing page.

ORGANIZE CONTACT INFORMATION GLOBALLY

With global ordering, contact information for all of your customers is listed in the same order on the
Customer Maintenance screen and contact information for all of your vendors is listed in the same
order on the Vendor Maintenance screen. Global ordering is defined in the settings for contact types.
Therefore, when the customer order or vendor order for a type is assigned to position 1, 2, 3, 4, or 5,
it's put in the corresponding spot on the applicable maintenance screen. If a contact type is not
assigned a position, it's set to 0 and is displayed on the maintenance screens wherever a spot is
available.

Note: When the position is set to 0 for all contact types, the order of phone numbers and email
addresses can differ for each customer or vendor. For more information, see "Organize an
Individual’s Contact Information" on the facing page.

To globally organize contact information

1. Select Customers > Contact Types. The Contact Type screen appears.

Customers
Maintenance
Easy Checks
Types
Contact Types b

A A A S A AL S S S

2. For each contact type, do the following:

a. Selectthe type and click Edit. The Add/Edit Contact Type screen appears.
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Add

b. For customers, type the number that corresponds with the position you want to assign in the
Cust Order field. For example, type 1 to list the contact type first on the Customer

Maintenance screen.

c. Forvendors, type the number that corresponds with the position you want to assign in the
Vend Order field. The position can be the same as the one used for customers or it can be
different.

d. Click OK.

Add/Edit Contact Type (16482)

Contact Type: |Ce|| Phone (Personal)

" Eax " E-Mail s Cell " Phone

Cust Order:|1 Vend Crder. |3 Cancel

3. When you're done assigning positions, close the open screens.

ORGANIZE AN INDIVIDUAL’S CONTACT INFORMATION

Contact information can be organized on a customer-by-customer or vendor-by-vendor basis,
instead of using the same order for everyone. With this method, you define how phone numbers and
email addresses for individual customers or vendors are ordered on the maintenance screens by
changing their placement on the Contact List. Therefore, if you move up a phone number down on a
customer’s Contact List, it also moves to the corresponding spot on the customer’s maintenance
screen.

When you organize phone numbers and email addresses on an individual basis, the following
occurs:

= The contact method designated as primary moves to the top of the list. For customers, the
primary contact method is used by default on work orders.

= The alternate contact method is shown beneath the primary contact method. Therefore, it's
the second phone number or email address listed.

= The remaining numbers and email addresses, if any, are below the primary and alternate
contact information.

When customers and vendors have more than five phone numbers and email addresses, the
additional contact information is available only on the Contact List.

To organize contact information differently for each customer and vendor, the position needs to be
set to 0 in the settings for all contact types. To verify that the position is 0 for all contact types go to
Customers > Contact Types and review the entries in the Position column.
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To organize an individual’s contact information
1.

164

Look up the customer or vendor whose contact information you want to organize. For more
information, see "Customer Searches" on page 89 or "Vendor Searches" on page 179.

On the Customer Maintenance or Vendor Maintenance screen, make sure the General tab is

selected. Then click Phone & E-Mail. The Contact List opens.

mation |

Prev | Mext |

Cust# | [1 [238
Contact Type Mumber / E-Mail Mame
Home Phone  ~| |208-555-8001
Cell Phone [F'er:j 208-555-4444 Melanie's Cell

Cell Phone (Per: ~ |

208-555-7991

Dean's Cell

E-Mail

=

msmith@newemail.c

Melanie personal

Business Ph-jnej

Phane & E-Mail Text |

Define the primary contact method. If you don’t need to change the primary contact method,

208-555-0000

disregard this step.

a.

contact method.

Melanie Work

Edit Contact |

Select the row for the phone number or email address you want to designate as the primary

Click Move Up repeatedly, until the phone number or email address is at the top of the list

and the word Primary is shown next to it.

Contact List (16424)

Phone Mumbers

Contact Type

|Number

|Default |Name | Move Up I

Define the alternate contact method. If you don’t need to change the alternate contact method,

Hame Phane

disregard this step.

a.

contact method.

208-555-8001
Cell Phone (Personal) 208-555-4444

Primary
Alternate Melanie’s Cell

Move Down |

Select the row for the phone number or email address you want to designate as the alternate

Click Move Up repeatedly, until the phone number or email address is on the second row of

the list and the word Alternate is shown next to it.




Primary Contact Method

Contact List (16484)

Phone Mumbers

Contact Type |Number |Default |Name | Move Up I
Cell Phone (Personal) 208-555-7991 Primary Dean's Cell

Home Phane 208-555-8001 Alternate Move Down |
Cell Phone (Personal) 208-555-4444 Other Melanie's Cell

E-Mail msmith@newemail.com  Other IMelanie Personal

Business Phone 208-555-0000 Other Melanie's Woark

Cell Phone (Business)|208-555-1111— EOal Deans work

5. Define the position for the customer’s remaining phone numbers and email addresses.
a. Select the row for the contact method you want to move.

b. Click Move Up or Move Down repeatedly, until the phone number or email address is
where you need it to be.

Contact List (16484)

Phone Mumbers
Contact Type |Number |Defau|t |Name | Move Up |
Cell Phone (Personal) 208-555-7981 Primary |Dean’s Cell

Cell Phone (Business) 208-555-1111 Alternate Dean’s Work Move Down I

Cell Phone (Personal) 208-555-4444 Other Melanie’'s Cell

6. Close the Contact List.

PRIMARY CONTACT METHOD

When you initially add contact information, the phone number or email address at the top of the list is
designated as the primary contact method, and the second one is designated as the alternate
contact method. For customers, the primary contact method is assigned to work orders by default. If
you want to use a different phone number or email address as the primary contact method, you can
change it.

UPDATE THE PRIMARY CONTACT METHODS

If contact information is ordered in the same manner for all customers and vendors, you don’t have to
use the phone number or email address in the first position (on the maintenance screens) as the
primary contact method. In this scenario, you can choose the primary contact method from the
Contact List.

Note: For customers, the primary contact method is assigned to work orders by default.

To update the primary contact method

1. Search for the customer or vendor to whom you want to assign a primary contact method. For
more information, see "Customer Searches" on page 89 or "Vendor Searches" on page 179.

165



User Guide

2. Onthe Customer Maintenance or Vendor Maintenance screen, click Phone & E-Mail. The
Contact List appears.

; Prev | Mext |
matmnl
Cusﬁr:l |1 |244

Contact Type Mumber / E-Mail Mame
Business F'h-:nnej |208—555—1477 Main Phone
E-Mail j |bunnsbaker}'@fakerr Business email
Cell Phone [Eusj 208-555-0011 Bart (Owner)
Cell Phone [Eusj 208-555-0022 Betty (Manager)
[cenl Phone (Bus 7| [208-555-0033 [Bert (Baken

Phone & E-Mail Text | Edit Contact |

3. Selectthe phone number or email address that you want to use as the primary contact method,
and repeatedly click Move Up until it is at the top of the list.

Contact List (16484)

Phone Numbers

Contact Type |Number |Defau|t |Name | I Move Up I
Business Phone 208-555-1477 Primary Main Phone
E-Mail bunnsbakery@fakemail.c Alternate Business e lMove Down |
Cell Phone (Business) 208-555-0011 Other Bart (Owne

(Manz

4. Ifyou also need to update the alternate contact method, select the phone number or email
address you want to use and repeatedly click Move Up or Move Down until it is second on the
list. Otherwise, disregard this step.

5. Close the open screens.
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CHAPTER 9

VENDORS

TireMaster’s vendor management tools help to you track purchases from your suppliers, and you
can track the balances you carry with your vendors. This chapter includes the following sections:

Add and Manage Vendors .. ... il 168
Vendor Maintenance SCreen ... .. .. 174
Vendor SearChes ... 179
NV eNdor TYPOS 180
Vendor Payment Terms .. L 183
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ADD AND MANAGE VENDORS

With vendor records, you can track the purchases of tires and service parts from your suppliers.

ADD A VENDOR

Before you can order items from a vendor, a vendor record must exist in TireMaster

Note: Users can add and update vendor records at both the corporate site and the stores.

To add a vendor
1. Select Vendors > Maintenance. TireMaster prompts you for the vendor's name.

Vendors
Maintenance
Charges
Easy Checks
AP Payments

Matienal Accounts

2. Click Cancel to close the Name Lookup/Entry screen.

Enterﬂame:l

v Active Only
[+ Search All Site | OK I Cancel I

3. When the Vendor Maintenance screen opens, click Add. TireMaster prompts you for the
vendor’s name.

Edit | gelete| '_I'errnsl

4. Type the vendor’'s name and click OK. The new vendor record is created.

168



5. Enter the vendor’s contact information.

6.

7.

Add and Manage Vendors

Mame Lookup/Entry (2300)

Enter Name: |SHRILL ALARM SYSTEMS]|

[v Active Only

[w Search All Site Cancel |

a. Type the vendor’s street or mailing address.

b. Type the vendor’s zip code. If the zip code has already been used in TireMaster, the Zip

Codes screen appears.

c. Click OK. The city and state are added to the vendor’s contact information.

Add the phone numbers that you want to have on record for the vendor. For more
information, see "Add Phone Numbers and Email Addresses" on page 155.

Vendor Maintenance (12200]

General | Ledgerﬂ—nstor}fl Aging |

[t lfeze |

Address2: |PD BOX 29001

Contact Type Number / E-Mail Mame
Name: |SHRILLALARM SYSTEMS |Business Phone ~ | |208-555-1002 [ Main number
Address: |300 W. SECURITY AVE. |cellPhone  ~| |208-555-2121 [Beth - Acct Mor
| E-tail x| |bethb@shrillariarm.c [Beth - Acct Mgr

City: |[BOISE

State: [ID  Zip: [83701

v Active

IElusiness F'honej I I
IElusiness F'honej I I

Phone & E-Mail | Tex‘tl

If you need to assign a different type to the vendor, click the Acct Type field, press [], and select
a type from the list. Otherwise, leave the vendor type setto V.

Acct Type I'u" T MFG Code: I

Exp Acct | |

[~ 1099 Yendor
™ -9 on file A

If the vendor has given you a credit limit, type it in the Credit Limit field.
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10.
1.

12

» Credit Limit: 2500.UD|F

Bank Mame

Routing # Bank Acct #

Ab bbb bbb bbb i bbb b b bbb dob A bbb bb

ravTvyw

|

F wvywywy

To assign a default expense account to the vendor, click the Exp Acct field. Then press[~]and

select an account from the list that appears.

Note: This setting is used to automatically add offsetting journal entry lines for the selected
account to vendor charges created for this vendor.

Enter the vendor’s tax reporting information if needed.

a. Type the vendor’s Tax ldentification number or Social Security number in the TIN# field. The

1099 Vendor and W-9 on file check boxes become active.

b. If you need to complete a 1099-Misc form for the vendor, select the 1099 Vendor check box.

c. Ifyou have IRS form W-9 in your possession for the vendor, select the W-9 on file check
box.

Type the account number the vendor has assigned to you in the Account# field if needed.

Add the name of the vendor’s bank, the bank’s routing number, and the account number if
needed.

If you have any notes about the vendor that you want to save, type them in the Notes field.

N T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T YT T YT T YT YT YT T YT YT TS

Exp Acct |6600 0 Bank Mame
o] | TING | [WELLS FARGO
||: Account#|82101 Routing # Bank Acct #
|124103?99 989-2201-7921
Motes:

13. To save the new vendor’s record, click OK.

MANAGE EXISTING VENDOR INFORMATION

Occasionally, you might need to make changes to vendor records because their account information

has changed or you're no longer business partners.
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UPDATE A VENDOR RECORD
You can change details for a vendor record, such as the address or a phone number.

Note: Ifyou need to update the information for several vendors, you can use list editing
for customers and vendors. For more information, see "Update Multiple Customer
Records " on page 72.

To change a vendor record

1. Search for the vendor whose information you want to update. For more information,
see "Vendor Searches" on page 179.

2. When the Vendor Maintenance screen opens, make sure the General tab is selected.
Then click Edit.

YTV T T T T T T T T T YT T YT T T YT T YT YT YT

Find | Add Edit Delete | Terms

b b b

3. Make the needed changes. For information about settings on this screen, see "Vendor
Maintenance Screen" on page 174.

4. To save your changes, click OK.

UPDATE MULTIPLE VENDOR RECORDS

When you need to update settings for more than one vendor, you can update the
information for a range of vendor records.

Note: Vendorinformation can be updated at either the corporate site or the stores.

To update multiple vendor records
1. SelectVendors > List Editing. The Vendor Range screen opens.
Wendors
Maintenance
Charges

Easy Checks
AP Payments

Mational Accounts

Types
List Editing %
Reports...

2. Tosearch for a range of records to edit, use one or more of the following:
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= Staring and ending name

= Area code (starting and ending), city, state, or zip code

= Blank zip codes

= Site (for the corporate site of TireMaster Corporate systems only)
= Account type

= Active, inactive, or both

Tip:  Toreturnto the screen’s original settings, click Reset.

3. Click OK. The Vendor List Editing screen opens.

Vendor Range Lookup (16269)

MName: |ﬁ.l‘u1C TIRE WAREHOUSE J to |DI~(AUTD PARTS J

cnx:|
State:
Zip: | [~ Blank Zip Codes
. . Active/lnactive CashiCredit
" Both {+
Acct Type: |V
Finance Charge Statement
 EfE :
e c
{* {*

Reset QK Close

Note: Forahard copy of the information listed on the screen, click Print to generate
the List Editing Report.

4. Selecta column and update the records as needed. You can type your changes or
make a selection from a list. To select a setting from a list, click or press [=].

Vendor List Editing (16270)

CUCD SITENO NANME A} 5 |CREDIT  |AcctType |ACTIVE |
179 1|AMC TIRE WAREHOUSE P 5000V v
174 1[AMERICAN TIRE DISTRIBUTORS 1 suuu_uulfv’ v
sansfllonsns s IBNIQZONE, o0 sassssssnsas

Tip:  You canrearrange the columns on this screen. For more information, see
"Rearrange Table Columns" on page 10.
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5. When you're finished updating the records, click Close.

W

Close |

MAKE A VENDOR RECORD INACTIVE

If you have vendors with whom you no longer do business, you can remove them from the
list of active vendors. Doing so makes your vendor list easier to manage and use.

To make a vendor record inactive

1. Search for the vendor you want to make inactive. For more information, see "Vendor
Searches" on page 179.

2. When the Vendor Maintenance screen opens, make sure the General tab is selected.
Then click Edit.

Edit I geletel Iermsl

3. Clearthe Active check box.

E

General | Ledgerﬂ-ﬁstoryl Aging |

Name: [AMC TIRE WAREHOUSE
Address: |F'.U. BOX G957

Address2: I
City: [DALLAS
State: [TX  Zip: [76709-1208
[~ icive: =

PP A W AR u N N PP RN W R g arary

f

4. To save your changes, click OK.
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DELETE A VENDOR RECORD

If you've never used a vendor record for purchasing products, you can delete it.

Note: Vendor records only be deleted at the corporate site.

To delete a vendor

1. Search for the vendor whose record you want to delete. For more information, see
"Vendor Searches" on page 179.

2. When the Vendor Maintenance screen opens, make sure the General tab is selected
and click Delete. A confirmation messages appears.

3. Click Yes. The vendor is removed from the database.

VENDOR MAINTENANCE SCREEN

The Vendor Maintenance screen is used for adding vendors and storing vendor account information.

VENDOR GENERAL TAB

The General tab (Figure 9-1) contains basic information about the selected vendor. This is where
you can add, edit, and delete vendor records, and access the selected vendor's payment terms.

Vendor Maintenance (12200)

General |Ledgem—|ist0r}r|Aging| e | pest |
|1 |180
Contact Type Mumber [ E-Mail Mame
Name: |PARRISH TIRE Business Phone | [800-999-2255 |
Address: |P.O. BOX 1398 Fax Number L! 208-999-8473
Address2: E-Mail L! AR@parrishtire.com  |For billing questio
City: |TREADVILLE Business Phonsl!
State: [TX Zip: |76709-1 398 Business Phonsj
¥ Active FPhaone & E-Mail | Textl
Acct Type !‘u’ MFG Code:l ArlAp: IAF' Credit Limit: IU.UU
Bank Mame
Exp Acct
Ll I— Ii TiNg | [BanK OF AMERICA
B Account # [ASA0980 Rouing# _ BankAcct#
. 158908234 368989678
Motes:
Find | Add | Edt | Delete | Tems |

Figure 9-1: Vendor Maintenance Screen General Tab
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N .

Prev

Next

Name

Address

Address2
City
State

Zip

(blank)

Primary Phone

Alternate
Phone

Phone
Numbers

Acct Type
MFG Code
AP/AR

Credit Limit

Exp Acct

Lets you move to the record for the previous vendor on the Vendor List.

Note: This button is available for the General tab only. The shortcut key
for this button is PageUp.

Lets you move to the record for the next vendor on the Vendor List.

Note: This button is available for the General tab only. The shortcut key
for this button is PageDown.

Displays the vendor’s name.

Displays the vendor’s street address or P.O. box (if the vendor only has a
P.O. box number).

Displays the vendor’s P.O. box humber.
Displays the vendor’s city.

Displays the vendor’s state.

Displays the vendor’s zip code.

Displays the system-assigned vendor number. The prefix identifies the
site where the vendor was added.

Displays the vendor’s preferred phone number.

Displays an alternate number for contacting the vendor.

Lets you enter one or more phone numbers for the vendor. For more
information, see .

Lets you specify the vendor type for the vendor.
Not used.
Defines whether this is an AP (vendor) or AR (customer) account.

Lets you enter the maximum amount you can charge from the vendor.
Note: This value is only a visual reminder for you. It does not affect the
amounts you charge to a vendor.

Lets you assign a default expense account to the vendor. This expense
account is automatically entered as the offset account when creating
vendor charges for the vendor.

Note: If you need to remove this setting, click the Exp Acct field and
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N L

1099 Vendor
W-9 On File

TIN#

Account #

Bank Name
Routing #
Bank Acct #
Notes

Find

Add

Edit

Delete

Terms

OK

Cancel

press[z]. When the Chart of Accounts appears, click Cancel.
Then, click Yes to verify that you want to remove the account from
the vendor’s record.

Lets you indicate whether the vendor is a 1099 vendor.
Lets you indicate whether you have IRS form W-9 on file for the vendor.

Lets you define a vendor’s tax identification number. For individuals, you
can enter a social security number instead.

Lets you record the account number a vendor has assigned to you. When
you pay the vendor with checks, this number prints on the check stubs.

Lets you record the name of the vendor’s bank.

Lets you record the routing number for the vendor’s bank.

Lets you record the account number for the vendor’s bank.

Lets you include additional information about the vendor account.
Lets you look up a vendor.

Lets you add a new vendor.

Lets you update a vendor’s information.

Lets you remove a vendor from the database if that vendor has never
been used on a purchase order or receiving document.

Displays the payment terms the vendor has given you.

Lets you save changes and exit the screen. This button only appearsin
add and edit mode.

Lets you exit the screen without saving any changes. This button only
appears in add and edit mode.

VENDOR LEDGER/HISTORY TAB

The Ledger/History tab (Figure 9-2) lists the vendor’s transactional activity, which includes
purchases, returns, payments, and vendor charges.
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Vendor Maintenance (12200)

General

Aging |

IF‘ARRISH TIRE

|1 |1au

Search I ‘ SortBy: ¢ Ref#  Date ( Invoice#

03/02M9

03/0119 VC

P
1
02/28M9 1 EY:
02/28M19 1 ]
02/28M19 1 PY.
02/25M19 1 PY
02/20M19 1 = VC

v

<

Site |Mod |Inveice

163
128
161
127
122
142

Twwwwwwwwwwwwwwwww

View: i~ AP Ledger
i+ History

E-Mails |

Charge Amt Check#
238712 |47

Rebata

2508 0.00
123688 1299.24 1299.24 46
1253.26 0.00 26
44352 0.00 22
Return -185.60 -185.60

>
Open ltem | Print | Research |

Figure 9-2: Vendor Maintenance Screen Ledger/History Tab

Tip:  You can limit the number of documents retrieved when looking up a vendor’s history by
setting a system control. For more information, see "AR/AP Lookup Date " on page 1134.

on oo

Search

Sort By:

(first blank
field)

(second and
third blank
fields)

Date
Site
Mod

Invoice

Lets you narrow down the documents displayed by invoice number,
reference number, PO number, check number, or amount.

Lets you display documents by the transaction date, transaction
reference number, or invoice number.

Note: When Invoice# is selected, sorting by site number also occurs.

Displays the vendor name.

Displays the system-assigned vendor number.

Displays the transaction date.

Displays the site where the transaction took place.

Displays the type of document produced by the transaction.

Displays the document number for the transaction.
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fom __ Desetpten

Ref Displays the reference number or code entered at the time of the
transaction.

Note: When the selected transaction is a vendor credit resulting from a
national account or government support sale, this column displays
a memo number.

Total Amt Displays the total amount of the transaction (only when History is
selected).
Charge Amt Displays the portion of the transaction that you charged to the vendor.

Note: In most cases, this amountis equal to the value in the Total Amt
field. If you pay part of a vendor invoice with cash or check and
charge the remainder, this field displays the amount charged
instead.

Paid Amt Displays the amount applied to a vendor charge or the amount paid on a
vendor charge (when AP Ledger is selected).

PO Displays the vendor invoice document number for a purchase.

Checki# Displays the check numbers for AP payment checks and easy checks
used to pay the vendor (when History is selected).

AP Ledger Displays each charge and payment posted to a vendor’s account.
History Displays all transactions that have affected this vendor’s account.
E-Mails Lets you email one or more selected documents to the vendor.

Open Item Displays the open item ledger, which is used for viewing and applying

payments to outstanding invoices.

Print Lets you reprint the selected documents or a report listing the vendor’s
history.
Research Lets you view journal entries related to the selected transaction line.

VENDOR AGING TAB

The Aging tab (Figure 9-3) displays the balance you owe to the vendor, along with any past-due
balances.
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Vendor Maintenance (12200)

PARRISH TIRE |1 |1an

Current:

Balance: l 238712

YTD: Past

1-30:

0.00 | 3666.36 | 0.00
31-60: 61-90: Owver

0.00 | 2387.12 | 0.00 | 0.00

Figure 9-3: Vendor Maintenance Screen Aging Tab

Note: The vendor’s total balance for all sites is displayed at the corporate site and any stores that
share a database with the corporate site. At a remote store, however, the balances for only
that site are available.

T

Balance
Current

YTD

1-30

31-60
61-90
Over

Past

Displays the total amount you owe the vendor.
Displays the amount you owe the vendor now.

Displays the total amount of purchases from and charges to the vendor’s
account for the current year.

Displays the amount due to the vendor from tomorrow to 30 days from
now.

Displays the amount due to the vendor in 31 to 60 days.
Displays the balance due to the vendor in 61 to 90 days.
Displays any balances due to the vendor after 90 days.

Displays any balance that is past due.

VENDOR SEARCHES

Searching for vendors is one of most-commonly performed tasks in TireMaster. Vendor searches
typically occur when starting various transactions and when you need to look at the vendor's account

balance or history.

179



User Guide

To search for a vendor

1. Start a task that requires you to search for a vendor or select Vendors > Maintenance.
TireMaster prompts you for the vendor's name.

Vendors
Maintenance
Charges
Easy Checks
AP Payments

Maticnal Accounts
(W WN W YW W N

2. Type all or part of the vendor's name. If you want to retrieve all vendors instead, leave the Enter
Name field blank.

Tip:  You can use the percent sign (%) to replace an unknown portion of the vendor's name.

3. Toinclude inactive vendors in the search, clear the Active Only check box.

Clear the Search All Sites check box if you want to limit the search to vendors added at your
site.

Mame Lookup/Entry (2300)

Enter Name: |N.AP."—'4

[v Active Only
[v Search All Site QK | Cancel

5. Click OK. One of the following occurs:

= |fthe search finds an exact match, the Vendor Maintenance screen opens to the vendor's
record.

= |f more than one vendor matches the lookup, the Vendor List appears. In this scenario, select
the appropriate vendor’s name, and click OK.

Tip:  Ifyou selected the wrong vendor, click the Prev or Next button on the Vendor
Maintenance screen move to the correct vendor record.

VENDOR TYPES

Vendor types are used to classify vendors. Vendor types are set up and managed on the same
screen as customer types. For more information, see "Customer Type Edit Screen" on page 99.

ADD A VENDOR TYPE

TireMaster comes with several vendor types ready for you to use as is. However, you might want to
create your own vendor types for reporting purposes or for tracking sales differently.
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To add a vendor type
1. SelectVendors > Types. The Customer/Vendor Type List opens.
Vendors
Maintenance
Charges

Easy Checks
AP Payments

Mational Accounts
Types k
List Editing

Reports...
2. Click Add. The Customer/Vendor Type Edit screen opens.

olesale Sales

Farm Sales
Employee Sales

Mational Account Sales

Add Edit Delete

3. Define a unique code for the vendor type in the Type field.

Note: Forease of use, use only letters or numbers.

Inthe AP or AR field, type AP.
5. Type a description for the vendor type.

Custorner / Vendor Type Edit (1300)

Type Vv AP AR |AP

Description |‘u'end0rs Purchases - 1099

Accounts

\""mq‘“““[““‘i“““““l

6. Assign GL accounts to the vendor type. To assign an account, click the account field, press =],
and select an account from the list that appears.
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TP T T T P T TP T T TP T T YT T YT T I T T YT T YT

—Option
I~ Charge I~ Ship-To [~ Addons
[~ Vehicle [ TaxSelect [ Wholesale

[~ FETExempt [ Direct Deposit
[~ Price Levels for National/GS

Department I 1
oK Cancel |

Example: Using the TireMaster’s default accounts, the AP Account would be 2000-100.

7. To save the vendor type, click OK.

Note: For vendor types, disregard the settings listed under Options.

SET THE DEFAULT VENDOR TYPE

The default vendor type is automatically assigned each time you add a new vendor to TireMaster.

When you set the default vendor type, select one that best represents the vendors from whom you
buy products and services.

To set the default vendor type

1. Select Setup > System Controls. The System Controls screen opens.

Setup
System Controls Ib
Printers
WO Status

Users & Permissions

Menu Configuration

2. Click the Vendor tab.
3. Select Vendor Default Type and press Enter.

System Controls (8400)

Cnmmissinnl Eustomerl Enterprisel General Iedgerl Inventoryl Other  Wendor |

Dezcription |Value | SiteMo | ~

P Cuy

E"-.-"er‘u:ll:lr Default Type =

77 Ard-Partu Yendnr n 1 ~

" Corporate Controls € Store Contrals I~ Apply Changes To All Stores Close |

4. Selectthe type that you want to use as the default vendor type, and click OK.
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5. Close the System Controls screen.

UPDATE A VENDOR TYPE

At some point, you might need to change one or more of the GL accounts assigned to a vendor type
or you might want to change its description.

To update a vendor type
1. SelectVendors > Types. The Customer/Vendor Type List opens.
Wendors
Maintenance
Charges

Easy Checks
AP Payments

Mational Accounts

Types %

List Editing

Reports...
2. Click Edit. The Customer/Vendor Type Edit screen opens.
U T T INTER-STORE TRANSFER © 77 T ¢

W WVendors Purchases

rwes

Vendors Purchases - 1099—=
Z Bank Cards/ Check Cashing/Etc.

s

Add Edit Delete

3. Select different GL accounts or change the description.

To save your changes, click OK.
DELETE A VENDOR TYPE
If a vendor type is not assigned to any suppliers, it can be deleted.

To delete a vendor type
1. Select Vendors > Types. The Customer/Vendor Type List opens.
2. Select the type you want to remove, and click Delete. A confirmation message appears.

3. Click Yes.

VENDOR PAYMENT TERMS

Vendor terms define when payments are due and they affect purchase order processing.
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SET DEFAULT VENDOR PAYMENT TERMS

Default terms are automatically applied to all new vendor accounts. If a vendor’s terms do not match
the default terms, you change the vendor record for that supplier as needed. Default vendor payment
terms are set in System Controls.

To set default vendor payment terms
1. Select Setup > System Controls. The System Controls screen opens.

Setup
System Controls Ib

Printers

WO Status

Users & Permissions

Menu Configuration

2. Clickthe Vendor tab.
3. Setthe requirements for the default due date:
a. Select Default AP Due (D=#Days or T=Date) and press Enter

System Controls (6400)

Commigzion I Cugtomer I Enterprize I General ledger I Irventan I Other  Yendor |

Dezcription |Value |SileNo | ~

D ays between check run 15 1

Default AF Discount #0aps/Date 0 1

Default AF Discount (D=H#Days or T=Date] B} 1

Default AP Dizcount Percentage (%) 0.00 1

Default AF Due #Dayz/Date 15 1

Default AF Due [D=H#Da, 1

1 L&

b. Ifthe paymentis due by a specific number of days after the purchase, select Days. If the
payment is due by a specific day of the month instead, select Th. Then click OK.

c. Select Default AP Due #Days/Date and press Enter.

System Controls (6400)

Commissionl Custnmerl Enlerprisel General Iedgerl Irwentoryl Other  Vendor |

Drescription |Va|ue |SiteNn | ~
Days between check run 15 1
Default AP Dizcount #0ays/D ate ] 1
Default AP Dizcount [D=HD aps or T=Date) ] 1
Default AP Dizcount Percentage [%) 0.00 1
Default AP Due #Days/Da )
P

d. Type the number that represents the number of days after the purchase or the day of the
month. Then click OK.
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4. Setthe early pay discount percentage:

a. Select Default AP Discount Percentage (%) and press Enter.

System Controls (8400)

Cnmmissinnl Eustomerl Enterprisel General Iedgerl Inventoryl Other  Wendor |

Dezcription |Value |SileNo | ~
D ays between check run 15 1
Default AF Discount $0aps/Date 0 1
Default AP Dizcount [D=HDays or T=Date] D 1

b. Type the percentage amount and click OK.
5. Setthe requirements for receiving the early pay discount:

a. Select Default AP Discount (D=#Days or T=Date) and press Enter.

System Controls (8400)

Cnmmissinnl Eustomerl Enterprisel General Iedgerl Inventoryl Other  Wendor |

Dezcription |Value |SileNo | ~
AP Current D ays 900 1
Days between check run 15 1
Default AP Dizcount BD ayz/Date 1] 1

b. Ifthe vendor needs to receive the payment by a specific number of days after the purchase to
offer the early pay discount, select Days. If the vendor needs to receive the payment by a
specific day of the month instead, select Th. Then click OK.

c. Select Default AP Discount #Days/Date and press Enter.

System Controls (8400)

Cnmmissinnl Eustomerl Enterprisel General Iedgerl Inventoryl Other  Wendor |

Dezcription |Value |SileNo | ~
AP Current D ays

15

Days between check run

Default AP Dizcount #0ays/Date —

d. Type the number that represents the number of days after the purchase or the day of the
month. Then click OK.

6. Setthe default number of payments made to your vendors.

a. Select Vendor Default Terms and press Enter.
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Wendar Default Terms —_ o
Wendor Default Type W 1
77 Ard-Partu Yendnr n 1 v

€ Corporate Control: €7 Store Contrals [T Apply Changes To &l Stores Elaze |

b. Select the number of payments (installments) vendors typically allow per invoice, and click
OK.

7. Close the System Controls screen.

SET A VENDOR'S PAYMENT TERMS

If a vendor’s payment terms are not the same as the default terms, you can set individual terms for
that vendor.

To set a vendor's payment terms

1. Look up the vendor whose terms you want to set. For more information, see "Vendor Searches"
on page 179.

On the Vendor Maintenance screen, make sure the General tab is selected.

Click Terms. The Terms screen opens.

Add | Edit | Qeletel

To enable early pay discounts, make sure the Give Early Pay Discounts check box is selected.

To set up a unique early pay discount, due date, or both, clear the Use Above Defaults check
box. TireMaster disables the default terms.

System Controls (8400)

Cnmmissinnl Custnmerl Enterplisel General Iedgerl Inventoryl Other  Wendor |

Dezcription |Va|ue |SiteNo | ~
D ays between check run 15 1
Default AP Dizcount #0ayps/Tate 0 1
Default AP Dizcount [D=HDayz ar T=Date] D 1
Default AP Dizcount Percentage [%) 0.00 1
EIZZI efault AP Due #D ays/D =
F

6. If you selected the Give Early Pay Discount check box in step 4, do the following:

a. Type the discount percentage in the Discount % field.
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9.

Vendor Payment Terms

Example: To subtract 5% from an invoice for which you receive early payment, type 5 in

the Discount field.

b. Ifthe payment must be received a specific number of days after the purchase to give the
discount, type the number of days in the Discount Days field and select Days Later. If the
payment must be received by a specific day of the month instead, type the day of the month

and select Day of Month.

If the payment is due a specific number of days after the purchase, type the number of days in
the Due Date field and select Days Later. If the payment is due by a specific day of the month

instead, type the day of the month and select Day of Month.

Discount %: 2

] « Days Later

Discount Days: 0~ Dai of Month
_ " Days Later

Due Date: 20 & Day of Month

L'ﬂ“E'E‘?..TSL"ﬂ.S;...44444-‘.444;444;4444444:

Note: If payments are due on the last day of the month, type 31. TireMaster will adjust due

dates for months with fewer than 31 days.

Under Invoice Terms, select the maximum number of payments the vendor allows you to make

on an invoice.

T T P T P T PV P Yy yFr Yy y Yy Wy Yy Yy Ty Ty Ty Ty ry vy rye

Invoice Terms:
f+ 1 Payment (" 3 Paymenis
" 2 Paymenis (" 4 Paymenis

(" Definable At Point of Sale

QK Cancel

To save your changes, click OK.
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CHAPTER 10

INVENTORY CONTROL

TireMaster includes a variety of tools for managing your inventory. This chapter includes the
following sections:

Track Inventory Costs and Quantities ... . ... 190
Add and Manage Items . 191
Inventory Maintenance Screen .. . 206
Inventory Searches . . il 216
Custom Inventory Lookup Screen ... .. .. 225
The Inventory List ... . 229
Inventory History il 230
omPhysical CoOUNtS . 233
Add-On Packages ... .. . 239
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TRACK INVENTORY COSTS AND QUANTITIES

Before you add an item to the inventory, you need to decide whether you want to track its cost and
quantities. Depending on the choice you make, you'll classify the item as either inventoriable or
noninventoriable.

Note: Inventoriable and noninventoriable items are not the same as stock and nonstock items. The

term stock means an item is carried in inventory. Nonstock refers to items that are purchased
for specific jobs. Inventoriable and noninventoriable define whether you track an item’s
quantities and cost.

INVENTORIABLE ITEMS

If you need to keep track of an item’s cost and quantities, set it up as an inventoriable item.
Inventoriable items include the items that you typically keep in stock and include in your physical
inventory counts. If you want your sales reports to show the profit or loss for an item, setit up as
inventoriable.

To classify an item as inventoriable, type the letter Y in the Inventory (Y/N) field on the Inventory
Maintenance screen. To track changes in an inventoriable item’s cost, you need to select one of
three inventoriable costing methods. For more information, see "Inventoriable Costing Methods" on
page 346.

Inventory Maintenance (12300)
General ‘QMF'ricingl History l MNotes l JF'rev JNSH

Product Code: |?44828802 Partg: 1| 4045
Size: |LT235J’?5R15J’5 Rim Size: 15.00
Inventory (YIMN): \d
Description:  [HT WRANGLER
Type (G,CFD):
Quick Look: |235?5155 v Active [ Discontinued )
Color'Spiff:
: TIRES " Pas I Lab
Group: | Charge Shop: arts abor Commission: l_
-

LAAAALALASALDALLLLAADLADDDALEEDLADADDLEDLDDDLDDDBILEDDEDDLDDADDSDDDEDLLDDSLSMS

Figure 10-1: Classifying an Item as Inventoriable

NONINVENTORIABLE ITEMS

If you need to track an item’s cost but not its quantities, set it up a noninventoriable item.
Noninventoriable items typically include labor, nonstock items such as service parts, and hard-to-
track items such as valve stems.

To classify an item as inventoriable, type the letter N in the Inventory (Y/N) field on the Inventory

Maintenance screen. When you set up a noninventoriable item, you also need to decide the
following:

= |fyou wantto post the item’s cost to general ledger at point of sale (Option Cost Method).
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= |fyou want to post the item’s cost to the general ledger when you buy it from a vendor
(Expense Method).

= [fyou want to post the item’s cost to the general ledger when it’s sold (Relief Percent Method).

For more information, see "Noninventoriable Costing Methods" on page 347.

Inventory Maintenance (12300)
General ‘OtyfF'ricingl History l Maotes l JF'rev JNSH

Product Code: [23 Par | 1] 23

Size: | Rim Size: 0.00
Inventaory (Y/M): M

Description: |NON—STOCKWATER PUMP

Type (GCFDY: |
Quick Look; |NSF'TSWF' v Active [ Discontinued .
Colon/Spiff. l_
: SERVICES <[~ Parts [ Lab
Group: | Charge Shop: arts abor Commission: ,—

|v Force Option Cost

LAAAAAALAALLDALLDSLLLALDADALDELELLDLDALLDLDEEDbALDbidbdhdbddddsdddbdbddddsbssls

Figure 10-2: Classifying an Item as Noninventoriable

ADD AND MANAGE ITEMS

Because tracking inventory activity is an ongoing task, TireMaster includes tools for gathering
information about the products and services you sell.

ADD AN INVENTORY ITEM

When you add an item to the inventory, you need to complete settings that will help you distinguish it
from the other products and services you sell. Completing all of the available inventory settings is not
necessary, however, each item must be assigned the following:

= Aunique product code
= Aninventory category
= AGLcode
You also need to define whether an item is inventoriable or noninventoriable.

Note: Mostitems should be added at the corporate site. Stores, however, can add and manage
items that won't be sold by other locations. An item added by a store cannot be viewed or
changed by another store.

To add an item

1. Select Inventory > Maintenance. TireMaster prompts you to search for an item.
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Inventory
Maintenance
PO & Receiving
Suggested Reorder & PO
City Adjustment Wizard

List Editing

LAAAAALALSSSSLSDSSSSSS

2. Do one of the following:

= Search for an item that’s similar to the one you’re adding. For more information, see
"Inventory Searches" on page 216.

Tip:  Bylooking up a similar item, you can reuse many of its settings for the new item.

= Click Cancel.

3. When the Inventory Maintenance screen opens, click Add. TireMaster prompts you for a product
code.

PP TV T T VT T T T T T T T T T T YT T T T YT Y,

Bolt1: Lugs: Offset: l—
Bolt2: Width: Weight:

e

"YYWV IYYYYYS

4. Type a unique product code for the new item and click OK.

Add New Inventory (1000)

Mew Product Code:
90000032516|

I Ok I Cancel

5. Enter the item’s basic information:

a. Type the size, description, and quick-look code. For tires, also type the rim size.
Note: Foritemsthatdo not have a size, type a period (.) in the Size field. The period
ensures that the item’s information prints properly on work orders and invoices.
b. Click the Group field, press [z]. Then select a group from the list that appears, and click OK.
c. Make sure the Active check box is selected.
6. Define whether to assess shop charges for the item.

= For shop charges based on the sum of the item’s parts price and FET, select the Charge
ShopParts check box.

=  For shop charges based on the item’s labor price, select the Charge Shop Labor check
box.

= For shop charges based on both the item’s parts price and labor price, select both of the
Charge Shop check boxes.
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Inventory Maintenance (12300)

General ‘CMF’ricingl History ] Motes ]

Product Code: [90000032516

Size: [225/65R 16 100T Rim Size: [ 16.00
Description: |EVOLUT|ON TOURALL-SEASON

Quick Look: |2255515 Iv Active [~ Discontinued
Group: |i'I'IRES Charge Shop: # Pars [ Labor

N A A A A A A

Note: To assess shop supplies, other settings also need to be completed. For more

information, see "Shop Supplies" on page 339.

7. Define how the item should be handled.

a.

d.

If the item is inventoriable, type the letter Y in the Inventory (Y/N) field. For noninventoriable
items, type the letter N instead. For more information, see "Inventoriable ltems" on page 190
and "Noninventoriable Items" on page 190.

Define the item’s type in the Type (G, C, F, D) field:

For normal items, leave the field blank.

For gasoline, type the letter G. For more information, see "Add Gasoline to the Inventory"
on page 333.

For consignments, type the letter C. For more information, see "Set Up Consignment
Items" on page 332.

For fees, type the letter F. For more information, see "Set Up Fees" on page 338

For discounts, type the letter D. For more information, see "Set Up Discounts" on

page 338.

If you'll record the cost of the item at point of sale, select the Force Option Cost check box.

Note: This settingis only for noninventoriable items obtained through outside purchases.

For more information, see "Noninventoriable Costing Methods" on page 347

If the item is noninventoriable and you want to track it, select the Track check box. For more
information, see "ltem Tracking" on page 280.

8. Enter employee incentive information (optional).

a.

To assign a spiff color to the item, click the Color/Spiff field and press [z]. Then select a color
from the list that appears and click OK.

If you pay sales commission for the item, click the Commission field and press[z]. Then
select the inventory commission type and click OK.
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Part#: l_ l—

Inventory (Y/M): ,‘r’_
Type GCFDE |
ColorSpift [
Commission: ,A_

-

e, e e ol e, e

RAASAASLASSSSSSS LS

9. Enter up to three bar codes (optional). For more information, see "Prepare to Use Bar Codes" on
page 322.

10. Enter the vendor part number and reconciliation code for the item’s main vendor or
manufacturer.

a. Type the part numberin the Vendor Part Number 1 field.

b. Clickthe Recon Code 1 field and press [z]. Then select the reconciliation code for the item’s
main vendor or manufacturer and click OK.

T P T T T T T T T T T T T T T T T T P T T T T T T T T T T T T T T T T T T T F T v T T PP Py vy P v Py vy vy ooy ooy yowrvrryryw

Bar Code: |070563321156 Bar Code2: Bar Code3:

Vendor Part Number 1: Vendor Part Mumber 2: Vendar Part Mumber 3: ‘endor Part Mumber 4:

90000032516 & | | |
Recon Code 1: codr Recon Code 2: Recon Code 3: Recon Code 4:

AAALALLLLADLLLLDLDALDLADDLDADLDDASLDDDALDLADADDLEDLDDELDDDLDEDADADDSDSLDLDDDDSLSAN

Note: The Vendor Part Number 1 and Recon Code 1 fields are used together.
Therefore, if the vendor part number is for Goodyear, the reconciliation code needs
to be the one for Goodyear.

11. Enter up to three additional vendor part numbers and reconciliation codes for other vendors who
distribute the item.

Note: The additional vendor part numbers and reconciliation codes are used together as well.
For example, if the Michelin vendor part number is entered in the Vendor Part Number
2 field, the Michelin reconciliation code needs to be entered in Recon Code 2 field.

Tip:  To see which vendor part numbers and reconciliation codes are assigned to items,

generate a Vendor Part Number List. This report is on the Inventory tab on the Report
List.

12. Enter the following tire and wheel details as needed.

a. Fortires, enter the load index/speed rating, UTQG rating, load range, sidewall style, and
treadlife warranty. For information on using the Core Item field, see "Prepare to Track Core
Items" on page 884.
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B i i b i b ke ke

Load/Speed: [100/T Load Range: |STD Warranty: ESUUU|
UTQG: |600-A-B Sidewall: |BLK Core Item:

ety [ wues [ oreer [ L Adeonkitcods [ | | Taedle 7 Parts 7 Lavor ] |
For wheels, enter the number of lugs, the bolt pattern, the rim width, and the rim offset.

Type a minimum weight requirement (optional).

13. Assign the following codes and tax settings:

a.
b.

Click the Add On/Kit Code field and press [z]. Then select an add-on code and click OK.

Click the Mfg Code field and press [z]. Then select the code for the item’s manufacturer and
click OK.

If the item’s price excluding labor is taxable, make sure the Parts check box is selected.
Otherwise, clear the check box.

If the item’s labor price is taxable, make sure the Labor check box is selected. Otherwise,
clear the check box.

Click the Category field and press [z]. Then select a category code and click OK.

Click the GL field and press [z]. Then select a GL code and click OK. or one of the three
preset GL codes and click OK.

PPV P P T TV T PP T TV TV Py VTV Ty oYYV VYT YT T T YY

Add-On/Kit Code: [PT Taxable: | Pars [v Labor

Mfg Code: |COOQ Category: [TIPA  GL: [TPAI

oK | Cancel |

B e b

14. To save the new item, click OK. TireMaster prompts you to edit the prices for the new item.

VTV VIV POV ewe

b

Ty

v Parts [w Labor

TIPA  GL: |TPAI

E|

K Cancel |

15. To add prices for the item, click Yes. For instructions, see "Fixed Prices" on page 358.
Otherwise, click No and close the Inventory Maintenance screen.

UPDATE INVENTORY INFORMATION

When you need to update information for items, you have two options. You can update items one ata
time or in bulk by with Inventory List Editing.
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UPDATE INFORMATION FOR A SINGLE ITEM

When you need to update the information for a single item, you can make the needed
changes in the record for that item.

To update an item’s settings

1. Look up the item you need to update. For more information, see "Inventory Searches"
on page 216.

2. Do one of the following on the Inventory Maintenance screen:

=  To change codes assigned to the item, make sure the General tab is selected.
Then click Edit.

Inventory Maintenance (12300)

General |Ot]u’F'ricing| History | Notes |

P WY wY

Product Code: |T44826802 5

Add || Edit I Delste |

r

= To change price, cost, and stocking-level settings, click the Qty/Pricing tab. Then
click Detail/Edit to open the Site Prices and Quantity screen.

General UtnyfiCiﬂg| Historyl Motes |

Site#: Part#: Description : Product Code : Size »

1 4045 HT WRANGLER : 744826802 : LT23

! ! ! i: DetaillEdit
)

= To change the item’s notes or link to a web site, specifications sheet, or product
photo click the Notes tab. Then click Edit Note.

General |{11yfF'ricing| History Notes |

4
4
4
4
4
4
E.

Site#: Part#: Description : Product Code - Size
|1 |4045 |HT WRANGLER : 744826802 : LT235/75R14(R

NUVVUS I TT TSSO OUe

3. Update the settings that need to be changed.
4. To save the changes, click OK.



Add and Manage Iltems

UPDATE INFORMATION FOR MULTIPLE ITEMS

With Inventory List Editing, you can update the settings for a group of items. The Inventory
List Editing screen is similar to a spreadsheet and is split into two panes. The top pane lists
basic properties for items, such as size, product code, and group. The bottom pane is for

price, cost, and stocking-level settings. List Editing is available only that the corporate site.

To update information for multiple items

1. SelectInventory > List Editing. TireMaster The Custom Inventory Lookup screen
appears.

Inventory
Maintenance
PO & Receiving
Suggested Reorder 8 PO
Cty Adjustrent Wizard

List Editing

Pricing Wizard

AAAAAAAAAAAAAAAAAAAAAA

2. Search for a group of items to update. For more information, see "Inventory Searches"
on page 216.

3. Resize screen and rearrange the columns (one on or both of the panes) if needed. For
more information, see "Resize Screens" on page 10 and "Rearrange Table Columns"
on page 10.

Note: If you belong to a security group that’s assigned the permission Save Screen
Layout, you can save your changes by clicking Save Layout.
4. Inthe top pane, select the row for the item you want to update. The corresponding row
for that item is automatically selected in the bottom pane.
Note: For ahard copy of the information listed on the screen, click Print.
5. Inthe top pane, make changes by typing them, selecting or clearing check boxes, and

selecting codes from a list. To access the various code lists, click the cells colors
yellow. Then press or click [z]. Your changes are saved instantly.
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W Inventory List Editing (16145)

PartMo |Size Prod Code Rim |Description Addon Vend Part Mo
4041 LT215/75R15/8 744154900 15 HT WRANGLER PT 135442563
4044 LT215/85R16/10 744821900 16 HT WRANGLER PT 135815463
4046 LT225/75R16M0 744830900 16 HT WRANGLER 1135815469
4045 LT235/75R15/6 744826802 15 HT WRANGLER ) 135815466
4043 LT235/85R16/10 744725502 16 HT WRANGLER 135869830
4042 LT245/75R16/10 744395900 16 HT WRANGLER 135548570

Note: Because anitem’s product code cannot be blank, TireMaster will re-enter it if it
has been deleted.

Tip:  Pressthe arrow keys to move from cell to cell and press Tab to move between
panes.

6. Inthe bottom pane, click the row for the selected item and make changes as needed. In
the Price By and Operator columns, press [7]repeatedly to see your choices.

W Inventory List Editing (16145)

PartMo  |Size Prod Code Rim |Description Addon “end Part Mo

4041 LT215/75R15/8 744154900 15 HT WRANGLER PT

FIYVIN | T215/85R16/10 | 744821900 HT WRANGLER

4046 16 HT WRANGLER

Product Code: 744821900 Size: LT215/85R16M0 Description: HT WRANGLER

Part Mo |Site |F'arts |Lab0r |Last Cost |F'rice By |Elase |Dperat0r |Fact0r |St4
4041 1 230.45 0.00 160.45 C 160.45 D y
4044 1 255.20 0.00 185.20 |C 185.20 D 0.70|
4046 1 243.60 0.00 173.60 |C 173.60 D 0.75
4045 1 220.98 0.00 150.98 |C 150.98 D 0.75
4043 1 220.27 0.00 150.27 |C 150.27 D 0.75
4042 1 187.29 0.00 117.28 |C 117.29 D 0.75

Tip:  To copy and paste settings, click the cell with the number or code you want to
copy. Then click the cell again and press Ctrl+C. Next, click the cell where you
want to paste the data. Click the cell again and press Ctrl+V.

7. Tochange additional items, repeat steps 4 through 6.

8. If you want to edit another group of items, click Select Inventory.

Save Layout | I Seledlnventory” Close I

9. Close Inventory List Editing screen.
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UPDATE ITEMS WITH SPREADSHEETS

You can update price, cost, and bar code settings for existing items by importing data from an XML
spreadsheet into TireMaster. Updating items in this manner helps you save time, because
information for multiple items can be updated at once.

Note: To ensureitems can be updated, the spreadsheet needs to meet certain requirements. For

information on creating spreadsheets for inventory updates, see "Spreadsheet
Requirements " on the next page.

To update items with an XML spreadsheet

1.

Select Inventory > Spreadsheet Updates. TireMaster prompts you to update items with an
XML spreadsheet.

Inventory

Maintenance
bbb bddbdsdddddddsdddds

FPT VYTV PP T T PP T T T T T T YT

List Editing

Pricing Wizard
Spreadsheet Updates
Color & Spiff Codes

ASAALLLSLLLSSSSSSSSSS

Depending on how your spreadsheet is set up, select Vendor Part Number or Product Code.
TireMaster checks your inventory for any items that have been assigned duplicate part numbers

or product codes.

Inventory Update from Spreadsheet XML File (12310)

IUpdate by: " Vendor PartNumber @& Product Codei|

Select Inventory Update File | |

P VW W Pwesy

Motes:
|

Note: Items with duplicate part numbers or product codes will not be updated. Therefore, you
might want to verify that unique part numbers and product codes are assigned to items
before updating the prices.

Tip:  Togenerate a hard copy of the notes at any time, click Print Notes.

Look up the spreadsheet with the price information:
a. Click Select Inventory Update File. The Load Inventory Update File screen appears.

Inventory Update from Spreadsheet XML File (12310)

Update by: ¢ Vendor Part Number &+

Motes:

I Select Inventory Update File I | ;
<

b

b. Select the file that you want to use for the update and click Open.

Note: If you don’t see the file you want to use, select it from the Look in drop-down.
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To view the pending changes, click Preview. If TireMaster cannot access the data file, make
sure the spreadsheet is no longer open in Excel.

K
4
4
4
4
4
4
4
4
4
4
4
4
4
4
4
4
4
4
4
4
4
4
4
4
4
4
4
L
"

Jalosassnssa

Print Motes | | Preview I

Note: Although prices on the update screen might extend to more than four decimal points in
some instances (such as BASE=.047399999999999998), those values will be displayed
properly on TireMaster’s setup screens for the updated items (such as 0.474).

To complete the update, click Process Inventory Update. The following message appears:
“Inventory update is complete.”

Sl b e

»
»
»
»
>
>
E:" Process Inventory Update I Close |
>

Note: Although prices on the update screen might extend to more than four decimal points in
some instances (such as BASE=.047399999999999998), those values will be displayed
properly on TireMaster’s setup screens for the updated items (such as 0.474).

Click OK to close the message.

Close the Inventory Update from Spreadsheet XML File screen.

Verify that the price, cost, or bar code fields were updated by looking up a sample of individual
items or by looking up multiple items in Inventory List Editing.

SPREADSHEET REQUIREMENTS

XML spreadsheets (Figure 10-3) used for updating inventory need to meet the following
requirements:

= |t mustbe saved in the XML spreadsheet format.

Tip: In Microsoft® Excel®, select Save As from the File menu. Then select XML
Spreadsheet from the Save as Type drop-down list.

= Each column heading mustinclude the TireMaster database column name in
parenthesis. (For example, INVPRICE.DBILL.)

= |t must have a column for vendor part numbers, product codes, or both.

= |fanamountis 0.00, type 0. 00. Cells cannot be blank.
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@ﬂ

Examplexm| <= The file is saved in the XML format.

A B E D
Product Code Base Price EDL Last Cost
. (inv.invno) (invprice.Dbill}) | (invprice.EDL) @ (INVPRICE.LASTCOST)
2 000098 140.00 170.00 — 0.00
3 000215 158.31 188.31 0.00
4 000266 20027 220.27 20027
5

000428 115.16 115.16

At least one of the Database column The number 0.00 is
required columns is names are in entered instead of
included. For this parenthesis. leaving cells blank.
example, it's vendor

part number.

Figure 10-3: XML Spreadsheet Example

The Pricing folder in the TireMaster program directory (c:\TireMaster\Pricing or
d:\TireMaster\Pricing) includes two spreadsheets that you can modify, or you can create
your own. Table 10-1 lists the fields in TireMaster that can be updated with an XML
spreadsheet, along with the corresponding database column names.

Table 10-1: XML Requirements

TireMaster Field Name Database Column Name

Vendor Part # INV.VENDPARTNO Spreadsheets must
have a column for
vendor part numbers,

Product Code INV.INVNO product codes, or
both.

Bar Code 1 INV.BARCODE1

Bar Code 2 INV.BARCODE2

Bar Code 3 INV.BARCODE3

Base Price INVPRICE.DBILL

Last Cost INVPRICE.LASTCOST

Labor Price INVPRICE.LABOR

Everyday Low INVPRICE.EDL
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TireMaster Field Name Database Column Name

Price By INVPRICE.PRICEBY

Factor INVPRICE.FACTOR

Sale Labor INVPRICE.SALE_LABOR
Sale Price INVPRICE.SALE_PRICE
Sale Begin (date) INVPRICE.SALE _BEGIN
Sale End (date) INVPRICE.SALE_END

Last FET INVPRICE.LASTFETAX

Next FET INVPRICE.FETAX

Standard Cost INVPRICE.STANDARDCOST

ASSIGN STOCKING LEVELS TO A GROUP OF ITEMS

With the Pricing Wizard, you can assign the same minimum stocking level, the same maximum
stocking level, or both to a group of items. You’ll most likely use the Pricing Wizard to assign stocking
levels in conjunction with another task. For example, in one session of using the Pricing Wizard, you
could do the following to the tires in a specific product line:1) set the minimum stocking level, 2) set
the maximum stocking level, and 3) update the cost.

Note: Stocking levels can also be defined in the settings for individual items and for groups of items
with Inventory List Editing. With Inventory List Editing, you can vary the minimum and
maximum stocking levels assigned. For more information, see "Update Information for
Multiple Items " on page 197

To assignh stocking levels with the Pricing Wizard

1. SelectInventory > Pricing Wizard.

Inventory

Maintenance
bbb bbb bddbddddbddddbdd

TV PP YIT YT P TP E YT YT I TY L

List Editing

Pricing Wizard
Spreadsheet Updates
Color & Spiff Codes

AAALAAALAALSSSSSSSSSSSS

2. Make sure Price Change is selected.
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izard (4700)

Operation 1

Source Field

3. Update the minimum stocking level if needed. Otherwise, skip this step.

Add and Manage Iltems

a. Select Min Stock from the Field to Update drop-down for the operation being used to
update the minimum stocking level. The Value field appears and replaces the price change
fields.

Pricing Wizard (4700)

[
{« Price Change { Sale ‘ Begin Date: I 3/126/2019 1.
) 4
Operation 1 <
Source Field Field to Update :

| El I
4

Last Cost S j

Standard Cost 4

Price Level :

Operation j
Source Field C

b. Type the number you want to assign as the minimum stocking level in the Value field.

3/26/2019 hd

H.

4. Update the maximum stocking level if needed. Otherwise, skip this step.

vy

Value: I41

a. Select Max Stock from the Field to Update drop-down for the operation being used to
update the maximum stocking level. The Value field appears and replaces the price change
fields.

Pricing Wizard (4700)

it

[
f+ Price Change (" Sale ‘ Begin Date: | 2/26/2019 ;
q’wwvwwwvwwwwvwm
—Operation 2 p
Source Field Field to Update 4

4

| = |

4

Last Cost ~l e

Standard Cost :

Frice Level E

—Operation 3 Min Stock ¥
Source Field L

Factor 4

I j Watrix $
Color/Spiff hd 1

b. Type the number you want to assign as the maximum stocking level in the Value field.
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8.
9.

[}
]
=

[
=
w

Value: |4

Rah b b b A

E

i

Yalue: |12 x

AAALLASALSAALSSSSLLSSSSSSSSSS

Click Inventory, and look up the item or items to which you want to assign stocking levels. For
more information, see "Inventory Searches" on page 216.

Invento ry"r |

Load Configuration | Save Configuration |

e

<
4
<
<
<
<
<
<
<
)

Review the pending changes.

a. Click Print for Review. The Report Window opens and displays the Pricing Wizard Report.

|

4
4
4

4
MFG="B Rﬁ

<
4
<
4
<
4

Load Configuration | Save Configuration |

b. Verify that the changes you want will be made.
c. Printthe reportif needed, and close the Report Window.

Click Apply. A confirmation message appears.

.

L
>

R e e f

[ ey | ciose |

Click Yes. A second message verifies the update has been completed.

Click OK to close the confirmation message.

To view the changed stocking level for a single item, look at either the Min Stock or Max Stock field
on the Site Prices and Quantity screen. For multiple items, select List Editing from the Inventory
menu, and look up the same items you just updated. Stocking levels are listed in the lower-right half
of the Inventory List Editing screen. If you can’t see them, scroll to the right.
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DISCONTINUE AN ITEM

When you stop selling a particular item or when a manufacturer no longer makes an item, you can
classify that item as discontinued. Once a discontinued item reaches a quantity of zero, TireMaster
changes the item’s status to inactive when you cut off the month.

To discontinue an item

1. Search for the item you want to discontinue. For more information, see "Inventory Searches" on
page 216.

On the Inventory Maintenance screen, make sure the General tab is selected and click Edit.
Select the Discontinued check box.

To save you changes, click OK.

MAKE AN ITEM INACTIVE
By making an item inactive, you can exclude it from inventory searches and reports.

Note: When you close the month, TireMaster changes the status of any discontinued items with a
quantity of zero to inactive. To determine whether an item’s quantity is zero, TireMaster adds
the item’s quantity on-hand to the item’s quantity on order.

To make an item inactive

1. Search for the item you want to discontinue. For more information, see "Inventory Searches" on
page 216.

2. Onthe Inventory Maintenance screen, make sure the General tab is selected and click Edit.

General IQtyfF'ricingl History l Motes l

Add || Edit I Delete |

3. Clearthe Active check box.

General ‘OtyfF’ricingl History ] Notes ]

Product Code: [144356

Size: |‘1759’55R'15 Rim Size: 15.00

Description: ~ [WS70 BLIZZAK

Quick Look: |‘1755515 [~ Discontinued

Group: [TIRES Charge Shop: [~ Parts [~ Labor

4. To save you changes, click OK.
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DELETE AN ITEM

Inventory items cannot be deleted. You can make them inactive instead. For more information, see
"Make an Item Inactive" on the previous page.

INVENTORY MAINTENANCE SCREEN

The Inventory Maintenance screen is used to store and track information about the products and
services you sell. Tasks commonly performed with this screen include adding items

and viewing an item’s history.

GENERAL TAB

The General Tab (Figure 10-4) stores an item’s basic information, as well as several codes that are
part of its settings.

Inventory Maintenance (12300)

General |QtyfF'ricing| History | Motes | ﬂlﬂl

Parr. [ 1 [ 3057 ‘

Product Code: |732804500

Size: IF‘23EM'TUR16!SL Rim Size: I 16.00

Inventory (YIM): IY
Description: IRS—AEAGLE

Type (G,CFD): I
Quick Look: |2357016  Active [T Discontinued _

Color/Spiff. I
Group: ITlRES Charge Shop: [~ Farts [ Labor T I—

Commission:

I~ Force Option Cost

Bar Codet: In Bar Code2: IU Bar Code3: IU

‘endor Part Mumber 1: ‘endor Part Mumber 2: ‘endor Part Mumber 3: ‘eendor Part Mumber 4:
135000477 | | |

Recon Code 1: I Recon Code 2: I Recon Code 3: I Recon Code 4: I

Load/ Speed: Load Range: Warranty:
uTQG: Sidewall: Core tem:
Bolt1: | 000 Lugs: I 0 Offset Add-On/Kit Code: Ip-r Taxable: [ Parts | Labor
Boltz: | 000 Width: | Weight: | 0.00 || yrgcode: [GDY Category: [TIPA oL [TPAI
Eind | Edt | Delete | Close |

Figure 10-4: Inventory Maintenance Screen General Tab
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fom __Desetpten

Prev
Next

Product Code

Size

Rim Size
Description

Quick Look

Group

Active

Discontinued

Charge Shop:
Parts

Charge Shop:
Labor

Part#

Inventory
(Y/N)

Lets you move to the record for the previous or next item on the
Inventory List. The items displayed when clicking the buttons depends
on the search options and sort order used for the inventory lookup.

Note: If you click Next on the screen for the last item retrieved,
TireMaster will beep. At that point, you can only move
backward. TireMaster also beeps if you click Prev on the
screen for the first item retrieved. In that scenario, you can only
move forward.

Lets you enter the number assigned to an item by the manufacturer.
This number must be a unique.

Lets you enter an item’s size.

Note: To ensure that various documents are formatted properly, use
a code of your choice or a period for items that don’t have a
size.

Lets enter the size for rims.
Lets you create a description for the item.

Lets you assign an easy-to-remember code of your choice that you can
use to look up the item.

Lets you assign an inventory group to the item. For more information,
see "Inventory Categories and Groups" on page 314.

Lets you define that the item is currently being produced or is currently
being sold.

Lets you define that the item is no longer being produced or is no longer
being sold.

Lets you define whether to assess a shop charge based on the sum of
the item’s parts price and FET.

Lets you define whether to assess a shop charge based on the item’s
labor price.

Displays the site number and the system-assigned number for the item.

Lets you state one of the following:
= Y identifies inventoriable items

= N identifies noninventoriable items
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fom __Desetpten

Type
(G,C, F,D)

Color/Spiff

Commission

Force Option
Cost

Bar Code 1
Bar Code 2
Bar Code 3

Vendor Part
Number 1

Recon Code 1
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Lets you classify the item:
= No entry identifies a normal item.
= G identifies the item is gasoline.
= Cidentifies a consignment item.
= Fidentifies the item is a fee.

= D identifies the item is a discount.
Lets you assign a color code, sales spiff, or both to the item.

Lets you assign an inventory commission type to the item.

Note: If this code is not entered manually, TireMaster uses the default
inventory commission type set in System Controls for
calculating commission.

Lets you remind users to enter the exact cost, including FET, of
noninventoriable items at point of sale.

Note: Ifthe System Control Force Option Costis setto Yes, users
are required to enter the cost.

Lets you assign a primary bar code to the item.
Lets you assign a secondary bar code to the item.
Lets you assign a third bar code to the item.

Lets you enter the vendor part number for the item’s main vendor or
manufacturer. Some vendors and manufacturers refer to vendor part
numbers as article numbers or product IDs.

Tip: Because the entry in this field is the only vendor part number
displayed on the Inventory List and the Inventory List Editing
screen, you should enter the most frequently used vendor part
number here.

Note: This vendor part number is used in conjunction with
reconciliation code 1. Therefore, both the part number and
reconciliation code need to be for the same vendor. For
example, if this is a Goodyear vendor part number, the
Goodyear reconciliation code needs to be entered in the
Recon Code 1 field.

Lets you assign the reconciliation code for the item’s main vendor or
manufacturer. This code is used for tracking national account,
government support, and defect adjustment sales.



Inventory Maintenance Screen

fom ___Desetpten

Vendor Part
Number 2

Recon Code 2

Vendor Part
Number 3

Recon Code 3

Note: This reconciliation code is used in conjunction with vendor part
number 1. Therefore, both the part number and this
reconciliation code need to be for the same vendor. For
example, if this is the Goodyear reconciliation code, the
Goodyear vendor part number needs to be entered in the
Vendor Part Number 1 field.

Lets you enter a second vendor part number for another vendor who
distributes the item. Some vendors refer to vendor part numbers as
article numbers or product IDs.

Note: This vendor part number is used in conjunction with
reconciliation code 2. Therefore, both the part number and
reconciliation code need to be for the same vendor. For
example, if this is a Michelin vendor part number, the Michelin
reconciliation code needs to be entered in the Recon Code 2
field.

Lets you assign a second reconciliation code for another vendor. This
code is used for tracking national account, government support, and
defect adjustment sales.

Note: Thisreconciliation code is used in conjunction with vendor part
number 2. Therefore, both the part number and this
reconciliation code need to be for the same vendor. For
example, if this is the Michelin reconciliation code, the Michelin
vendor part number needs to be entered in the Vendor Part
Number 2 field.

Lets you enter a third vendor part number for another vendor who
distributes the item. Some vendors refer to vendor part numbers as
article numbers or product IDs.

Note: This vendor part number is used in conjunction with
reconciliation code 3. Therefore, both the part number and
reconciliation code need to be for the same vendor. For
example, if this is a Bridgestone vendor part number, the
Bridgestone reconciliation code needs to be entered in the
Recon Code 3 field.

Lets you assign a third reconciliation code for another vendor. This
code is used for tracking national account, government support, and
defect adjustment sales.

Note: This reconciliation code is used in conjunction with vendor part
number 3. Therefore, both the part number and this
reconciliation code need to be for the same vendor. For
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Vendor Part
Number 4

Recon Code 4

Load/Speed
uTQG

Load Range
Sidewall

Warranty

Core Item
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example, if this is the Bridgestone reconciliation code, the
Bridgestone vendor part number needs to be entered in the
Vendor Part Number 3 field.

Lets you enter a fourth vendor part number for another vendor who
distributes the item. Some vendors refer to vendor part numbers as
article numbers or product IDs.

Note:

This vendor part number is used in conjunction with
reconciliation code 4. Therefore, both the part number and
reconciliation code need to be for the same vendor. For
example, if this is a Cooper vendor part number, the Cooper

reconciliation code needs to be entered in the Recon Code 4
field.

Lets you assign a fourth reconciliation code for another vendor. The
reconciliation code is used for tracking national account, government
support, and defect adjustment sales.

Note:

This reconciliation code is used in conjunction with vendor part
number 4. Therefore, both the part number and this
reconciliation code need to be for the same vendor. For
example, if this is the Ccooper reconciliation code, the Cooper
vendor part number needs to be entered in the Vendor Part
Number 4 field.

Lets you define the load index and speed rating for a tire.

Lets you define a tire’s Uniform Tire Quality Grade rating.

Note:

For TireMaster systems that are not integrated with Tire
Brands, the values in this field are displayed with product
information at the top of the page on good, better, best
(comparison) quotes after the label Wear. For more
information, see "Good, Better, Best Quotes" on page 472.

Lets you define the load range for a tire.

Lets you define the sidewall style for a tire.

Lets you define the treadlife warranty for a tire.

Note:

For TireMaster systems that are not integrated with Tire
Brands, the value in this field is displayed with product
information at the top of the page on good, better, best
(comparison) quotes after the label Miles. For more
information, see "Good, Better, Best Quotes" on page 472.

Lets you enter a core inventory item you want to associate to the item.
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fom _Desetpten

Bolt1 Lets you enter the primary bolt pattern for a wheel in either metric or US
standard measurements.

Bolt2 Lets you show an alternative measurement or a secondary bolt pattern
for a wheel.

Lugs Lets you enter the number of lug nuts for a wheel.

Width Lets you enter the width of a wheel.

Offset Lets you enter the offset for a wheel.

Weight Lets you set a minimum weight requirement for the item.

Add-On/Kit Code

Mfg Code

Taxable: Parts

Taxable: Labor

Lets you assign a group of add-on items that will be included on
invoices when the item is sold.

Lets you enter the item’s manufacturer.

Lets you define whether to collect sales tax for the item’s parts price,
except for tax-exempt customers.

Lets you define whether to collect sales tax for the item’s labor price,
except for tax-exempt customers.

Category Lets you assign an inventory category to the item.

GL Lets you assign a general ledger code to the item. If you're running a
TireMaster Point of Sale system, use one of the preset GL codes.

Find Lets you search for an item.

Add Lets you add a new item to the inventory.

Edit Lets you change the selected item’s settings.

Delete Lets you delete the selected item if it has never been used in a
transaction.

Cancel Lets you exit the screen without saving changes in add or edit mode.

OK Lets you save changes and exit the screen in add or edit mode.

Close Lets you exit the screen when you are not in add or edit mode.

QTY/PRICING TAB

The Qty/Pricing tab (Figure 10-5) displays information about an item’s quantities and prices. To
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update an item’s stocking quantities, prices, and cost settings, click Detail/Edit.

Note: The available quantity is the total of the item’s quantity on hand and the quantity not priced.

Tip:  Toview addition information about an item, press =] repeatedly.

Inventory Maintenance (12300)

General Qt].rfF'ricingl Historyl MNotes ]

Sited#: Part#: Description : Product Code : Size
|1 3957 |RS-AEAGLE : 732804500 : P235/70R16/SL

Site Location | Available I Best OnHand UnPriced Oon'wo On Order EDL
8.00 212.42 8.00 0.00 0.00 0.00 21242
b

AAELLLLALDALLLLLLSALSSSLLLSLSSSSOSSLSSESSSSSSOSSSLSSSSSSOHLSSSSSSSSSSSLS

z'rv"'v"""v"'v"""'v"'v"'v"""v"'v' YV T TP T T T T T T YT T T YT T T T TR

DetaillEdit

Figure 10-5: Inventory Maintenance Screen Qty/Pricing Tab

HISTORY TAB

The History tab (Figure 10-6) shows an item’s sales and receiving history. It also shows whether an

item is currently on any work orders:

= Select Sales History for a list of both sale and return invoices. The sales history shows how

much you previously charged customers for the item.

= Select Receiving History for a list of vendor invoice documents (VIDs) created when the item
was priced. The receiving history shows what you paid a vendor when you previously bought

the item.

= Select Work Orders to see whether the item is currently on any work orders.

You can control how many historical documents (also referred to as records) are displayed on the
screen by selecting one of the radio buttons in the lower-right corner of the screen. For a duplicate
copy of a document, select the line for it and click Reprint. To see how a transaction posted to the

general ledger, select the line for it and click Research.
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Inventory Maintenance (12300)

General |OtyfF'ricing History | Motes |

Site#.  Part# Description : Product Code : Size
1 [3957 |RS-AEAGLE : 732804500 : P235/70R16/SL
Date Site | Mod | Invoice Customer Qty Parts Labaor FET Line

0227M9 [1 | [188  |cCagneyCourier 21242 0.00| 000

0227119 1 200 Turner, Johnny &Anne 400 21242 0.00 000 1
02/27119 |1 203 Walker, Dan 400 21242 000 0.00 1
02/2719 1 184 Cagney Courier 400 21242 000 000 1

BB DDDBDDDDDLDEDDDDLDEDEDLEDDEDDDBDDDDLDDDDDSDDDELLLL5580F

wmwvmmm-

Document Types: Mumber of Documents:
+ Sales History = Receiving History =~ Work Orders | | * 40 {120 i Al |
Invoice Description: RS-AEAGLE Reprint | Research |

Figure 10-6: Inventory Maintenance Screen History Tab

T

Site#

Part#
Description

Date

Site

Displays the number for the site where the item was added to the
inventory. In TireMaster Point of Sale and TireMaster Plus, this number
is always 1.

Displays the item’s system-assigned part number.
Displays the item’s description, product code, and size.

Displays one of the following:
= The date the invoice was completed (sales history view)

= The date the vendor invoice document (VID) was completed
(receiving history view)

=  The date the item was added to a work order (work order history
view)
Displays one of the following:

= The number for the site where the invoice was completed (sales
history view)

= The number for the site where the vendor invoice document was
completed (receiving history view)

= The number for the site where the item was added to a work order
(work order history view)

In TireMaster Point of Sale and TireMaster Plus, this number is always
1.
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fom _ Joeeetetor

Mod

Invoice

VID#

Customer

Vendor

Qty

Parts

Price

Labor

FET

Line

Document Type:

Sales History

Document Type:

Receiving
History

Document Type:

214

Displays the code that identifies the document type. For normal sales,
returns, and trade-ins, this field is blank (sales and work order history
views). For more information, see "Document Type Codes" on

page 1153.

Displays the invoice number or work order number (when viewing sales
and work order history).

Displays the document number for the vendor invoice document (when
viewing receiving history).

Displays the name of the customer who purchased or is going to
purchase the item (when viewing sales and work order history).

Displays the name of the vendor who sold you the item (when viewing
receiving history).

Displays the quantity sold, received, or placed on work order.

Displays the parts price for each item sold or placed on work order
(when viewing sales and work order history).

Displays your cost for each item (when viewing receiving history).

Displays the labor price for each item sold or placed on work order
(when viewing sales and work order history).
Displays one of the following:

= The federal excise tax for each item sold (sales history view)

= The federal excise tax charged to you when the item was received
(when viewing receiving history)

=  The federal excise tax for each item on work order (when viewing
work order history)

Identifies the line where the item appears on the invoice, vendor invoice
document, or work order.

Lets you view the item’s sales history.

Lets you view the item’s receiving history.

Lets you see a list of work orders that the item is assigned to.
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fom  Joeeetptor

On Work Order

Number of

Documents: First

radio button
(lower-right
corner)

Number of
Documents:
Second radio
button (lower-
right corner)

Number of
Documents: All

Reprint

Research

NOTES TAB

The Notes tab provides a space for including information, such as warranty disclaimers, in an item’s
inventory record. Notes entered on this screen print on work orders and invoices.

Lets you limit the number of historical documents or work orders
displayed to the number shown.

Note: To define the number of documents displayed when selecting
this radio button, set the System Control Grid Control - Limit
1. For more information, see "Grid Control - Limit 1" on
page 1137.

Lets you limit the number of historical documents or work orders
displayed to the number shown.

Note: To define the number of documents displayed when selecting

this radio button, set the System Control Grid Control - Limit
2. For more information, see "Grid Control - Limit 2" on
page 1137.

Let you display all historical documents or work orders.

Lets you reprint the selected invoice or vendor invoice document (when
viewing sales and receiving history)

Lets you view journal entries generated when the selected item was sold
or received (when viewing sales and receiving history).

Note: Journal entries can be researched only in the TireMaster Plus
and TireMaster Corporate systems.

You can also use the Notes tab to link an item to a web site or a file, such as a product specifications
sheet or a photo, that’s stored on your computer or network.

To add a note to an item, click Edit Note and type the text for your note. To save the note, click

OK.

To link an item to a Web site, click Edit Note and type the web site’s URL in the External
Specifications field. Then click OK.

To link an item to a file on your computer or network, click Edit Note and type the path and file
name (such as c:\tirephotos\Cooper\trendsetter or
\\Imynetwork\specsheets\Goodyear\Wrangler.
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INVENTORY SEARCHES

When looking up items, you can use various search options—referred to as prompts in TireMaster—
to narrow your search and control how the items you find are displayed on the Inventory List.

SEARCH WITH QUICK LOOK CODES

A quick look code can be any combination of numbers or letters that’s easy to remember. Many
dealers use quick look codes as a way to look up tire sizes without having to type slashes or letters.
Searching with quick look codes is helpful at point of sale.

To
1.

216

search with quick look codes

Select Inventory > Maintenance. TireMaster prompts you to search for an item.

Inventory
Maintenance
PO 8 Receiving
Suggested Reorder & PO
Oty Adjustrment Wizard

List Editing

LAAASALLLSSSSLSSSSSSSS

Tip: Toreuse the codes from a previous search, click Past Lookups and make a selection
from the drop-down list.

Click the tab you want to use for the search.

In the 3-Quick Look row, click the Start field and type a full or partial quick look code.

Customn Inventory Lookup (8100)

Past Lookups: |
1P0S | 2 Receiving | 3 Fricing | 4 Editing | 5 0th

PN P P PN

Prormpt Start g
- Quick Look: 2150516 M
Description:

-l Rm%ﬂw;&a AAAAAAAAAAAAAA r

Tip:  Clicking Clear removes the quick look code from the screen.

To use different sort codes for the search, type the letters or numbers for the codes in the Sort
field.

it i diedidihediiodiediodiediodhodidiodhdhdhdiodhdbdiedidiodh i I

Sark: GBE*S:Size M=MFG P=FrodCode O=0ty B=Best E=EDL 4=Spiff
F=Rim C=Cat G=MiscSont V=VendPatd 3=QuicklLook

v Activelterns Only [ Include Discontinued tems [ Descending

Clear Ok | Lancel |

Note: You can use up to four of the sort codes displayed to the right of the Sort field. When a
sort code cannot be used to perform a task or organize information on a report, it's
disabled.
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5. Select or the following check boxes as needed:

= Toinclude active items in the search, make sure the Active Items Only check box is
selected.

" Toinclude discontinued items in the search, make sure the Include Discontinued Items
check box is selected.

= Todisplay the items from the highest to lowest order on the Inventory List, select the
Descending check box.

PP ITITIITITITTTTTTTTTT T T T T T T T

Sot[ggg  9=Size M=MFG P=ProdCode O=Oty B=Best E=EDL 4=Spiff

R=Rim C=Cat G=MiscSot “Y=VendPart# 3=QuickLook

| v Active ltemsz Only [ Include Discontinued ltems v

Clear ok | LCancel |

Note: Because TireMaster is designed to always display quantities from highest to lowest,
the Descending check box is disabled when the letter Qs the only code entered in

the Sort field.

6. Click OK. The Inventory List opens.

VT TETEETETeY

de =0ty B=Best E=EDL 4=Spiff
t W=VendPartt  3=OuickLook

»
Jantinued ltems v
»

ak Lancel

7. Selectan item and click OK.

Y'Y

Note: To see available and on-order quantities for another site, click Other Site.

SEARCH BY MANUFACTURER

You can narrow your search to items that are made by a particular manufacturer. This method of

searching for items is helpful when you create purchase orders.

To search for items by manufacturer

1. Select Inventory > Maintenance. TireMaster prompts you to search for an item.

Inventory
Maintenance
PO & Receiving
Suggested Reorder & PO
Oty Adjustrnent Wizard

List Editing

B B A A A A A A A S

Tip: Toreuse the codes from a previous search, click Past Lookups and make a selection

from the drop-down.
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2. Click the tab you want to use for the search.

3. Inthe Manufacturer row, click in the Start field and press [z]. Then select the manufacturer code
from the list that appears and click OK.

Customn Inventory Lookup (8100)

Past Lookups: |

1POS | 2 Receiving | 3 Pricing | 4 Editing | & Other |

m

Ah A A AN AA M &as sl

Frompt Start |
3 - Quick Look:
Dezcription:

Product Code Range:
Gty Min:

M arufacturer: A/

.mVABRtWAAAAAAAAAAAAAAAAAAAAAJ

Tip:  Clicking Clear removes the manufacturer code from the screen.

4. If you want to use different sort codes for the search, type the letters or numbers for the codes in
the Sort field.

/vﬁt'm""""""""'v"v"""v"' Ty yyyp
y Min:

t anufacturer: ERI

Inventony:

Group:

Category Hange:

Size Range:

Rirn Size:

Sort: Sr 5=5ize M=MFG P=ProdCode O=Oty B=Best E=EDL 4=Spiff
R=Rim C=Cat G=MiscSon W=VendPath 3=NuickLook

v Activeltems Only [ Include Discontinued ltems [~ Descending

Clear ok Lancel |

Note: You can use up to four of the sort codes displayed to the right of the Sort field. When a
sort code cannot be used to perform a task or organize information on a report, it's
disabled.

5. Do one or more of the following as needed:

=  Toinclude active items in the search, make sure the Active Items Only check box is
selected.

" Toinclude discontinued items in the search, make sure the Include Discontinued Items
check box is selected.

= Todisplay the items from the highest to lowest order on the Inventory List, select the
Descending check box.
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Sart [gp 5=5Size M=MFG P=ProdCode O=0ty B=Best E=EDL 4=Spiff
R=Rim C=Cat G=MiscSart “=VendPath 3=lluickLook

I v &ctivelterns Only v Include Discontinued ltems [ Descending I

Clear ok | LCancel |

Note: Because TireMaster is designed to always display quantities from highest to lowest,
the Descending check box is disabled when the letter Q is the only code entered in
the Sort field.

6. Click OK. The Inventory List opens.

e Q=0ty B=Best E=EDL 4=Spiff
t W=WendPartt  3=QuickLook

|Nae

ntinued lters | Descending

I Ok I Lancel

7. Selectanitem, and click OK.

FYYYTYYEY

Note: To see available and on-order quantities for another site, click Other Site.

SEARCH FOR A RANGE OF ITEMS

With some prompts, you can look for a range of items. For example, you can search for all of the
items that fall within a particular product code range. Using a range lets you narrow your search. The
prompts that you can use to search for a range of items have active (white or yellow) fields in the End
column of the Custom Inventory Lookup screen.

To search for a range of items

1. Select Inventory > Maintenance. TireMaster prompts you to search for an item.

Inventory
Maintenance I}
PO & Receiving
Suggested Reorder & PO
City Adjustment Wizard

List Editing

B A A A A A A

Tip: Toreuse the codes from a previous search, click Past Lookups and make a selection
from the drop-down.

Click the tab you want to use for the search.
Define the beginning and end of the range:

a. Click the Start field for the row you’re using and type a code, number, letter, or description.
For group and category ranges, click [r]and make a selection from the list that appears.
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Note: You can use both full and partial entries for the following search options to look up a
range of items: quick look code, product code, group, category range, size range,
vendor part number range, bolt pattern, wheel width, wheel offset, and the number of
lug nuts.

b. Click the End field for the same row and type a code, number, letter, or description. For
category and size ranges, click [v]and make a selection from the list that appears.

Custom Inventory Leckup (8100)

Past Lookups: | ﬂ
1P03 | 2 Recelving | 2 Fricing | 4 Editing | 5 Other |

Frompt Start |End |
3 - Quick Look:
Description:

Product Code Range: _|013000 4 toaan0 A

aQmM'ﬂEAAAAAAAA.LAAAAA‘A‘AAAA AAASSSSLELSSS

>

Tip:  Clicking Clear removes the codes from the screen.

4. If you want to use different sort codes for the search, type the letters or numbers for the codes in
the Sort field.

it ittt thoiie it it i it dh e

Sort: [pop#K 5=5ize M=tFG P=ProdCode G=Gty B=Best E=EDL 4=Spiff
R=Rim C=Cat G=MiscSorn W=VendPath 3=lluickLook

v dctivelternz Only [ Include Discontinued ltems [ Descending

Clear oK | Lancel |

Note: You can use up to four of the sort codes displayed to the right of the Sort field. When a

sort code cannot be used to perform a task or organize information on a report, it's
disabled.

5. Select or clear the following check boxes as needed:

® Toinclude active items in the search, make sure the Active Items Only check box is
selected.

=  Toinclude discontinued items in the search, make sure the Include Discontinued Items
check box is selected.

= Todisplay the items from the highest to lowest order on the Inventory List, select the
Descending check box.

et Dot ettt e et it el

Sort: S=Size M=MFG P=ProdCode GQ=Qty B=Best E=EDL 4=Spiff
- PSB B=Rim C=Cat G=MizcSot Y="endPartf 3Z=[uicklook

| v Activeltems Only v Jn [ Descending I

Clear ok | Lancel |

Note: Because TireMaster is designed to always display quantities from highest to lowest,
the Descending check box is disabled when the letter Q is the only code entered in
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the Sort field.

6. Click OK. The Inventory List opens.

;vvvvvvvvvvvvwvvvv

de O=0ty B=Best E=EDL 4=Spiff
t W=VendPartt  3=OuickLook

[~ Descending

LCancel |

7. Selectanitem, and click OK.
Note: To see available and on-order quantities for another site, click Other Site.

SEARCH WITH BAR CODES

You can look up an item by scanning its bar code or typing its bar code on the Custom Inventory
Lookup screen.

Note: Up to three different bar codes can be assigned to a single item.

To search for items with bar codes
1. Select Maintenance from the Inventory menu. The Custom Inventory Lookup screen appears.

Inventory
Maintenance
PO & Receiving
Suggested Reorder & PO
Oty Adjustment Wizard
List Editing

LAALALLLLSSSSLDDSSSSSS

Click the tab you want to use for the search.

In the 6-Bar Code row, click the Start field. Then scan the item’s bar code or type the numbers
in the item’s bar code.

Customn Inventory Lookup (8100)

Past Lookups: |

Frompt Start | E

I anufacturer:

B - Bar Code: sareosots A
Note: You can also type a partial bar code. In this scenario, TireMaster retrieves all items
whose bar codes include the sequence of numbers you typed.

4
<
;
1P0S  2Recelving | 3 Pricing | 4Editing| 5 Other | £
A
f
R
4
4
4
4

4. Click OK. The Inventory List appears.
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T VT TVTVOEwwwwew

e =0ty B=Best E=EDL 4=Spiff
b WVendPatl  3=Ouicklook

o d

ntinued ltems [ Descending

I ok I Lancel

5. Toopen the item’srecord, click OK.

b

Note: To see available and on-order quantities for another site, click Other Site.

SEARCH FOR STAGGERED FITMENT TIRES

When you need to look up tires for a vehicle that accepts staggered fitments, use the Split Look
option to define the differing front and rear tire sizes. The Split Look option allows you to search with
two different quick look codes.

To search for staggered fitment tires

1. Select Inventory > Maintenance. TireMaster prompts you to search for an item.

Inventory
Maintenance I}
PO & Receiving
Suggested Reorder 8 PO
Oty Adjustrment Wizard

List Editing

LAAAAALALLSSSLSSLSSSSS

Click the tab you want to use for the search.

In the Split Look row, click the Start field and type the quick look code (typically the size without
letters or slashes) for the first size you need to find.

Custom Inventory Lookup (8100)

4
Past Lookups: | :
1POS | 2 Recsiving | 3Pricing | 4 Editing | 5 Other | &

3 - Quick Look:
Spit Look: 2454020 &

P RBEQ'R'R”AAAAAAA LBAASSSSH 58 500

Note: Itdoesn’t matter if the front or rear size is used first.

4
Frompt Start |E]
<
4
£
4

4. Inthe Split Look row, click the End field and type the quick look code for the second size you
need to find.
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Past Lookups: I ;I
1POS | 2 Receiving | & Priving | 4 Ediing | 5 Other |

Frampt Start I End I

3 - Quick Loaok:

Split Look: 2454020 2?53520‘/
saAREsgiption] | ol ssssssssssssssna POV VN

5. Tonarrow down the search, do the following as needed:

6.

7.

8.

= Click in the Start field for the Description row and type a full or partial description.

Pazt Lookups: I :
4
1P03 | 2Receiving | 3 Pricing | 4 Editing | 5 Othes
4

Frompt Start
3 - Quick Look: :
Split Look: 2454020 4
4
Deseisilen POTENZ A :
SET 0y ARgE; 4

= Click in the Start field for the Manufacturer row and press . Then select the manufacturer
code from the list that appears and click OK.

Product Code R ange:
Gty Mir:

Manufacturer: BRI "/

[/ AR R,

Past Lookups: I :
1P0OS | 2 Receiving | 3 Pricing | 4 Editing | 5 Othel
Prormpt Start b
3 - Quick Look: :
Split Loak: 2454020 :
Description: r
P

L

L

o

<

L

L

Click OK. The Inventory List appears.

3

»
[de =0ty B=Best E=EDL 4=Spiff
ot W=WendPat  3=QuickLook

3
ertinued ltems [ Descending |
>

13
: o |

Note: If you don’t define the description, manufacturer, or both, sort the Inventory List by
description or manufacturer to simplify finding the same kind of tire in both sizes.

Select an item, and click OK.

Note: To see available and on-order quantities for another site, click Other Site.

To access the information about the other tire for the staggered fitment, click the Prev or Next
buttons as needed.

223



User Guide

SEARCH WITH MULTIPLE CODES

For some searches, you can use more than one code to look for items. For example, you can search
for all Goodyear tires that fall within a particular size range.

To
1.

224

search for items using multiple codes

Select Inventory > Maintenance. TireMaster prompts you to search for an item.

Inventory
Maintenance I}
PO & Receiving
Suggested Reorder 8 PO
Oty Adjustrment Wizard

List Editing
b bbb bddddsdddsdsdddsdd

Tip: Toreuse the codes from a previous search, click Past Lookups and make a selection
from the drop-down.

Click the tab you want to use for the search.

Click the Start field for the first row you’re using, and type a code. For manufacturers, groups,
and categories, you can click [v]and select a code from a list. If the row can be used to search by
range, you can also enter a code in the End field.

Custom Inventery Lookup (8100)

Past Lookups: | :
1P0S | 2 Receiving | 3Pricina | 4 Editing | 5 Othe
4

Frompt Start 4

3 - Quick Look: 2355018 1

L Split Lgok: 4

Repeat step 3 for the additional codes that you’re using for the search.

Custom Inventory Lookup (8100)

Past Lookups: | :
1P0S ] 2 Receiving | 3 Pricing | 4 Editing | 5 Dtha
Prompt Start b

3 - Quick Look: 2355018 }
Split Look: 4
Description: EAGLE A’/ :-
Froduct Code Range: :
Gty Min: :

M arf acturer: GDY "/ :’
Iventony s ssaahansssssss and

Tip:  Clicking Clear removes the codes from the screen.

If you want to use different sort codes for the search, type the letter or number for the codes in the
Sort field.



Custom Inventory Lookup Screen

et ittt e et e e e e

Sort [gE 5=5Size M=MFG P=ProdCode O=0ty B=Best E=EDL 4=Spiff
R=Rim C=Cat G=MiscSart “=VendPath 3=lluickLook

v activelterns Only [ Include Discontinued ltems [ Descending

Clear ok | LCancel |

Note: You can use up to four of the sort codes displayed to the right of the Sort field. When a

sort code cannot be used to perform a task or organize information on a report, it's
disabled.

6. Select or clear the following check boxes as needed:

® Toinclude active items in the search, make sure the Active Items Only check box is
selected.

=  Toinclude discontinued items in the search, make sure the Include Discontinued Items
check box is selected.

= Todisplay the items from the highest to lowest order on the Inventory List, select the
Descending check box.

it it e e e e e et

Sort: 5=Size M=MFG P=ProdCode Q=0ty B=Best E=EDL 4=Spiff
- ue B=Rim C=Cat G=MizcSort V=¥endPartf 3Z=[LuicklLook

I v &ctivelterns Only [ Include Discontinued ltems [ Descending I

Clear oK | LCanecel |

Note: Because TireMaster is designed to always display quantities from highest to lowest,

the Descending check box is disabled when the letter Q is the only code entered in
the Sort field.

7. Click OK. The Inventory List appears.
;"VVVVVVVVVV'VVVf"

de O=Oty B=Best E=EDL 4=Spiff
ot YaendPartt  3=QuicklLook

»
yortinued ltems [ Descending
»

>
: I ok I LCanecel

8. Selectan item, and click OK.

v

Note: To see available and on-order quantities for another site, click Other Site.

CUSTOM INVENTORY LOOKUP SCREEN

The Custom Inventory Lookup screen is used to find inventory items in the TireMaster database. You
define the requirements for inventory searches by entering one or more codes in the fields on the
Custom Inventory Lookup screen. The screen also has five tabs that you can customize for various
circumstances in which you look up items.
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CUSTOM INVENTORY LOOKUP SCREEN PROPERTIES

The Custom Inventory Lookup screen (Figure 10-7) includes a set of customizable tabs and settings
that affect the way in which items retrieved by a search are displayed. For information about the tabs,
see "Configure the Custom Inventory Lookup Screen" on page 228.

Custom Inventory Lookup (8100)

Past Lookups: I

1 Standard | 2 Rieceiving | 2 Pricing | 4 Ediing | 5 Other |

=

Prormpt

Start

3 - Quick Look:

|End |

Description:

Product Code Range:

Gty Min:

M arufacturer:

Inventon:

Group:

Category Range:

Size Range:

Rim Sizex

Eo[tngB S=Size M=MFG P=ProdCode O=0ty B=Best E=EDL 4=Spiff:
F=Fim C=Cat G=MiscSaort Y=\endPart#t 3=Quicklook |

¥ Active ltems Only [~ Include Discontinued Itemz [~ Descending |

Clear

Lancel J

Figure 10-7: Custom Inventory Lookup Screen

R

Past Lookups

Prompt

Start

End
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Lets you select the codes used for a previous search from a drop-down

and reuse them in a new search.

Displays the names of the search options for the selected tab. The
search options are actually various settings assigned to items, including
size, product code, and bar code.

Lets you type a code, number, letter, or description to use for searches:

When searching for a range of items, set the beginning of the
range in this column.

When searching by manufacturer, group, and category, click[z]
and make a selection from a list.

When using the Split Look option to search for staggered
fitments, type one size in this column and the other size in the
End column.

Lets you type the code, number, letter, or description for the end of a



Custom Inventory Lookup Screen

fom fpeetpten

Sort

Active Items Only

Include
Discontinued
Items

Descending

Name

Clear

OK

range of items:

=  When searching for a range of items, set the end of the range in
this column (for search options that can be used to look up a
range of items).

= When searching by group and category, click[z] and make a
selection from a list.

=  When using the Split Look search option to find staggered
fitments, type one size in the Start column and the other size in
this column.

Lets you set the order for displaying items retrieved by a search on the
Inventory List. The first code is the primary sorting method, the second
code is the secondary sorting method, and so on. For example, if the
primary sort order is rim size, all items with the same rim size will be
sorted by the secondary sort order instead.

Note: You can enter up to four sort codes. When a sort code cannot
be used to perform a task or organize information on a report,
it’s disabled.

Lets you include active items in the search.

Lets you include discontinued items in the search.

Lets you display the items retrieved by the search from the highest to
lowest. The items that match the primary sort order will be displayed in
descending order first followed by those matching the secondary sort
order, and so on.

Note: Because TireMaster is designed to always display quantities on
the Inventory List from highest to lowest, this check box is

disabled when the letter Qis the only code entered in the Sort
field.

Lets you change the name of the selected tab.

Note: This button is visible only when accessing the Custom Inventory
Lookup screen from the Setup menu.

Removes codes that have been entered in the Start and End columns.

Functions in one of the following ways:

® From the Inventory menu, begins the search for items.
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fom fpeetpten

=  From the Setup menu, saves changes to the screen.

Cancel Functions in one of the following ways:
= From the Inventory menu, lets you stop the search for items.

= From the Setup menu, lets you cancel changes to the screen.

CONFIGURE THE CUSTOM INVENTORY LOOKUP SCREEN

The TireMaster startup database includes the following tabs: Standard, Receiving, Pricing,
Editing, and Other. You can tailor each tab for the various tasks in which you search for items. For
example, you can set up one tab for point of sale and another for ordering from vendors. The settings
for the Custom Inventory Lookup screen can differ for each workstation.

Note: The settings on the first tab determine how items are retrieved when searching with the

down-arrow lookup method. For more information, see "Down Arrow Lookup Method" on
page 10.

To configure the Custom Inventory Lookup Screen

1. Select Setup > Inventory Lookup. The Custom Inventory Lookup screen opens.

2. Torename atab, click the tab and then click Name. TireMaster prompts you to name for a name.
3. Type the new name for the tab and click OK.

Tip:  To avoid having to scroll right to see the name of tab 5, use short names for all of the tabs.

4. To modify the rows on a tab, click the row you want to change. Then click ~|, and select a search
option from the drop-down.

5. Repeat step 4 until the search options you want to use are listed.

Tip:  To save time at the counter, set up the Custom Inventory Lookup screen so the prompts
are listed in order of importance for each task. For example, you could list the Size
Range prompt first for a point of sale tab, while Product Code Range could be used
first a tab for receiving inventory.

6. Using the codes to the right of the Sort field, type the sort order. For example, to sort by rim size,
quick look code, and best price, type R3B.

7. Select or clear the following check boxes as needed:
= Toinclude active items in searches by default, select the Active Only check box.

®  Toinclude discontinued items in searches by default, select the Include Discontinued
Items check box.

= Todisplay items from the highest to lowest order by default, select the Descending check
box.
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Note: Descending order is associated with the first code typed in the Sort field (step 6). For
example, if you type in the code BR3, best price will be displayed in descending
order.

8. To setup the remaining tabs, repeat steps 2 through 6.

9. To save the screen configuration, click OK.

ENABLE THE CUSTOM INVENTORY LOOKUP SCREEN

Before you can use the Custom Inventory Lookup screen, you need to enable it in System Controls.

To enable the Custom Inventory Lookup Screen
1. Select Setup > System Controls. The System Controls screen opens.
2. Click the Inventory tab.

3. Scroll down to the Custom Inventory Lookup setting and see if it is set to Yes. If it is not, press
Enter and select Yes.

4. Close the System Controls screen.

THE INVENTORY LIST

The Inventory List displays the items retrieved by inventory searches. This screen includes several
details about retrieved items, including size, description, quantities, and price and cost information.
Because there is much information on the screen, you can make it easier to work with by adjusting
the layout and sorting the columns.

MOVE AND RESIZE INVENTORY LIST COLUMNS

Although you can view various columns on the Inventory List by scrolling, you might prefer to change
the layout by moving and resizing some columns. When you’re done changing column size, position,
or both, you can save the updated layout.

Note: The new layout affects only the workstation on which changes were made. Therefore, the
columns on the Inventory List can be moved and resized differently for each computer.
To move and resize Inventory List columns

1. Search for an item. The Inventory List opens. For more information, see "Inventory Searches" on
page 216.

2. Tomove a column, click the column heading. When the thick, black line appears, drag the
column to a different position.
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Inventory List (2000)

T ) 2 T

336332165 |P2357sR15/52  [TRACKER 2

3. Toresize a column, move the pointer (%) to the boundary line for the column heading. When the
pointer turns into +|*+ drag the boundary to the new width.

Inventory List (2000)

336332165 |F'235!75R1 5152 |TRA!,KER 2

4. When you're done moving and resizing the columns, click Save Layout. The Inventory List
columns will be displayed in the new arrangement until the layout is changed.

Note: The Save Layout button is available only to users who belong to security groups that are
assigned the Save Screen Layout permission.

SORT THE INVENTORY LIST

When you look up items, you can use sort codes to define how they should be organized on the
Inventory List. Once the items have been retrieved, however, you might want to sort the items again.
To sort items retrieved in a search, click one of the column headings on the Inventory List (Figure 10-
8). To change the order from highest to lowest or the other way around, click the heading again.

Inventory List (2000)

_r

312008027 LT235/75R15/6 | DURATRAC WRG

|85672 T235/75R 1515 K2 MUD-TERRAINT/A g gg]

Figure 10-8: Sorting Inventory List Columns

INVENTORY HISTORY

Sales and receiving history is available for inventory items in TireMaster. Sales history lists invoices
created when items were sold or returned, and receiving history includes vendor invoice documents
created when items were priced. When looking at an item’s history, you can also see if the item is
currently on work orders or set aside for upcoming appointments. Item history is can be viewed on
the Inventory Maintenance screen and the Inventory List.

VIEW HISTORY IN AN ITEM'S INVENTORY RECORD

One way to view an item’s history is to retrieve the inventory record for that item. Looking up history in
this manner offers the following advantages:

= You can reprint each of the sale and vendor invoices associated with the item.

= You can view journal entries generated when the item was sold or received.
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= You can see the description included on each of the sale and vendor invoices associated with
the item.

Note: For noninventoriable items, these descriptions can vary.

To view an item’s history in its inventory record

1. Select Inventory > Maintenance. TireMaster prompts you to search for an item.

Inventory
Maintenance I}
PO & Receiving
Suggested Reorder & PO
Oty Adjustment Wizard

List Editing

LAALAALLLLASSLLSSSSSSS

2. Search for the item whose history you want to view. For more information, see "Inventory
Searches" on page 216.

3. Onthe Inventory Maintenance screen, click the History tab.

Inventory Maintenance (12300)

General IQTy:'F'ricingl History l Motes l

Product Code: |732804500
Size: |P23570R16/5L

4
4
4
4
4
4
4
4
4
4

s Desciintion: | JRSABAGLE .. .a
4. Select Sales History, Receiving History, or Work Orders.

T T T T T T T T T T T T T T T T T T T YT T T YT T T T T

Document Types:

fo Sales History i Receiving History " Work Orders

Invoice Description: RS-AEAGLE

b b b b b b b

Note: Work order history includes items that have been set aside for scheduled appointments.
The document type code SAis assigned to those items. If an appointment expires without
becoming a completed invoice, the item’s appointment quantity will continue to affect the
quantity on work order until the appointment is deleted.

5. To define the maximum number of documents displayed, select one of the radio buttons in the
lower-right corner of the screen.

.

VPPV T VTV TITT T T TTT T T

Mumber of Documeants:

* 40 120 " All

Reprint | Resegrch|

i e

Note: The numbers assigned to the first two buttons are defined by a pair of system controls.
For more information, see "Grid Control - Limit 1" on page 1137 and "Grid Control - Limit
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2" on page 1137.

6. Selectadocument.

Inventory Maintenance (12300)

General latyrF‘ricing History I Motes l

FYwyYweY

Site#: Part#: Description : Product Code : Size

|1 |3957 |RS-AEAGLE : 732804500 : P235/70R1
4

Date | Site | Mod| Invoice | Customer 4

02/27M19 1 188 CAGMNEY COURIER 4

7. Toview and reprint the selected document (for sales history and receiving history only), click
Reprint.

GVV\

ocuments:

120 Al

| Reprint I Resegrch|

In some instances, the following occurs:

o el e

= |fboth a purchase order and a vendor invoice document were created for the item,
TireMaster prompts you to select which document to print (receiving history only).

= |fthe item was returned to a vendor, TireMaster prompts you to define whether you want to
print the vendor invoice document or inventory return document (receiving history only).

8. Toview journal entries generated when the item was sold or received, click Research.

ocuments:

120 " All

Reprint | I Research I

’VVVVVVVV&VV\

VIEW HISTORY FROM THE INVENTORY LIST

You can access an item’s history from the Inventory List. Therefore, you can look at the item's
historical details as you’re placing it on a work order, quote, purchase order, or receiving document.
With this method of viewing an item's history, you can see the following:

=  How much you previously charged customers for the item
= What you paid a vendor when you bought the item
=  The work orders and appointments to which the item is assigned

Note: To view the cost and federal excise tax in an item’s receiving history, you need to be assigned
the Inventory View/Edit Cost permission.
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To view an item’s history from the Inventory List

1.

Search for an item as a standalone operation or as part of a another task. For more information,
see "Inventory Searches" on page 216.

When the Inventory List opens, select the item and click History. The Inventory History screen
opens.

Inventory List (2000)

Prod Code Size Description H
732127500 P225/55R16/SL RS-A EAGLE }
732354500 P225/60R16/SL RS-AP EAGLE :
7324915 05(50R17IS -A EA 4
D E: Best Price: SE‘IE.:‘Q2

History‘T/ListEdit| Quots | specs §

Select Sales History, Receiving History, or Work Orders.

T

I(i“ Sales History ¢ Beceiving Histary & 'work Drdersl %

Mumber of Documents: o 40 120 i Al i

Note: Work order history includes items that have been set aside for scheduled appointments.
The document type code SAis assigned to those items. If an appointment expires without
becoming a completed invoice, the item’s appointment quantity will continue to affect the
quantity on work order until the appointment is deleted.

To define the maximum number of historical documents or work orders displayed, select one of
the radio buttons (bottom left).
Close the Inventory History screen.

On the Inventory List, select an item and continue the task you initially started.

OMPHYSICAL COUNTS

Taking a physical count is a multi-step process. Itincludes generating a list of items, counting the
items, and making adjustments when there are discrepancies between the number of items counted
and the number of items in TireMaster.

PRINT AN INVENTORY COUNTING DECK

A counting deck is a list of items from your TireMaster system. When you take inventory, you can
print one large counting deck or you might find it easier to generate separate lists for groups of items,
such as those from a specific manufacturer or product line.
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Whether you include quantities on your counting deck depends on who will use it. For control clerks,
you might want to include on-hand quantities so they can compare the physical count to the system
count. For counters, ASA recommends excluding on-hand quantities.

Note: The following instructions describe printing a counting deck from the Quantity Adjustment
Wizard. For instructions on printing it from the Report List, see "Inventory Counting Deck" on
page 926 or "Inventory Counting Deck w/ QTY" on page 927.

To print a counting deck

1. SelectInventory > Qty Adjustment Wizard. The Qty Adjustment Wizard opens.

Inventory
Maintenance
PO & Receiving
Suggested Reorder & PO
Cty Adjustment Wizard L\\)

List Editing

LAAAAAAALLSSALLSSDSSSS

2. Make sure the Select Items tab is selected.

3. Click Select Items and look up the items you want to count. TireMaster displays the number of
items retrieved by the search in the Number of Items Selected field. For more information, see
"Inventory Searches" on page 216.

City Adjustrment Wizard (11500)

Select tems | Upaate Quantites |

Lookup items you want to count. I Select [tems I

Number of ltems Selected. 0

BBALLSSSSLLDSDDDDSDDDDSDDSDDDDDDSDDDSDDDDSDDDDD

Note: Look up only the items that you can count before the store opens for business.
Otherwise, the count will be off for any items that are sold or put on work orders.

A i b A e A

Tip:  Write down the range and sort order used for the counting deck. If you need to adjust
inventory quantities, you'll be able to listitems on the screen in the same order as the
printed report.

4. Click Inventory Counting Deck. TireMaster prompts you to print on-hand quantities.
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Cty Adjustment Wizard (11500)

Select ltems l Update Quantities ]

Lookup items you want to count. | Select [tems

Mumber of ltems Selected. 49

Print a list of the selected items,
and count them. I Inventary Counting Deck I

FE VYV YV YV TSI VTV TT e ew

SOALSSLLLLDSDDLDSDDDDSDDDDDDDDSDDDDSDDDDDDSSSDSS S

5. Depending on whether you want to include on-hand quantities, click Yes or No. The Report
Window opens.

Print the counting deck and close the Report Window.
To print a counting deck for an additional group of items, repeat steps 3 through 6.

To exit the Qty Adjustment Wizard screen, click Cancel.

S A d A A A s A A A s b s A s

YN Y Y YT Y YY

Mext ==

| Cancel I

9. When the confirmation message appears, click Yes to cancel the wizard.

COUNT THE ITEMS

The second part of taking inventory is the physical count, the step in which you count items to see
how many you actually have. An item’s actual count includes the following:

=  The number of items received into inventory (both priced or not priced)
=  The number of items on work orders and in the shop

=  The number of the items on work orders but not in the shop (for example, items that have been
loaded on a service truck)

Note: Ifanitem is still in the shop, but it has already been paid for, do not include it in the physical
count.
To count the items

1. Starting with the first item on the counting deck, count the number of units, and write down the
actual quantity.

Note: The actual countincludes items on work order (both mounted and not mounted) and
items not on work order. These items can be either in the shop or at another location. If
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an item is still in the shop but has already been paid for, do not include it in the physical
count.

Tip:  Ifyouincluded quantities on the counting deck, remember that the number in the On
W/O column is included in the Quantity column.

Repeat step 1 for each remaining item.

Go through the counting deck and circle any items whose system quantity does not match your
count. You need to make a quantity adjustment for these items before you resume business.

ADJUST INVENTORY QUANTITIES

If the number of items from the physical count don’t match the system generated countin TireMaster,
adjust the quantities with the Inventory Quantity Adjustment Wizard. When an adjustment is
performed, the updated on-hand quantity is difference between the physical count and the quantity
on work order.

Note: ASArecommends printing an Inventory Checkup Report before making quantity
adjustments. If the report identifies discrepancies between the system-generated inventory

quantities and the sales, receiving, and adjustment activity for items, contact TireMaster
Support.

Warning: The Inventory Quantity Adjustment Wizard is only to be used during the process of taking
inventory or on other occasions when an item’s quantities need to be changed. Do not
use it to enter start-up quantities, return items to vendors, correct purchase orders, or set

up consignment items. Doing so permanently invalidates the system-calculated cost for
each item.

To adjust inventory quantities

1. SelectInventory > Qty Adjustment Wizard. The Qty Adjustment Wizard opens.

Inventory

Maintenance

BAA A S A A A A A A S A LSS A S

b B A A A A b a sl Al b s 8

List Editing

Pricing Wizard
Spreadsheet Updates
Color & 5piff Codes

BAA A S A A A A A S S A AL

Note: Inventory quantities must be adjusted after taking the physical count, but before you
receive items and sell items. Otherwise the adjustment will not correct the item’s on-hand
quantity.

Make sure the Select Items tab is selected.

Click Select Items and look up the items or a group of items that were counted. For more
information, see "Inventory Searches" on page 216.
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Select ltems | Update Quantities

Lookup items you want to count.

Mumber of ltems Selected.

Select ltems

—

omPhysical Counts

Tip:  Look up the items with the range and sort order that were used for printing the counting
deck. Using the same search parameters helps to ensure that product codes and
descriptions will be listed on the screen in the same order as the counting deck.

4. Click Nextto move to the Update Quantities tab.

El MNext == I Cancel |

5. Ifanitem’s system-generated count differs from the actual count, type its actual count and press
Enter. The item’s row turns blue.

Oty Adjustment Wizard (11500)

Select tems  Update Quantities I Uit iy |
ProdCode Size Description Actual Count | ~
732170500 P205/55R16/52 RS-AEAGLE 1.0000
732401500 195/60R15/5L RS-AEAGLE 0.0000
732051500 205/55R16/5L RS-AEAGLE 0.0000
732674500 P205/55R16/5L RS-A EAGLE 5.0000
732127500 P225/55R16/5L RS-AEAGLE 0.0000
732354500 P225/60R16/5L RS-A P EAGLE Pﬁ
732804500 P235/TOR16/SL RS-A EAGLE 0.0000

\al732491500 RIDSISORITISL  IRSAEAGLE s aald0000 e saads

Note: Do nottype the difference between the system-generated count and the actual count. If
an item’s actual count needs to be adjusted to zero, type a 0.

6. If you need to undo an adjustment, select the item and click Cancel Line. The blue highlighting

disappears.
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10.
1.
12
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Cty Adjustment Wizard (11300)

Select tems Update Quantities ]
ProdCode Size Description Actual Count | -
732170500 P205/55R16/52 RS-A EAGLE 1.0000
732401500 195/60R15/5L RS-A EAGLE 0.0000
732051500 205/55R16/5L RS-A EAGLE 0.0000
732674500 P205/55R16/SL RS-A EAGLE / """"""
732127500 P225/55R16/SL RS-A EAGLE 0.0000
32354500 P225/(60R1G/ISL g ¥VIFFovvvrvyvIvYvVV VYV Y bl g bbb i i bl i
Inventory Counting Deck | Cancel Line == Back | Einish | Cancel |

Compare the numbers entered on the screen to the counting deck to ensure you’'ve entered the
correct quantities for the items that needed to be adjusted.

Adjust quantities for another group of items if needed.

a. Click Back to return to the Select Items tab.

iy g e i i i e s g B i e e

BOR18/5L RS-AP EAGLE 0.0000

R5R18/5L R3-AEAGLE 0.0000

20R18MXL R3-AP EAGLE 0.0000 o
>

»
4 Inventary Counting Deck | Cancel Line |I == Back | Finish | Cancel |

b. Repeat steps 3 through 7.

Once you’ve entered all of the necessary adjustments, click Finish. The Report Window
appears.

i i i i i s . B e e e

B0R18/5L RS-AP EAGLE 0.0000

R5R18/EL R3-AEAGLE 0.0000

B0R18MXL RS-AP EAGLE 0.0000 o
4

»
: Inventory Counting Deck | CanceILine| == Back |I FEinish I Cancel |

Print and review the Physical Count Edit report.

Close the Report Window. A confirmation message appears.
Do one of the following:

= To complete the adjustment, click Yes. Clicking Yes will update the system-generated on-
hand quantities and adjust the item’s value in the general ledger.

Note: Once an adjustmentis completed, you can view adjustment details in the subledger
for the Inventory Quantity Adjustment vendor.
= To complete the adjustment, click Yes. Clicking Yes will update the system’s on-hand
quantities.

= |fyou don’t want to adjust the quantities, click No.
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ADD-ON PACKAGES

With add-on packages (referred to as add-ons), you can automatically include additional items and
services such as alignments, warranties, and disposal fees on a customer's work order. Using
add-on packages includes the following benefits:

= [treduces the amount of time needed to create work orders, because you don’t have to add
each itemone atatime.

= |tcan help you increase sales, because add-on packages remind you to suggest additional
items and services to customers.

= |t can help to prevent liability by prompting you to recommend services that, if declined, might
compromise a customer’s safety.

Note: Whether add-ons are included on a work order depends on the customer type assigned to
the customer. For some customer types, add-ons are disabled. For more information, see
"Customer Types" on page 95 and "Customer Type Edit Screen" on page 99.

ANATOMY OF AN ADD-ON PACKAGE

An add-on is made up of an add-on code and one or more items. Add-on codes are displayed at the
top of the Add-On Code List, and the items assigned to each of the add-on codes are listed toward
the bottom (Figure 10-9). The items assigned to an add-on code are called add-on items.

Add-0n Cede List (6200)

Add-On:

Code |Descripti0n "~
L1 LIGHT TRUCK GOLD PACKAGE

LIGHT TRUCK SILVER PACKAGE e An add-on code.

LT LIGHT TRUCK BRONZE PACKAGE

P1 PASSENGER GOLD PACKAGE

P2 PASSENGER SILVER PACKAGE

PT PASSENGER BRONZE PACKAGE v
Mew Code Del. This Code Edit This Code |

Items Associated With Above Add-On:

Prod.Code Description Tax (Percent [Qiy Site Quote

8 COMPUTER BALANCE -LT 0
34 RUBBER VALVE STEM | 000 0.00 |0 v The items
21 STATE TIRE TAX (FEE) [ 000 000 O v assigned to
SRV-WARILT LT ROAD HAZARD WARRANTY 1YF| 1000 000 0 v [~ the selected
7 COMPUTER 4-WHEEL ALIGNMENT | 0.00 100 0 v add-on code.
43 TIRE DISPOSAL - LT. | 000 000 0 v

Add tem To Code | Delete This ftem_ | EditThistem |

Figure 10-9: The Add-On Code List

Add-on codes can be assigned to one or more items in your inventory. In the following image (Figure
10-10), the add-on code LT is assigned to a tire.
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Inventory Maintenance (12300)

General Imerricing] History ] Motes ]

Product Code: |744826802

Size: |LT235."?5R‘15.I’B Rim Size: 15.00

Description:  |[HT WRANGLER E
Add-OniKit Code: [LT 4| | Taxable: [

FY WY TYYrYywvywi

Mfg Code:  |GDY Category: |TILT GL: |TLTI
Close

e b b b

Figure 10-10: The Add-On Code Assigned to a Tire

The items that add-on codes are assigned to are referred to as parent items, and they are the main
items put on work orders. Tires and oil changes are two examples of parent items. When you put a
parent item on a work order, the items linked to its add-on code (the add-on items) are also added to
the work order automatically. If a customer doesn’t want to purchase an add-on item, you can delete
it from the work order. On the Invoice Entry screen, the lines for parent items are green and lines for
add-on items are white (Figure 10-11).

Quantity [size | Description |Pas  iabor  |FET
4.00 LT235/75R15/6 HT WRANGLER 220,98 0.00 <& Parent tem
400 . COMPUTER BALANCE - LT 0.00 12.99 4
400 . RUBBER VALVE STEM 199 0.00 p
4.00 . STATE TIRE TAX (FEE} 3.00 0.00 : — Add-On ltems
400 . LT ROAD HAZARD WARRAN' 2210 0.00 p
4.00 . TIRE DISPOSAL - LT. .00 0.00 c
4

Figure 10-11: A Parent Item and It's Add-On Items

CREATE ADD-ON CODES

The first step in setting up add-ons is creating the add-on codes that can be assigned to (parent)
items. The items that add-on codes are assigned to are called parent items. When parent items are
sold, the add-on codes prompt TireMaster to automatically include additional items on work orders.

To create an add-on code
1. SelectInventory > Add-On Codes. The Add-On Code List opens.
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Inventory

Maintenance
LAAAAAAAALAALALLALLSLSSS

Categories & Groups
Inventory GL Codes
Add-On Codes h

Gasoline Combine

Reports...

2. Click New Code. The Add-On Header Edit screen opens.

Add-0n Code List (6200)

Description

LIGHT TRUCK GOLD PACKAGE
LIGHT TRUCK SILVER PACKAGE
LIGHT TRUCK BROMZE PACKAGE
PASSENGER GOLD PACKAGE
PASSENGER SILVER PACKAGE
PASSENGER BROMZE PACKAGE

Del. This Code | Edit This Code |

3. Type atwo-character code in the Add-On Code field.

Note: Once you click OK, this code cannot be changed.

Tip:  Name add-on codes based on the type of parent items they’ll be assigned to, such as
light-truck tires. This naming method helps others understand which add-on codes to
assign to parent items.

4. Type adescription for the add-on code.

Add-On Header Edit (5100)

Add-On Code: Igc

Description: |0||_ CHANGE PACKAGE

OK | Cancel |

5. Click OK. Now you can assign items to the new add-on code. For more information, see "Assign
Items to Add-On Codes" on page 243.

MANAGE EXISTING ADD-ON CODES

You can change the description of existing add-on codes and delete add-on codes that are unused.

CHANGE AN ADD-ON CODE'S DESCRIPTION

If you don't like the description for an add-on code, you can change it. However, the add-on
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code itself cannot be edited.

To change an add-on code's description
1. SelectInventory > Add-On Codes. The Add-On Code List opens.

Inventory

Maintenance

Categories & Groups
Inventory GL Codes
Add-On Codes b

Gasoline Combine

Reports...

2. Select the code whose description you want to change, and click Edit This Code.

Add-0n Code List (6200)

Add-On:

Code |Descripti0n |f\

L1 LIGHT TRUCK GOLD PACKAGE

L2 LIGHT TRUCK SILVER PACKAGE

LT LIGHT TRUCK BROMNZE PACKAGE

oc OIL CHANGE PACKAGE ,_H"

P1 PASSEMNGER GOLD PACKAGE

P2 PASSENGER SILVER PACKAGE v
Del. This Code |

3. Type the new description, and click OK.

Add-On Header Edit (5100)

Add-On Code: IOC

Description: ILDFF'ACK»‘\GE

I QK I Cancel

DELETE AN ADD-ON CODE

Add-on codes that are not assigned to any items can be deleted.

To delete an add-on code
1. SelectInventory > Add-On Codes. The Add-On Code List opens.
2. Selectthe code you want to delete, and click Delete.

3. When the confirmation message appears, click Yes. The code is removed from the
database.

4. Close the Add-On Code List.
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ASSIGN ITEMS TO ADD-ON CODES

The second step in creating add-on packages is assigning items to the add-on codes. When you
assign items to an add-on code, you need to define whether they'll be sold at the same quantity as
the parentitem or at a fixed quantity. For example, although you sell a set of four tires, you perform
only one alignment check.

You also need to decide whether to sell add-on items at their regular prices or a percentage of the
parentitem’s price. The prices and quantities of add-on items can be overridden at point of sale if
needed.

Note: You can assign items to an add-on code as soon as the code is created. However, if you are
in the process of going online, you need to wait until all your items are set up before you can
assign items to add-on codes.

To assign items to an add-on code
1. Select Inventory > Add-On Codes. The Add-On Code List opens.

Inventory

Maintenance
LAAAAALLLAALALALSLSLLSS

T T TET VI ITTT PP YT T T

Categories & Groups
Inventory GL Codes
Add-On Codes l}

Gasoline Combine

Reports...

2. Select the code to which you'll assign items (top of screen), and click Add Item to Code (lower
left). The Add-On Item Edit screen opens.

Add-0On Code List (6200)

Add-On:

[
4
L
Code |Descripti0n 4
L1 LIGHT TRUCK GOLD PACKAGE r
L
L2 LIGHT TRUCK SILVER PACKAGE 4
1
4

LT LIGHT TRUCK BRONZE PACKAGE
OIL CHANGE PACKAGE —¢

P

A’ Y

I Add Item To Code I Delete This ltem | Edit T

Trw rry

3. Click Lookup, and search for the item you want to assign to the add-on code. For more
information, see "Inventory Searches" on page 216.
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Add-0n Item Edit (5700)

Add-On: oc
Part#: | |

Prod. Code: |

LAALALSALLLLDLSDEDLEDADLDEDDDDSSSDS

4. Define whether the settings for an add-on item are only applicable for a particular site, if needed.
Click the Site # field, press [z}, and select the site from the Site List. Otherwise disregard this step.

5. Seta price percentage and fixed quantity as needed:

= To sell the add-on item at a percentage of the parent item’s price, type the percentage in
decimal form (such as 5. 5) in the Percent field. Otherwise, leave the percentage set to
0.00.

= To sellthe add-on item at a fixed quantity, type the quantity in the Fixed Qty field. Otherwise,
leave the quantity setto 0.

IV YTV T I T T T TR T YT T YT e

|F'ercent: 0.00 Fixed Qty 0.00 |

[~ Add only if parent item is taxable
[~ Appear selected when added to quotes

OK | Cancel |

6. To exclude the add-on item from tax-exempt invoices, select the Add only if parent item is
taxable check box. Otherwise, leave the check box alone.

7. Toinclude the add-on item in quoted prices, select the Appear selected when added to
quotes check box. Otherwise, leave the check box alone.

IV VYT YTV TV I T T TP T T T YT T YT

Percent: 0.0p  Fixed Qty: 0.00
[~ Add only if parent item is taxable
v Appear selected when added to quotes ('

(0] | Cancel |

8. Click OK.
9. To assign additional items to the add-on code, repeat steps 2 through 8.
10. Close the Add-On Code List.

UPDATE AN ADD-ON ITEM

If you need to change the percentage, quantity, or tax settings for an add-on item, update its settings.

To update an add-on item

1. From the Inventory menu, select Add-On Codes. The Add-On Code List appears.
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Inventory

Maintenance
LAAAAAAAALAALALLALLSLSSS

Categories & Groups
Inventory GL Codes
Add-On Codes h

Gasoline Combine

Reports...

2. Selectthe code that’s assigned the add-on item you want to update (top list).

Add-On:

Code Description 4
L1 LIGHT TRUCK GOLD PACKAGE 4
L2 LIGHT TRUCK SILVER PACKAGE :

LIGHT TRUCK BRONZE PACKAGE:

3. Select the item (lower list), and click Edit This Item. The Add-On Item Edit screen opens.

ltems Associated With Above Add-On:

Prod.Code |Description |Tax |F‘ercent |Oty |Site |Ouote|
28 COMPUTER BALANCE - LT [ oo0 o000 [v
34 RUBBER VALVE STEM [~ 000 0.00 |0 [v
21 STATE TIRE TAX (FEE) F o000 0 [v

LT ROAD HAZARD W.-‘\FlFLN‘JTYWE Il |10.00

43 TIRE DISPOSAL - LT. | oo o000 v

Add ltem To Code Delete This ltem | I Edit This Item I

oK |

Make the needed changes to the percentage, quantity, and tax settings.

5. Click OK.

REMOVE AN ADD-ON ITEM FROM AN ADD-ON CODE

If an item should no longer be assigned to an add-on code, you can remove the add-on item from the
add-on code.

To remove an add-on item from an add-on code
1. SelectInventory > Add-On Codes. The Add-On Code List opens.
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Inventory

Maintenance
LAAAALALLELLLLLLLLLLSLLSS

Bl A b b A e A A s

Categories & Groups
Inventory GL Codes
Add-On Codes h

Gasoline Combine

Reports...

2. Select the code that is assigned the add-on item you want to remove (top list).

Add-On:

Code Description 4
L1 LIGHT TRUCK GOLD PACKAGE 4
L2 LIGHT TRUCK SILVER PACKAGE :

LIGHT TRUCK BRONZE PACKAGE:

3. Select the add-on item (lower list), and click Delete This Item A confirmation message appears.

T P T T T T T T T T T T T T T T T T T P T T T T P o T T T T T T T T T T T T T T YT T TR YT YT T Y YL

Items Associated With Above Add-On:

Prod.Code |Description |Tax |F'ercent |Oty |Site |Ouote|
28 COMPUTER BALANCE - LT [ 000 000 0 3
34 RUBBER VALVE STEM [ |ooo 000 0 v
21 STATE TIRE TAX (FEE) ~ 0.00 000 0 v

1
W |[1000 [oo0 o vk

LT ROAD HAZARD ‘.’\".-'\FlFLM‘JTYWE
43 TIRE DISPOSAL - LT. |— 0.00 000 0

Add item To Code | | Delste This ltem I Edit This ftem |

4. Click Yes. The add-on item is removed from the add-on code.

ASSIGN ADD-ONS TO PARENT ITEMS

An add-on code defines which additional items to sell when an item is sold. The add-on code is one of
many settings that you can assign to an item on the Inventory Maintenance screen.

Note: Although an add-on code may be assigned to an item, the add-on items might excluded from
the work orders for some customers. This happens when the add-ons are disabled for a

customer type. For more information, see "Customer Types" on page 95 and "Customer
Type Edit Screen" on page 99.

To assign an add-on code to an item

1. Look up the item you want to assign the add-on code to. For more information, see "Inventory
Searches" on page 216.

2. Onthe Inventory Maintenance screen, make sure the General tab is selected and click Edit.
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Inventory Maintenance (12300)

r
4

General |OtyfF'ricing| History | Motes | :
<

4

Product Code: |18 o

) <
Size: I :
Description: ILUEE.DIL&FILTER<5QTS <
o Quiskiogic , LG A
4

Add || Edit I Delete | 4

2

Click the Add-On/Kit Code field, press ], and select an add-on code from the list.

o .
Add—DnIKitCode:I 4| Taxable: [ Parts [~ Labor

Mfg Code: |ZZZ Category: IDILU GL: |DSSN

OK | Cancel |

PV YT YYYY

To save your changes, click OK.

Close the Inventory Maintenance screen.

247



User Guide

248



TIREMASTER

SOFTWARE
DRIVEN BY ASA~

CHAPTER 11

INVENTORY REPLENISHMENT

In TireMaster, items are ordered and received into inventory with the PO system. This chapter
includes the following sections:

Purchase Orders .. 250
igulnventory Receipts ... .. .. 262
e TraCKiNg L 280
Outside Purchases .. .. 294
FET Handling for POs and Receivings ... . .. 300
Inventory RetUINS .. 301
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PURCHASE ORDERS

To order items, you need to create a purchase order and add items to it. For the purposes of
replenishing inventory, the corporate site and the stores can each have different levels of control.

Example: The corporate site could be authorized to create purchase orders for all stores, while a
store would only be allowed to create purchase orders for itself. For more information, see

Purchasing in TireMaster Corporate .

CREATE A PURCHASE ORDER

The first step in the inventory replenishment process is creating a purchase order. The information
on a purchase order defines which items you want to buy from a vendor and is used to produce
receiving documents when your vendors deliver items.

To create a purchase order
1. SelectInventory > PO & Receiving. The PO System opens.

Inventory
Maintenance
PO 8 Receiving %
Suggested Reorder & PO
Oty Adjustrment Wizard
List Editing

LAALAAALALLSSSLSDSSSSSS

2. Make sure the Purchase Orders tab is selected.

4
Vendor | J Find Doc Fieset‘g’%I

4
4
Purchase Orders ] Receiving Documents ] Historical Vendor Invoices ] 3
4
s

[¥ open [] ordered [7] Paial  [M Fulfilled

3. Click Add. TireMaster prompts you for the vendor's name.

Status 3

f Open i Ordered i

4
Add Edit | Delete |j

4. Search for the vendor you want to order from and click OK. The Purchase Order screen opens.
For more information, see "Vendor Searches" on page 179.

5. Ifyou have it, type the reference number for the purchase order.

250



Purchase Orders

e e e e

FOB
" Source
f+ Destination

——_
ef# 82210 &

For each item you want to order, click Add and look up the item or scan its bar code. For more
information, see "Inventory Searches" on page 216 or "Enter Bar Codes on Purchase Orders
and Receiving Documents " on page 325.

4

3

Add Delete | | 4

4

P 4

Unit Price 4

4

4

Close | Order | 1

Tip:  You can also use the down-arrow lookup method to add items to purchase orders. For

more information, see "Down Arrow Lookup Method" on page 10.

For each item added to the purchase order, do the following:

a.
b.

Type the quantity.
Change the price (your cost) if needed.

Note: Ifyou're orderingitems in bulk, such as valve stems, TireMaster can calculate the
cost for each item. For more information, see "Calculate an Item’s Per-Unit Cost" on
page 255.

Change the federal excise tax if needed.

s|Product code  [size [vendPatNo  |Name ay|  Price]  FETax| Extended| ¢

403105174  P235/65R17ISL 135646741 HP WRANGLER 17| 18234, 000 300978 <
[ |112187344  |208585R16/5L 135001306 EFFICENT ROF 16 19485 000| 311440 ¢
[ |732170500  P20sisER161S2 135000140 | RS-AEAGLE M o2¢  on| oam i

Note: A system control defines whether the FETax column displays the average cost of an
item’s federal excise tax or the FET used the last time the item was received. For
more information, see "Use Next FET for POS/Receivings" on page 1134.

Add shipping and handling information as needed:

Type the shipping method or courier’s name, along with the tracking number.

Under FOB, select Source if you will pay for the freight or Destination if the vendor will pay
for the freight.

Type the contact person’s name.
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3

¥ o ] FEOB———
Sh dV IThe vendaor L%

: pediia " Source

: Tracking # I & Destination

4

3

' Contact IBob Harris| Ref# |822‘10

9. When you're done adding items to the order, do one of the following:
=  To complete the order, click Order.

= To close the order and complete it later, click Close.

add | petete | cancer |
UnitF'ricel
I Close I I Order I

Note: An order that willbe completed later is called an open order.

ADD AND ORDER NEW ITEMS AT THE SAME TIME

If you need to order an item thatisn’t in your inventory, you can add it to TireMaster and the purchase
order at the same time. Because this process is the almost the same as adding items to TireMaster

and a receiving document, see "Add and Receive New ltems at the Same Time" on page 274 for
instructions.

REMOVE AN ITEM FROM A PURCHASE ORDER

If you decide that you don't want to order an item on a PO, you can remove the item.

To remove an item from a purchase order
1. Ifthe purchase order isn’t already open, do the following.
a. SelectInventory > PO & Receiving. The PO System opens.

Inventory
Maintenance
PO & Receiving
Suggested Reorder 8 PO
Cty Adjustrment Wizard

List Editing

b. Make sure the Purchase Orders tab is selected.
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Vendar |

_| Find Doc |

Purchase Orders | Receiving Documents | Historical Vendor Invoices |

Open D

Ordered [0 Patial [ Fuffilled

c. Todisplay all orders that haven’t been placed, select the status Open.

I 4
4

gtatusr/ 5
’7(3‘ Open i Orderad <
<

agse | Eat | Deete | E

r

d. Selectthe purchase order with the item you want to delete, and click Edit.

PQ System (16178)

‘u’endorl

Open

Purchase Orders | Receiving Documents | Historical Vendor Invoices |

D COrdered

_| EindDoc | ResetVendor | Fiter OF |

[ Partial Fulfilled

3| Site |PONum |PO Date

Add

|| Edit I

Ref Mame
| ROUND TIRE DISTRIBUTORS —— |

AMC TIRE WAREHOUSE

Q00

Print

| Close I

Delete | Receive |

2. Select the item you want to remove and click Delete.

|

PO# |1 |25 Shipped Via IThe vendor ¢
4

Date I 3129/12019 vl Tracking # I :
4

4

4

- 4

Vendor |ROUND TIRE DISTRIBUTORS | Contact |Elob Harris 4
4

Lines D Open/Unreceived |i Partially Received |i Completely Received:
S|Product Code |Size I‘u’endF‘anNo |Name | L
402105174 P235/65R17ISL 135646741 HP WRANGLER 4

- >
112187344 205/55R16/SL 135001306 w :
LAT32170500  JF205/55RIBISZ. | | s a 132000140 | RSAEAGLE o nna PPN,

ada | I Delete l

Cancel |

Total Qity:

Unit Price |

Cloze | Order |

Add Inventory |

3. When the confirmation message appears, click Yes.

4. Add new items to the purchase order if needed or close the Purchase Order screen.

Purchase Orders
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UPDATE AN OPEN PO

If an order hasn't been placed, you can update the vendor, items, and other information on the open
PO.

To update an open PO
1. SelectInventory > PO & Receiving. The PO System opens.

Inventory
Maintenance
PO & Receiving |}
Suggested Reorder & PO
Oty Adjustrment Wizard

List Editing

2. Make sure the Purchase Orders tab is selected.

\u’endorl _I EindDocl

Purchase Orders I Receiving Documents | Historical Vendor Invoices |

open [ | Ordered [ Partial Fulfilled

3. Todisplay all open purchase orders, select the status Open.

I <
<

gtatusr/ S
’7(3' Open " Ordered r
<

acd | Eat | Dpee | E

4. Selectthe purchase order you want to update and click Edit.

PO System (16178)

\u’endorl _I Find Doc | Reset‘jendorl Filtergﬁl

Purchase Orders | Receiving Documents | Historical Vendor Invoices |

open [ | Ordered [l Patial  [M Fulfiled
3| Site |POMum |PO Date Ref Mame

|FlDUf‘-lD TIRE DISTRIBUTORS ——

Add || Edit I Delete | meceie | Pt [[ close |

5. Do the following as needed:

Click _| and look up a different vendor.

= Change the quantity for an item on the order. If you want to use the per-unit cost for bulk
items, see "Calculate an ltem’s Per-Unit Cost" on the facing page.
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= Click Add and search for an additional item to put on the order.
= Select an item you want to remove from the order and click Delete.
= Change the reference number, contact name, and shipping information.

6. If you want to place the order, click Order and print a copy of the PO. Otherwise, click Close.

Add | Delete | Cancel |

LInit Price |

I Close I I Order I

CALCULATE AN ITEM’S PER-UNIT COST

When you buy items in bulk, such as valve stems, TireMaster can calculate the per-unit cost for each
item.

To calculate an item’s per-unit cost

1. Starta purchase order or receiving document. For more information, see "Create a Purchase
Order" on page 250 or "Create a Receiving Document" on page 272.

2. Select the item whose per-unit cost you want to calculate, and click Unit Price. The Per Unit
Price screen opens.

Purchase Order (16179)

-

PO# |1 |25 Shipped Via | ¢
i

Date I 32912019 "I Tracking # I :
1

L

1

yendorlTIRES & MORE | Contact I B;

[

Lines D Open /Unreceived Partially Received Completely Received :
S|Product Code |Si7_e |\u’endF‘ar1N0 |Name 4
34 . RUBBER E STEM— 1 :

NG USSP PP PP STICKONWHEEL WEIGHTS | 1, ¢

add | peete | cancel | Total Q. | 2
Add Inventary |
Close | Order |

3. Type your cost for a case of the item in the Parts Price field.

Type the number of items in the case in the Quantity field. TireMaster displays the cost of each
item in the Per Unit Price field.
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Per Unit Price (16285)

Product Code: 34
Size:

Parts Price: |36.99
Quantity: |100|
Per Unit Price: Im_%gg
oK I Cancel |

5. Click OK. The per-unit quantity and cost information is added to the purchase order.

CANCEL AN ITEM ON A PURCHASE ORDER

If you've placed an order and then find out that an item won’t be shipped, you can cancel the item on
the order.

To cancel an item on a PO
1. SelectInventory > PO & Receiving. The PO System opens.

Inventory
Maintenance
PO & Receiving %
Suggested Reorder & PO
City Adjustment Wizard

List Editing

2. Make sure the Purchase Orders tab is selected.

‘u’endorl _I EindDocl

Purchase Orders I Receiving Documents | Historical Vendor Invoices |

open [ | ordered [ Partial Fulfilled

3. Todisplay the POs for orders that have been placed, select the status Ordered.

rrwvwwvvvvvwvwvvwwvw:

4

Statu -
4
I :

e

4. Selectthe order with the item that won’t be shipped, and click Edit. The Purchase Order screen
opens.
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PO System (16178)

\u’endorl _I EindDocl Reset‘jendorl Filtergﬁl

Purchase Orders | Receiving Documents | Historical Vendor Invoices |

[T Partial

open [ | Ordered Fulfilled

5| Site |PONum |PO Date

Add || Edit I Deiete | Receve | pint || close |

Note: Items can be canceled only from purchase orders with the status color yellow (for
ordered).

Select the item that won’t be shipped, and click Cancel. A confirmation message appears.

Purchase Order (16179)

4

po# [1 [ Shipped Via | p
L

Date I 3128/2019 'I Tracking # I :
i

i

Vendor |TIRE8 & MORE | Contact I Bl
L

Lines D Open / Unreceived Partially Received Completely Received 4
s|Productcode  [size [vendpartiio  [ame | oty
4 . RUBBER VALVE STEM 100 :
WHLWGTS STICK ON WHEEL WEIGHTS 144 :
— L

Total Qty: I D44

Add Inventory |
Close | Order | Re-Open |

Click Yes. The status of the item changes to Canceled (|i).

Close the Purchase Order screen. When you create a receiving document for this order, the
canceled item will no longer be on the order.

REOPEN AND UPDATE ORDERS

If your TireMaster system is set up to allow purchase orders to be reopened and edited, you can
make changes to an order that has already been placed. By reopening and updating an order, you
can ensure that the purchase order data in TireMaster matches any changes the vendor has made
to a pending shipment. Reopening a PO reduces the amount of time it takes to receive an order,
because you won’t need to back order items or add items to the receiving document.

Note: The ability to reopen and update orders is defined by a system control. For more information,

see "PO System - Re-Open Ordered POs" on page 1133 .
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To reopen and update an order

1. SelectInventory > PO & Receiving. The PO System opens.

Inventory
Maintenance
PO & Receiving
Suggested Reorder & PO
Cty Adjustment Wizard

List Editing

2. Select the status Ordered.

FYw Y

e

3. Select the purchase order you want to update, and click Edit. The Purchase Order screen opens.

PO System (16178)

\u’endorl _I Find Doc | Reset‘jendorl Filtergﬁl

Purchase Orders | Receiving Documents | Historical Vendor Invoices |

open [ | Ordered [l Patial  [M Fulfiled
site [PONum |[PODate  |Ref |mame
1 26 03/29/2019 80059 TIRES & MORE

(]

Add || Edit I Delete | Recsive | Print | Close |

4. Click Re-Open. TireMaster closes the Purchase Order screen and returns to the main PO
System screen.

Add Inventory |

19
[=)
w
[1e]

[
=
[=3
]

Re-Open

5. Make sure the purchase order you want to update is selected, and click Edit (again).
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\u’endorl _I EindDocl Reset‘gendorl Filtergﬁl

Purchase Orders | Receiving Documents | Historical Vendor Invoices |

[W open [ ] ordered [ Patia M Furfilled
g|site [Ponum [PoDate  [Ref |name
03/29/2019 80059 TIRES & MORE
03/29/2019 ROUND TIRE DISTRIBUTORS —
02/28/2019 SORUWM'S TIRE DISTRIBUTION

TPV ETITITITEETYTTTTYY

Add || Edit | Delet: | Receive | Pt || close |

Purchase Orders

Note: The status of the PO changed from ordered (yellow) to open (green) when you re-

opened it.

Do the following as needed:
= Additems to the reopened order.
= Delete items from the reopened order.

= Update the prices of items on the order.

Click Order. The Report Window opens and displays a copy of the purchase order.

ada | Detete | cancel |

UnitF'ricel
Close | I Order I

8. Printthe purchase order and close the Report Window.

REORDER INVENTORY

You can simplify the reordering process by creating a suggested purchase order. Creating a
suggested purchase order includes generating a report that shows the difference between the
minimum quantities you’ve set for your items and the actual quantities you have on hand. Once
you’ve generated the report, you can create a purchase order based on its results.

To generate a suggested reorder

Select Inventory > Suggested Reorder & PO. TireMaster prompts you to search for items.
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Inventory
Maintenance
PO 8 Receiving
Suggested Reorder & PO
Oty Adjustrment Wizard

List Editing
A bbb

2. Lookup agroup of items that you to include on the report. For more information, see "Inventory
Searches" on page 216. The Suggested Reorder Report appears in the Report Window.

3. Printthe report.

< Previous | Mest » | | Print I Zoom | E-kail |

4. Write the quantities you want to order on the report.

Suggested Reorder Report

Description Last Cost On Hand On Order Sugg. Order TotWt Product 7

Site#: 1 .
LT215/85R18/HT TRANSFORCE 122.20 0.00 ] 4 [+] [+] 4 £ 000 183701
185/60R14 SPORT PRECISION 5279 0.00 0 4 4] 4] 4| £ 0.00 137913

)
196/50R18  AS WIDE OVAL FIREHAWK 8312 0.00 "] 4 4] 4] 4] = 0.00 147960
235/MER1IE  TOURPRECISION 8351 0.00 0 4 -4 4] 1 ?‘.? 0.00 147535
FIBE/EER1E LE2 DESTINATION 14225 0.00 "] 4 4] 4] 4= 0.00 018004

Store Total Approx OrderC ost: Approx Units: 24

5. Close the Report Window. A confirmation message appears.

6. Do one of the following:

= To create a purchase order based on the Suggested Reorder Report, click Yes. TireMaster
prompts you to look up a vendor.

= |fyou do notwant to create a PO yet, click No and disregard the rest of this procedure.

7. Search for the vendor you want to order from. For more information, see "Vendor Searches" on
page 179. The Purchase Order screen opens. All of the items from the Suggested Reorder
Report are included on the order at the recommended reorder quantities.

8. Make the following changes as needed:
= Additems to the PO.

= Delete items from the PO.
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= Change quantities and prices.
= Fillin the shipping information, contact name, and reference number.
9. When you're finished making changes to the purchase order, do one of the following:

= To complete the order, click Order. The purchase order appears in the Report Window so
you can print it.

=  To save the purchase order without completing it, click Close.

Purchase Order (16179)

. ’ E

PO# |‘1 IZ? Shipped Via I f*[i
L

Datg I 3/28/2019 vl Tracking # I e
4

yendor|ROUP-JD TIRE DISTRIBUTORS | Contact | Ref# || :
i

Lines D Open/Unreceived Partially Received Completely Received Canceled+
s|Productcode  |size [vendpartve  [name | ay| price| ¢
189701 LT215/85R16/10 107189701 HT TRANSFORCE 4 12220 :
137913 185/60R14 107000259 SPORT PRECISION 4 5279 :
147960 195/50R16 107000439 AS WIDE OVAL FIREHAWK 4 83.22 :
147535 235/65R16 107000397 TOUR PRECISION 8 83.51 :
018004 P265/65R18 107018004 LEZ DESTIMATION 4 143.25 :
I— 1

add | petete | cancel | Total Oty [~ 24
Unit Price | Add Inventory |

I Close I I Order I

CANCEL A PURCHASE ORDER

In some cases, you might start an order only to find that it is unnecessary later. You can cancel
purchase orders if the items on it have not been ordered or received.

To cancel a purchase order

1. SelectInventory > PO & Receiving. The PO System opens.

Inventory
Maintenance
PO & Receiving l}
Suggested Reorder & PO
Gty Adjustment Wizard

List Editing

2. Make sure the Purchase Orders tab is selected.
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‘u’endorl _I EindDocl

Purchase Orders I Receiving Documents | Historical Vendor Invaices |

open [ | Ordered [ Partial Fulfilled

3. Select the status Open. All open purchase orders appear on the screen.

| <
<

Status g~ 4
’7(3' Open  Orderad r
4

aga | Edt | Delete | E

4. Selectthe purchase order you want to cancel and click Delete. A confirmation message appears.

PO System (16178)

‘ufendorl _I Find Doc | Reset‘g’endorl Filtergﬁl

Purchase Orders | Receiving Documents | Historical Vendor Invoices |

open [ | Ordered  [7] Patial  [M Fulfilled
s|site [Ponum [PoDate  |Rer |name

1 24 03/01/2018 AMC TIRE WAREHOUSE
03/01/2019 GOODYEAR TIRE CO.—=

Add | Edit |I Delete l Receive Print | Close |

Click Yes.

Close the PO System screen.

IGUINVENTORY RECEIPTS

When an order is delivered, you need to receive the items in TireMaster's PO System. Deliveries
typically have a corresponding purchase order. Sometimes, however, you might need to receive
items that were not put on a purchase order. In that scenario, you can create a receiving document.

Note: Your system control settings define whether you're allowed to create a receiving document
without a corresponding purchase order. For more information, see "Force PO System to
Create New PQO" on page 1137.

RECEIVE ITEMS ON A PURCHASE ORDER

When you receive an order, TireMaster creates a receiving document that duplicates the items and
quantities on the original PO. You can create a receiving document regardless of whether the order
was delivered with a packing slip or a vendor invoice.
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Note: When you do not have a purchase order for a shipment, you need to create a receiving
document from scratch. For more information, see "Create a Receiving Document” on
page 272.

To receive items on a purchase order
1. SelectInventory > PO & Receiving. The PO System opens.

Inventory
Maintenance
PO & Receiving %
Suggested Reorder & PO
Oty Adjustment Wizard

List Editing

2. Make sure the Purchase Orders tab is selected.

Vendorl _l EindDocl

Purchase Orders | Receiving Documents | Historical Vendor Invoices |

open [ | Ordered [ Partial Fulfilled

3. Select the status Ordered. TireMaster displays the purchase orders for items that have not been
received.

4
aga | Eat || Delete |J

4. Selectthe PO with the items you want to receive and click Receive. The Receiving Document
screen opens.

PO System (16178)

\u’endorl _I EindDocl Reset‘jendorl Filtergﬁl

Purchase Orders | Receiving Documents | Historical Vendor Invoices |

Cpen D Partial

[7] ordered Fulfilled

|FlDUND TIREDISTRIBUTORS —_—

adg | gat | Delete || Receive I pint | [ close |

Note: Ifareceiving document already exists for an order, TireMaster asks if you want to create
another receiving document. Write down the RD number on the message and click No.
Then click the Receiving Documents tab and select the receiving document that was
referenced on the message.
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5. Update the reference number and the shipping and contact information if needed.
} ShippedVi FoB
; Snippec s " Source
: Tracking # {+ Destination
i
}  Conact |3amWebb Ref# 9236498
>
6. Update the quantities, cost, and federal excise tax for the items if needed.
s|Productcode  [size [vendPato  |Name ay|  Price]  FETax] <
E‘IBQ?D‘l LT215/85R16M10 107189701 HT TRAMSFORCE 4 122.20 0.00 <
513?913 185/60R14 107000259 SPORT PRECISION 4 54.89| 0.00 3
E‘M?QBD 195/50R16 107000439 AS WIDE OVAL FIREHAWK 4 8322 noof 4
E‘M?SBS 235/65R16 107000397 TOUR PRECISION g 83.51 0.00 3
P(018004 P265/65R18 107018004 LE2 DESTIMATION 4 143.25 0.00 :
| <
Note: Ifyou’ve ordered itemsin bulk, such as valve stems, TireMaster can calculate the cost for
each item. For more information, see "Calculate an Item’s Per-Unit Cost" on page 255.
Tip To view the quantity and cost used for an item on the original purchase order, select the
item and click Order Info.
7. If you wantto receive items (from the selected vendor) that are on a different purchase order,
click Add PO. Then select the purchase order that includes those items and click OK.
add | Delete |  Orderinfo|  Addinventory | 3
Unit Price %
Close | Recsive | I Add PO I | i
8. Enter shipping charges if needed, using one of the following methods:

= |fthere is shipping charge for individual items, type the amount in the Freight column for
each line item. The value entered here is included in the item’s cost when it posts to the
general ledger.

4 |Name | Clty| F'ricel FETax Freight] Extended | Corel
; HT TRANSFORCE 4 122.20 0.00 0.00 488.80 0.00
; SPORT PRECISION 4 0.00 0.00 219.56 0.00
: AS WIDE OVAL FIREHAWK 4 8322 0.00 0.00 33288 0.00
; TOUR PRECISION g 8351 0.00 0.00 G68.08 0.00
; LEZ2 DESTIMATION 4 143.25 0.00 0.00 573.00 0.00
>

= [fthere is a shipping charge for the entire order, type the amount in the Freight field (lower-
right corner of the screen). The value entered here posts to the general ledger’s freight
account). You can select the freight vendor when you enter the vendor invoice.
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Sl B

Received: 228232

Freight: 0.00
Tax: 0.00

YT Y T YT YYYTYY

Total 228232

9. Click Receive. The following message appears: Do you want to price this RD now?”

LA B i i e

Add | Qelete| grder|nfo| Addln\renton{|

Unit Price
Close | IBeceiveI Add PO | |

Note: Depending on your system control settings, you might be required to add a reference
number if you haven’t already.

TYOYYYOTwY

10. Do one of the following:

= |fyou have an invoice from the vendor, click Yes to price the items. For further instructions,
see "Price Items on a Receiving Document” below.

= |fthe shipmentincluded a packing slip but no vendor invoice, click No. When the receiving
document appears in the Report Window, print a copy of it. The items that you just received
will not be added to the inventory until you price them.

PRICE ITEMS ON A RECEIVING DOCUMENT

When a vendor sends you an invoice, you can enter the prices (your cost) for the items on a receiving
document. This process, referred to as pricing items, updates the last cost and next cost tracked by
TireMaster. Items should be priced before you sell them.

Note: Users at a store can price items for their store only, as long as settings in System Controls
allow it.

To price items on a receiving document
1. SelectInventory > PO & Receiving. The PO System opens.

Inventory
Maintenance
PO & Receiving
Suggested Reorder & PO
Oty Adjustrnent Wizard
List Editing

LAAAAALLLSSSSLSDSSSSSS

2. Selectthe Receiving Documents tab.
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266

‘ufendorl _I Find Doc | Resetyendorl Filtergﬁl

Purchase Orders | Receiving Documents | Historical Vendor Invoices |

Open [ | Ordered [0 Patial  [M Fulffilled

Select the status Received (Un-Priced). TireMaster displays the receiving documents with
items that have not been priced.

r_ 1
%
o
=

A als aa s s

adg | Eat | oeee | Price

Select the receiving document for the items you want to price and click Price. The Vendor Invoice
screen appears.

PO System (16178)

‘u’endorl | Find Doc | Reset Vendor | Filter Off |
- RevRD
Purchase Orders Receiving Documents | Historical Vendor Invoices | —_l
|i Open Received D Priced
s|site [Ronum |RDDate  |Rer |name |
1 59 03/29/2019 SORUNMS TIRE DISTRIBUTION

|[ROUND TIRE DISTRIBUTORS —

Add | Edit | Delete || Price l Print | Close |

Update the receiving date, default due date, discount date, discount amount, and reference
number if needed.

Vendor Invoice (16190)
VID # |‘1 |59

‘ Charge Vendar IRDUND TIRE DISTRIBUTORS |

Date I 312912019 vl Due Date I 4/15/2019 VI

Ref. # I9236498 Disc. Date I 4/ 812019 vl
Discount I 4565

Note: Discountterms are used only in TireMaster Plus and TireMaster Corporate. Depending
on how the system controls are set, you might be required to add a reference number if
you haven't already.

If you need to update the prices (your cost) for any of the items, click Edit Prices. Then type the
new amounts on the Vendor Invoice Price Editing screen. TireMaster automatically recalculates
the extended prices along with the total and discount amount.



7.

8.

igulnventory Receipts

ﬁﬁ%igvrvﬁwﬁwwwzgz

Total

4

Freight Vendor 4

4

1

I Edit Prices I Resst |‘

5
%]
o
)

Define the payment method:

=  To pay with cash, type the amount of the cash payment in the Cash field. TireMaster
recalculates the amount in the Charge field.

= To charge the total amount of the vendor invoice, leave the amount in the Charge field alone
and disregard any system-calculated discounts.

LA A A A A A A s A A b Al sl Al A

Cash 0.00

Charge 228232
Total 228232

|

FYWW e YT

Freight Vendor

EditF’rices| Reset |

If you need to change the number of payments, select 1, 2, 3, 4, or select Define and type the
number of payments.

b A A s B A A A A A s bl A 4.

Payments
1 2 3 4
" Define 0

|

Cancel

i e

If you entered a shipping charge when receiving the items, click J and look up the freight
vendor. For more information, see "Vendor Searches" on page 179.

’ﬁﬂﬁ@ﬁ'T"""'Yﬁﬂﬁ!""?’Bﬁm€'ﬁw"""""‘

Total 228232

Freight Vendor | D
; Cancel

Note: A vendor charge (for the amount entered when you received the order) posts to the
freight vendor’s subledger and the freight account in the general ledger.

Edit Prices | Reset |

10. Click Complete.
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VYV VY E VYV TV YT TTYY

efine ’“_

b a0

Y

Cancel

One of the following happens:

= |f you must pay the entire amount at one time, the vendor invoice document (VID) appearsin
the Report Window.

= Ifyou'll make multiple payments, the Vendor Payment Schedule screen opens. Change the
payment amounts and dates if needed and click OK.The vendor invoice document (VID)
appears in the Report Window.

Note: The totals of the Payment Amt and Discount Amt columns must equal the

payment and discount amounts on the vendor invoice document before the order can
be priced.

11. Print the vendor invoice document (VID). TireMaster adds the VID to the Historical Vendor
Invoices tab, and the receiving document's status color changes to gray (S column of the
Receiving Documents tab) to indicate the items have been priced.

BACK ORDER ITEMS

When the number of items delivered doesn’t match the number of items ordered, you can receive the
portion of the order that was shipped and place the unreceived quantities on back order.

PUT PARTIAL QUANTITIES ON BACK ORDER

When you receive a partial order, you can receive the quantities that were delivered and
place the remaining quantities on back order.

To put partial quantities on back order
1. SelectInventory > PO & Receiving. The PO System opens.

Inventory
Maintenance
PO & Receiving
Suggested Reorder & PO
Cty Adjustment Wizard
List Editing

LAAASSALLLSSSSSSSSSSSS

2. Selectthe Purchase Orders tab.
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‘ufendorl _I EindDocl

Purchase Orders I Receiving Documents | Historical Vendor Invoices |

open [ | ordered [ Partial Fulfilled

3. Select the status Ordered.

'rmmm
Statu

’7(‘ Open

add | Eat |

4. Select the purchase order with the back ordered items and click Receive. The
Receiving Document screen opens.

PO System (16178)

‘ufendorl _I Find Doc | Reset‘g’endorl Filtergﬁl

Purchase Orders | Receiving Documents | Historical Vendor Invoices |

Open [ | Ordered [0 Patial  [M Fulffilled
site [PONum |PODate  |Ref |name
1 26 03/29/2019 80059 TIRES & MORE
03/29/2019 ROUND TIRE DISTRIBUTORS —

(]

5. Foreach item that you need to put on back order, enter the quantity that was actually

received.

s[Product code  [size [venarartio  [name
P|40310517¢  P235165R171SL 135646741 HP WRANGLER
P|732170500 P205/55R16/52 135000140 RS-A EAGLE
P|740036515  LT195/75R14/8 135000983 AT WRANGLER
[P|403934169 P2T5/60R20/SL 135934169 HP WRANGLER

Tip:  To see the quantity and cost used for an item on the original purchase order,
select the item and click Order Info.

6. Click Receive. TireMaster prompts you to price the receiving document.
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Delete | grderlnfo| Add Inventory |

Add |
UInit Price
Close | I Receive I Add PO | |

Note: Depending on how the system controls are set, you might be required to add a

reference number if you haven'’t already.

7. Do one of the following:

= |fyou have an invoice from the vendor, click Yes. The Vendor Invoice screen
opens, and you can price the items. For more information, see "Price ltemson a

Receiving Document" on page 265.

= [fyou only have a packing slip, click No and print the receiving document. When
TireMaster prompts you to cancel the remaining quantities, click No to back order

(instead of canceling) the items.

8. Close the PO System screen.

PUT ALL QUANTITIES ON BACK ORDER

When one of the items on a purchase order is not delivered, you can place all quantities of

that item on back order.

To place all quantities of an item on back order

1. SelectInventory > PO & Receiving. The PO System opens.

Inventory
Maintenance
PO & Receiving
Suggested Reorder & PO
Cty Adjustment Wizard
List Editing

AAAASSALLLSSSSSSSSSSSS

2. Selectthe Purchase Orders tab.

PO System (16178)

vendor | | EindDoc

Purchase Orders l Receiving Documents | Historical Vendor Invoices |

W open [ | Ordered [7] Patial  [M Fuffiled

3. Select the status Ordered.
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4. Selecta purchase order and click Receive. The Receiving Document screen appears.

PO System (16178)

Vendor | .| EinaDoc | Resetvendor | Fiter of |
Purchase Orders | Receiving Documents | Historical Vendor Invaices | ﬂl
Open [ | Ordered [0 Partial M Furfilled
s|site [PoNum [PODate  |Ret |Mame |
1 26 03/29/2019 | B0059 TIRES & MORE
1 |25 03/20/2019 82210 ROUND TIRE DISTRIBUTORS

1 |24 [03/01/2019 | |AMC TIRE WAREHOUSE —

aid | Eat | Deee || Beceivel pint [ close |

5. Selectthe item you need to put on back order and click Delete. A confirmation
message appears.

4
RD# |1 |61 Shipped Via | b
4
Date I3:’2€Ia’20‘19 vl Tracking # I 1
4
4
4
Vendor |.Aru1c TIRE WAREHOUSE | Contact | .
4
Lines D Manual / Mo PO D Line From PO PC Line Exception |i Std. Return:
s|Product Code  size |vendparitio <
P|a3410 225/700R480A 060093410 . 4] ¢
PL28008 215/55R 15 060000412 HP PRIMACY 4 €

Add | Delete I Qrder Info Add Inventory
| | | Received: |12
Unit Pri
ni ”Cel Returned: IU— W

Close | 3eceive| Add PO | Imponawl

Tip:  To view the quantity and cost used for an item on the original purchase order,
select the item, and click Order Info.

Click Yes. TireMaster prompts you to cancel the item.

To place the item on back order (instead of canceling it), click No. The item is removed
from the receiving document.
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8. Toreceive the remaining items on the receiving document, click Receive. TireMaster
prompts you to price the receiving document.

Add | Ceiste grder|nfo|

Unit Price
Close | I Receive I Add PO | | i

Note: Depending on how the system controls are set, you might be required to add a
reference number if you haven'’t already.

Add Inventory |

9. Do one of the following:

= |fyou have an invoice from the vendor, click Yes. The Vendor Invoice screen
opens, and you can price the items. For more information, see "Price ltemson a
Receiving Document" on page 265.

= [fyou only have a packing slip, click No and print the receiving document. The
receiving document is added to the Receiving Documents tab.

CREATE A RECEIVING DOCUMENT

When a delivery is comprised of items you didn't order, you can skip the ordering stage and create a
receiving document from scratch.

Note: Your system control settings define whether you're allowed to create a receiving document
without a corresponding purchase order. For more information, see "Force PO System to
Create New PO" on page 1137 .

To create a receiving document

1. SelectInventory > PO & Receiving. The PO System opens.

Inventory
Maintenance
PO & Receiving
Suggested Reorder & PO
City Adjustment Wizard
List Editing

B B o b A

2. Selectthe Receiving Documents tab.
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‘ufendorl _I EindDocl Reset\_u’endorl Filtergﬁl

Purchase Orders | Receiving Documents | Historical Vendor Invaices |

open [ | Ordered [0 Partial Fulfilled

Click Add. TireMaster prompts you to search for a vendor.

Status {
i+ Open

Add

]

L

(RPN A PPN

Look up the vendor who sent you the shipment. The Receiving Document screen opens. For
more information, see "Vendor Searches" on page 179.

Note: You can change the vendor for a receiving document until you complete the receiving.

Ifit's available, type the reference number for the delivery.

FOB—
" Source
@ Destination

Ref# |OR2345 &

For each item delivered, click Add and search for the item or scan its bar code. For more
information, see "Inventory Searches" on page 216 or "Enter Bar Codes on Purchase Orders
and Receiving Documents " on page 325.

Add

Unit Price |
Close |

For each item added to the receiving document, do the following:
= Update the description (noninventoriable items)

= Type the quantity.

= Update the price (your cost)

Note: Ifyou’re receiving items in bulk, such as valve stems, TireMaster can calculate the

cost for each item. For more information, see "Calculate an Item’s Per-Unit Cost" on
page 255.

= Update the federal excise tax (FET)
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§|Product Code  |Size VendPartNo Name | oty|  Price] FETax ¢
NSSHCK . MasterPro Strut Assemblies Cc 2 133.99) 0.00 :
42 . Murray Heat Transfer Heater Ct 1 .“EEI 0.00 :

| 4

Note: A system control setting defines whether the FETax column displays either the
average cost of an item’s federal excise tax or the FET used the last time the item was
received. For more information, see "Use Next FET for POS/Receivings" on
page 1134.

8. Complete the following shipping and handling information:

a.

Under FOB, select Source if you will pay for freight or Destination if the vendor will pay for
freight.

Ifit's available, type the contact person’s name.

J ShippedVia FOB

» " Source

; Tracking # + Destination
»

»

»

; Contact |F'eteJ0nes| Ref# |0R234B

3

9. Click Receive. TireMaster prompts you to price the receiving document.

Add | ge|ete| Qrderlnf0| Addlnventory|

Close | |Beceive| AddPO | |

4
Unit Price 3
3

Note: Depending on how the system controls are set, you might be required to add a reference

number if you haven’t already.

10. Do one of the following:

If you have an invoice from the vendor click Yes. The Vendor Invoice screen appears, and
you can price the items. For more information, see "Price ltems on a Receiving Document”
on page 265.

If you only have a packing slip, click No and print the receiving document. The receiving
document is added to the Receiving Documents tab.

11. Close the PO System screen.

ADD AND RECEIVE NEW ITEMS AT THE SAME TIME

If you need to receive an item that isn’t in your inventory, you can add it to TireMaster and an open
receiving document at the same time.

Note:
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To add items while creating a receiving document

1. Create areceiving document for the vendor if one hasn’t already been created. For more
information, see "Receive Items on a Purchase Order" on page 262 or "Create a Receiving
Document" on page 272.

2. Click Add Inventory. TireMaster prompts you to search for items.

Delete | grderlnf0| | Add Inventory I

Add |
Unit Price

Close | Receive | Add PO | |

Sl B b

3. Do one of the following:

= Look up an item with settings similar to the item you need to add. For more information, see
"Inventory Searches" on page 216.

Tip:  Looking up a similar item saves time, because you can reuse many of its settings

for the new item.

= Click Cancel, and then click Add on the Inventory Maintenance screen.

4. Type the product code for the new item and click OK.

Add Mew Inventory (1000)

Mew Product Code:
90000003538

I Ok I Cancel

5. Onthe Inventory Maintenance screen, complete the settings for the new item. Then click OK.
TireMaster prompts you to view and edit the prices for the new item. For more information, see
"Add an Inventory Item" on page 191.
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Inventory Maintenance (12300)

General |QtyfF'ricing| History |

Motes |

Prev | Next |

Product Code: |90000003533

Size: |245.|'45R20 103Z XL

Rim Size: I 2000

Part#: I_ I— ‘

Inventory (Y/N): IY

Description: IZEDN RS3-5

Quick Look: |2454520

¥ Active

Group: ITI RES

[~ Discontinued
Charge Shop: ¥ Parts ¥ Labor

Type (G,CFD): I
ColorSpiff. I

Commission:

bbb bsbbbbhbsssissdssssdsdslsds s iy

v

Add-On/Kit Code: I

lfg Code:

Taxable: | Parts W Labor

Category: ITIPA GL: ITF'AI

Coo

oK

Cancel |

Click Yes. The Site Prices and Quantity screen opens.

Complete the price settings for the item. Then click OK. For more information, see "Fixed Prices"

on page 358 or "Factor Based Price Calculations" on page 359.

Site Prices and Quantity (1700)

Description: IZeon RS3-5 : 900000

03538 : 245/45R20 103Z XL

On Hand: I 0.0000
Mot Priced: I 0.0000
Waork Order: I 0.0000

LastFET: I 0.0000
Next FET: I 0.0000
Price Matrix: INone 'I

Parts: I 197.4470
Labaor: I 0.0000
EDL: I 197 4470

On Order: I 0.0000

Relief %: | 0.0000

Flat Rate: | 0.0000

At Recap: I 0.0000

Min Stock: I 0.0000
Max Stock: I 0.0000

Price By: IE_ Op: ID_
Base Price: I 167.8300
Last Cost: I 167.8300
Core Cost: I 0.0000

Factor: I 0.8500
Std Cost: | 0.0000
Mext Cost: I 0.0000

8. To exitthe Inventory Maintenance screen, click the General tab. Then click Close. The new item

is added to the receiving document.

Inventory Maintenance (12300)

General |01yfF'ricing| History | Notes |

Product Code: |90000003533

FY WA F O T T wwy

Size: |245.|'45R20 103Z XL

Description: |ZEDN RS3-5
R et V¥

9. Type the quantity for the new item.
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s|Product Code  |size VendPariNe  |Name | o] Price| <
90000032516 225/65R16 100T 90000032516 EVOLUTIONTOURALL-SEASC &  90.88 ¢
90000003538  245/45R20 103Z XL 90000003538 | ZEON RS3- 6783 ¢
| . 4

10. Update items previously added to the receiving document, along with the shipping and handling

information, if needed.

11. Receive the items and price the receiving document. For more information, see "Receive ltems
on a Purchase Order" on page 262 and "Price ltems on a Receiving Document" on page 265.

REVERSE A RECEIVING DOCUMENT

If a shipment was incorrectly received, you can reverse the receiving document for it as long as the
items have not been priced.

Note: Negative receiving documents that have been created to return items to vendors can also be

reversed as long as they haven’t been priced.

To reverse a receiving document
1. SelectInventory > PO & Receiving. The PO System opens.

Inventory
Maintenance
PO & Receiving b
Suggested Reorder & PO
Oty Adjustrment Wizard
List Editing

LAALAALLLLSSSLLDSSSSSS

2. Click the Receiving Documents tab.

Vendor Find Doc | Reset Vendor FiIterQﬁ|

Purchase Orders l Receiving Documents | Historical Vendor Invaices |

[F open [ | ordered [ Partial W Fulfiled \‘

LAAAAAALALLALALALLAALAALDEDDLDADLELDLDELDDDDDDLDLDDDLLDSSSS

3. Todisplay receiving documents that haven’t been priced, select Received (Un-priced). The
Rev. RD button appears in the upper-right corner of the screen.

4. Selectthe receiving document you want to reverse and click Rev. RD. A confirmation message

appears.
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PO Systern (16178)

‘u’endorl Find Doc | Reset‘jendor| Filter Off |
- RevRD
Purchase Orders Receiving Documents l Historical Vendor Invoices ] ﬁ
[W open M Received [1 Priced
s[site |RDNum [RDDate  |Ref |Name |
|:| 1 G4 04/01/2019 | 266 MAPA AUTO PARTS
62 03/29/2019 OR2346 O'REILLY
AMC TIRE WAREHOUSE
G0 03/29/2019 82210 ROUND TIRE DISTRIBUTORS
b e e e e e A e i e A e i i e e A e e e A e e e e B e B i e B i e e A

Tip: Ifyou cannot see the Rev. RD button, make sure (Received Un-priced is selected.

Note: Receiving documents that include tracked items cannot be reversed. In this scenario,
retrieve the receiving document and complete the vendor invoice (VID). Next, create a
new receiving document, add the tracked item with a negative quantity, and enter its cost.
If you need a corrected receiving for the tracked item, add it to the receiving document as
well, with a positive quantity and cost. Then complete the vendor invoice document. If the
tracked item uses the option cost method and has been sold to a customer, include the
original invoice number in the receiving document’s reference number and item
descriptions. This will help you identify the original sale invoice on the item tracking
screen.

5. Click Yes.

Note: No vendorinvoice documents are created for the original receiving or the reversal. To
view the original and reversed receiving documents, click the Receiving Documents
tab. Then select the status All. The reference number for the reversal includes the letters
REV and the reference number for the original receiving.

SEARCH FOR HISTORICAL VENDOR INVOICES

If you want to research your purchase history, you can view all historical invoices on the Historical
Vendor Invoices tab. You can search for invoices by vendor name, reference number, or document
number.

To look up a historical vendor invoice
1. SelectInventory > PO & Receiving. The PO System opens.

Inventory
Maintenance
PO & Receiving I}
Suggested Reorder & PO
Oty Adjustrent Wizard
List Editing

LAAASALLLSSSSSSSSSSSSS

2. Click the Historical Vendor Invoices tab.
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vendor | | EindDoc | Resetvendor | Fiterof |

Purchase Orders | Receiving Documents | Historical Vendor Invoices |

open [ | ordered [0 Partial Fulfilled

3. Tolook up the document by vendor, do the following.

a. Click _| and look up the vendor. For more information, see "Vendor Searches" on
page 179.

e

Vendor I
-

.

4
Purchase Orders | Receiving Documents H|st0r|ca|\ﬁ

Site |V | It i

b. Selectthe vendor invoice that you want to view and click Print. The Report Window opens.

PO System (16178)

Vendor [ROUND TIRE DISTRIBUTORS | EindDoc | Resetendor | Filter Of |

Purchase Orders | Receiving Documents  Historical Vendor Invoices |

Site |VIDMum |VID Date Ref MName
1 60 04/01/2019 92554 ROUMND TIRE DISTRIBUTORS
03/29/2019 9236498 'ROUND TIRE DISTRIBUTORS

|[ close |

c. Printa copy of the vendor invoice document, if needed, and close the Report Window.
4. Tolook up adocument by document number or reference number, do the following.
a. Click Find Doc.

_|| Eind Doc I ResetVendor | Fiter Of |

istorical Vendor Invoices |
w

b. Type the document number or a reference number when prompted for that information, and
click OK.

Ref# or Document Mumber

Find
12534

I OK I Cancel I

c. Click Print. The Report Window opens.
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PO Systern (16178)

Vendor | J

Purchase Drders] Receiving Documents  Historical Vendor Invoices ]

Site |VIDMum |VID Date
03/05/2019 12634 TIRES & MORE

T B B B e B B B B B

’I Print I Close |

L

d. Printa copy of the vendor invoice, if needed, and close the Report Window.

5. Todisplay historical invoices for all vendors again, click Reset Vendor.

3 J Find Doc || Resetyendorl Filtergﬁ|

>
>
>
Elistorical Yendor Invoices l
%

> A

ITEM TRACKING

With item tracking, you can match noninventoriable items on customer work orders to the receiving
documents for those same items.

The purpose of item tracking is to prevent fraud. Item tracking helps to ensure that when a
noninventoriable item is returned, it’s an item you actually sold to a customer. Item tracking also
allows you to verify that an outside purchase was not stolen by an employee.

Items can be tracked regardless of whether they’re assigned the option cost, expense, or relief

percent costing methods. However, the items you’ll mostly likely track are those assigned the option
cost costing method.

HOW TRACKING WORKS

Item tracking is initiated at point of sale. When you add a tracked item to a work order, you also
identify which receiving document is for the item. The method for linking an item on a customer’s
work order and a receiving document, depends on the item’s costing method:

=  Option Cost Items: When you add a tracked option cost item to a work order, you are
required to define the item’s cost and identify the vendor who delivered the item. When you do
this, TireMaster generates the receiving document for the item. Items assigned the option cost
method are typically obtained via outside purchases and then sold to customers. For more

information, see "Track Option Cost Items" on page 283 and "Outside Purchases for Tracked
Items" on page 295.

280



Iltem Tracking

= Expense Method and Relief Percent Iltems: \WWhen you add a tracked item assigned the
expense or relief percent costing method to a work order, a list of receiving documents
appears. Then you select the corresponding receiving document on the list. For more
information, see "Track Expense Method and Relief Percent Items" on the next page.

Note: If you enable tracking for an expense or relief percent item with available quantities, any
receiving documents created before the start of tracking will be excluded from the list of
receiving documents. Therefore, in this scenario, you'll assign the item to unknown
receiving documents until you've depleted the quantities received before tracking began.
These unknown receiving documents can be removed from the ltem Tracking screen,
which is used for researching the purchases and sales of noninventoriable items. For
more information, see Item Tracking Screen.

Once an item’s work order and a receiving document are linked, you can use the Item Tracking
screen to do the following when a customer returns a noninventoriable item:

= |dentify the vendor who sold you the item
= |dentify the receiving document that was processed when the item was delivered

This information helps you verify that the noninventoriable item being returned is an item you actually
purchased from a vendor and then sold to the customer, because you can easily find the supporting
documentation.

PREPARE FOR ITEM TRACKING

Before you can track a noninventoriable item, you need to enable tracking for it. The track item
setting is on the Inventory Maintenance screen (General tab).

Note: Tracking is intended for specific noninventoriable items, such as Nonstock Brake Pads,
Nonstock Starter, and Nonstock Water Pump. Avoid using tracking for multipurpose
noninventoriable items such as Nonstock Parts.

To enable item tracking

1. Add or look up the item for which you want to enable tracking. For more information, see "Add an
Inventory ltem" on page 191 or"Inventory Searches" on page 216.

On the Inventory Maintenance screen (General tab), click Edit.

Select the Track check box. If the check box is disabled, the item is inventoriable and cannot be
tracked.
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»

b 10 Prev MWexd

4

>

>

; Inventory (YiM): ’N_

> | Type GCFD) |

e [

4 ¥p LF

> | ColorSpift [

i Commission: ’_

; ¥ Force Option Cost

; =7 Track(

4

B A A A8 S A B A S A S A A B A
4. Click OK.

5. To enable tracking for additional items, repeat steps 1 through 4.

Tip:  Ifyou’re enabling tracking for multiple items that are organized sequentially on the
Inventory List (for example, the items are organized by their descriptions, which all begin
with the prefix non), don’t close the Inventory Maintenance screen and search for another
item. Click Next repeatedly until you locate the next item for which you need to enable
tracking, and then click Edit.

TRACK EXPENSE METHOD AND RELIEF PERCENT ITEMS

To track an item that’s assigned the expense costing method or the relief percent costing method,
you need to identify the receiving document that includes the item when you add it to a work order.
To track expense method and relief percent items

1. Starta work order. For more information, see "Create a Regular Work Order" on page 410.

2. Add the item to the work order. Then type the quantity and press Enter. The Track Parts screen
opens. It lists receiving documents that include the item that was just added to the work order.

Quantity |Size | Description |Parts |Labor  |FET
1.00 LOF Lube il & Filter SYN 8-8.5 £4.99 0.00
| & MISC TURN SIGMAL BULB - | 5.99 0.00

PV WYYy Y

A A A A A A N N N N N N N N O  rr r r rrFrF rFrYrYrYyrYyyyyyw

Note: When you receive multiple quantities of an item on a receiving document, the same item
and the same receiving document are listed multiple times on the Track Parts screen.

3. Do one of the following:

= Select the receiving document that includes the item you put on the work order, and click OK.
If there are multiple lines for a receiving document, press Ctrl and select a line for each item.
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Track Parts (3320)

Select RD partitem(s) this is assignedto

RD Mumber |RD Date Part Mame A Froduct Code / Size Vendor Name -~

§5741-1 |09-18-2019  |MISC TURN SIGNAL BUTB - |BULBFR! . |NAPA AUTO PARTS

B5741-1 09-18-2019 MISC TURN SIGNAL BULB - BULBFR . NAPA AUTO PARTS

B5741-1 09-18-2019 | MISC TURN SIGNAL BULB - BULBFR /. NAPA AUTO PARTS

657411 09-18-2019 | MISC TURN SIGNAL BULB - BULBFR /. NAPA AUTO PARTS

657411 09-18-2019 MISC TURN SIGNAL BULB - BULBFR /. NAPA AUTO PARTS

65741-1 09-18-2019  MISC TURN SIGNAL BULB - BULBFR . NAPA AUTO PARTS

§5741-1 09-18-2019 MISC TURN SIGNAL BULB - BULBFR /. NAPA AUTO PARTS

§5741-1 09-18-2019  MISC TURN SIGNAL BULB - BULBFR/. NAPA AUTO PARTS

§5741-1 09-18-2019  MISC TURN SIGNAL BULB - BULBFR/. NAPA AUTO PARTS

§5742-1 09-18-2019  MISC TURN SIGNAL BULB - BULBRR /. NAPA AUTO PABTRrwwwwrwwvrvvrrvbwws
857431, 09182019 | BATTERY TERMINAL COVERBATITRMCY/,  wseasuors [ o | Close

b

= |fthere is no receiving document for the item on list, click Close. When TireMaster prompts
you to assign the item to an unknown receiving document, click Yes.

Note: The lack of a receiving document occurs when an item already had available
quantities when tracking was enabled. (In other words, the item was received before

tracking began.)
4. Do one of the following as needed:
= Put additional items on the work order.

= Update items that were already on the work order (for example, change prices, edit
descriptions, assign technicians).

= Click Quit to close the work order.

= Complete the invoice. For more information, see "Complete an Invoice" on page 424.

TRACK OPTION COST ITEMS

To track an item that’s assigned the option cost costing method, you create the receiving document
for the item when you define its cost at point of sale. Option cost items cannot be linked to receiving
documents that were already created in the PO 